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Welcome 
 
Thank you for purchasing our ecommerce template software. Our shopping 
cart software is designed to get your store up and running with minimum cost 
and hassle whilst providing a powerful solution to your ecommerce needs. 
 
We have tried to do as much as the work for you, through the design, 
payment processor integration, shipping options etc. which will leave you to 
personalize the store, add your categories and products and get up and 
selling as soon as possible. 
 
Please take time to read through the notes provided here to get the most out 
of your online store. Please also pay particular attention to the security 
issues involved with running an online store and contact us if you have any 
concerns. 
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Requirements 
 
You will require one of the following HTML editors: 
 

• Macromedia Dreamweaver 3, 4, MX, 8, CS or 2004 
• Microsoft Frontpage 2000, 2002 or 2003 
• Adobe GoLive 5, 6 or CS 
• Expression Web 
• The CSS and Generic versions can be edited in the program of your 

choice. 
 
You will need a hosting company where your store will reside; the minimum 
requirements are as follows: 
 
ASP version 
 

• Microsoft Windows Server  
• Support of ASP pages 
• Database (Access) 
• ASPupload for image upload 
• ASPEncrypt for offline credit card processing (Capture card method) 

 
PHP Version 
 

• Unix / Linux Server  
• Support PHP version 4.1 or above 
• MySQL Database 
• Mcrypt for offline credit card processing (Capture card method) 
• cURL component installed for UPS shipping
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Installing the Template 
 
You should have downloaded a .zip file to your hard drive following purchase; 
this will be the id of the template you have purchased with the .zip extension 
e.g. 0003fe00bkg0021.zip 
 
Double click on the file to unzip the content to where you would like to work 
from on your hard drive 
 
Note 
 
We strongly recommend that you keep the .zip file in a safe place in case you 
need to run it again at a later date and to prevent loss of data in the event of a 
computer crash.
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Opening the Template in Dreamweaver 
 
In Dreamweaver you must define the site before making any changes to the 
template. Please note, there are slight variations between the different 
Dreamweaver versions, but the basic principle remains the same. 
 
1. Open Dreamweaver 
2. Select Site 
3. Click on New Site 
 

 
4. Ensure the Advanced Tab and in the Site Name Section give the 

template site a name 

5. In the Local Root Folder Section and select the yellow folder to 
browse to the folder you extracted the template to.  
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To get started you won't need to fill in any other information. Click on Done 
 
Please see our tutorial here www.ecommercetemplates.com/tutorials/ 
for more help and other versions. 
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Opening your Template in Frontpage  
 
1. Open FrontPage 
2. Select File 
3. Choose Open Web 

 
4. Browse to the location where you extracted your ecommerce template  

 
 

NOTE 
 
We ver 
you u 
choose File > Open, this will only open one individual file and when you make 
changes such as changing the location of a Hyperlink it will not establish the 
Cache for the whole site. 
 
Please see our tutorial here www.ecommercetemplates.com/tutorials/

 would strongly recommend you following the above instructions whene
 edit the template in FrontPage as this will open the complete site.  If yo

 for 
more help and other versions.
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Opening the Template in Adobe GoLive 
 
1. Open Adobe Golive 
2. Select File 
3. Choose Open  
4. Browse to the location where you extracted your ecommerce template  

 

5. Locate the .site file 

 

This will open the list of files a6. nd folders that make up your GoLive 
store 
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Double click on any of the file names will bring up the page in design 
view. Items that are repeated on

7. 
 several pages such as the company 

on, menu etc. have been set up as GoLive 
uble 

name, news secti
components so the whole site can be updated from the one file. Do
clicking on any of the components will bring it up for modification. 
Components are shown with a change in cursor: 

 

8. After making the modifications you should be prompted to update all 
files that use that component 
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9. Agree to update all files and move on to the next one 

reen bug icon rather than the tick next to a file in the 
ill probably have a broken link in that file or one of 

ncluded on that page. Bug icons in the vsadmin or inc 
lly be ignored. 

10. To set up a new page, the easiest way is take an existing page and 
save it under a new name. 

11. If you see the g
site list then you w
the components i
folders can usua

NOTE (for CS2 users) 
If you receive a message that the site file was created in an unsupported 
version then in GoLive CS2 go to New > Site > Create Site > Site from 
Existing Content > From a Local Folder of Existing Files. Navigate to and 
choose the sitename folder, make sure it finds the index page of the site (or 
navigate to that as well). Continue with the site wizard. This will create a new 
CS2 site file for the store. 
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Uploading the store to your server 

your host or alternatively start adding products and categories straightaway to 

our store 

ad a 

You may want to make some design changes before uploading the store to 

the online admin section and leave the design elements to later. 

 
Using an FTP program to upload y

You may already have a FTP program installed – if not, you can downlo
copy from one of the popular download sites like www.download.com or 
www.tucows.com - search for “FTP Utility” and you’ll get a large choice of 

 

programs. Popular utilities including WS_FTP Pro and Cute FTP 

Alternatively both Dreamweaver and FrontPage have their own built in FTP
programmes. 

• Using Dreamweaver to upload your store 

• Using Frontpage to publish your store 

Note. 

Your hosting company sho
three key items are: 

uld have provided you with the details for logging 
onto your server – the 

• FTP address 

With that information you should be able to connect to your server. The usual 
set up when using a FTP program is to have your local files on the left window 
and the server files on the right so you can send the files and folders from 
your local hard drive to your server. The hosting company will often have a 
number of folders already set up and you may need to check their instructions 
to find out where the store pages need to go but this will usually be in a folder 
called “htdocs” public html” or “www” 
With that information you can now transfer the files from your hard drive to the 
host server. It is best to upload all the files and folders from your extracted 
template – do not upload the main folder eg. DW Virtual Tones Ecomm Plus 
but rather the files and folders included within that folder ie. /vsadmin/ 
/prodimages/ /images/ categories.asp, cart.asp etc. 
Once you have the entire site uploaded you can then go on to make your 
database connection and log in to the admin section. 

• FTP user name 

• FTP password 
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Using Dreamweaver to Upload your Store 

Dreamweaver has an inbuilt FTP utility, which you can use to upload your files 
ocal 

tails to the remote window: 

ate Site to Define 
4. Ensure the Advance Tab is selected and choose Remote Info 
5. Enter the Remote Host Details 
6. Select Done and close and dialogue boxes that may be open 
Your host should have given you these details when you signed up for your 
hosting account. Once you have entered the information above, make sure 

 ar ake sure your 
connection is correct. 

and folders. When you first defined the site you may have only set up the l
information. If you want to use Dreamweaver to upload your store you will 
need to add some de
1. Select Site 
2. Click on Define Site 
3. Double Click on the Templ

you e connected to the internet and hit the test button to m

 

7. Select Site 

 

. 

8. Choose Site Files 

9. Select the Put Icon to upload all files and folders to your web host

The “Templates” folder doesn’t actually have to reside on your server as it is 
only used for making changes locally but it won’t harm anything if it is 
uploaded. Once you have the entire site uploaded you can then go on to 
make your database connection
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Publishing your Store via FrontPage 

2. Publish Icon: 

If you have a Frontpage version and your host has Frontpage extensions 
installed it is possible to use Frontpage to transfer your site from your hard 
drive to your server. 

1. Open your site in FrontPage - File > Open Web 

Click on the 

 

3. e the URL of the site you are publishing to: Next giv

 

4. And finally type in the Frontpage Username and Password that were 
supplied by your hosting company: 
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Once you have the entire site published you can then go on to make your 
da abase connection. 

king the Database Connection 

re are two ways of setting the da

t

Ma

The tabase connection depending on the type 
of Template you have purchased.  Please choose the appropriate section to 
set your database connection. 

• ASP version 

• PHP version 

Now that all the files and folders are on your host server, it’s necessary to 
make the connection between the store and the database that dynamically 

ver

 Version 

d 

> 

generates the store functions. The set up is different for the ASP and PHP 
sions: 

ASP

The easiest way to set up your connection is by preparing a quick test file an
then copying the contents into your db_conn_open.asp file in the vsadmin 
folder - here's how to do it: 

1. Open Notepad and Copy and Paste the following lines of code: 

<HTML
<BODY> 
sDSN = "Provider=Microsoft.Jet.OLEDB.4.0;Data 
Source=<%=server.mappath("vsproducts.mdb")%>;" 
</BODY> 
</HTML>  

2. Save the file as test.asp  

3. Upload this file to your fpdb folder (the one where your database 
resides)  

4. Now Open this page in your browser, the URL should be something 
like www.yourdomain.com/fpdb/test.asp  

5. Copy the contents of that page - it should look something like this 

sDSN = "Provider=Microsoft.Jet.OLEDB.4.0;Data 
Source=C:\web\database\vsproducts.mdb;"  
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6. Open the fi db_conn_open.asp (located in the vsadmin folder of 

your template) in notepad and replace the current content with what you 
have copied fr n't delete the 
opening and c conn_open.asp 
should look so

<% 

le 

om test.asp - just make sure that you do
losing <% %> tags so your code in db_
mething like this: 

DIM sDSN 

sDSN = "Provider=Microsoft.Jet.OLEDB.4.0;Data 
Source=C:\web\database\vsproducts.mdb;" 

%>  

7. Upload ou  new db_conn_open.asp to your server, overwriting the 
original in the r  

Note

y r
vsadmin folde

 

That should be wo e connection at the 
following URL:  w .asp and you can 
login with the defa  changeme. 

If when you login and you get a message saying your Database Connection 
needs to be set then try following the above steps again checking everything 
carefully. 

 you get an error message saying that your database is not writeable then 
cate that your connection has been set correctly but you will need 
our host to get write permissions set to your database folder. 

file 

could apply the correct permissions 
(writeable but not browseable) to the fpdb folder. 

 

 

 

 

 

 

rking fine now and you can check th
ww.yourdomain.com/vsadmin/admin
ult username mystore and password

If
this will indi
to contact y

We would also recommend making a back up of the db_conn_open.asp 
just in case it gets overwritten at any time. 

If you receive this error when trying to add new products or categories: 
Operation must use an updateable query. 
...then it means that your database doesn't have write permissions. You can 
contact your host and ask them if there is a special folder on the server where 
the database should reside or if they 
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S
T

ECURITY TIP 
he best place for your database is outside the 

web root. Most hosts provide a special folder 
for this with the database permissions already 
set. Using a folder outside the web root will 
make it difficult for anyone to download your 
database and gain access to your username 
and password. Otherwise you must set the 
permissions on your database folder so that 
your database cannot be downloaded. More 
information is available here. 

 
 

 

 
  

SECURITY TIP  
Rename your database from vsproducts.mdb to 
a name of your choice, (keeping the .mdb 
extension of course). 
Examples would be (though don't use ours) 

se2221.mdb 
nd your 

yourstore591.mdb or databa
This will make it harder for anyone to fi
database if your database folder permissions 
are set incorrectly. 

 
 

  

tant

 

Impor  
The folder where the database resides should be non-browseable. This 
means that nobody will be able to download your database by typing in 
ww u 
can download the database then ask your 
under the root of the site where your database can be placed, if they can set 
non-browseable permissions on the database folder, or in Frontpage, right 
click the database folder, choose properties and uncheck the "allow files to be 
browsed" box. 

w.yourstore.com/fpdb/vsproducts.mdb - it’s worth running a check. If yo
host if there is a special folder 
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PH

To set the database connection, open the file vsadmin/db_conn_open.php 
in a text editor such as Notepad. You need to fill in the details in the spaces 
provided. The 4 pieces of information that you need to provide are the 
username and password for database access, the name of the database 
and the address of the database. If you are in any doubt about these, please 
ask your host who will provide you with the information. Then fill in the gaps 
between the quotes as shown. 

$db_username = "loginname"; // Your database login username 
$db
$db  
$db_h

The last parameter $db_host is normally "localhost". However, it can also be 
 like 

e given you access to a hosting control panel where, 
am
Here’s an example using “cpanel” 

1. Log into to your hosting control panel, this will typically be the URL 
www.yoursite.com/admin/ or www.yoursite.com/cpanel/ and after 
entering your username and password you should see a screen with 
the mySQL icon: 

P Version 

_password = "loginpassword"; // Your database login password 
_name = "databasename"; // The name of the database you wish to use

ost = "localhost"; 

a URL

$db_host = "db.myhost.com";  

You host should hav
ongst other things, you can set up the mySQL database connection. 

 

2. Click there and choose your user name and password, then click 
“Add User” 
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3. When the screen refreshes you’ll need to give your database a nam
and click on Add db: 

e 

 

e drop down 
and choose “Add User to Db” 

4. Finally choose the database you have just set up from th

 

5. You will then be presented with details of your connection string that 
you can copy and paste into db_conn_open.php. 

 

Note 

Make sure you include the underscore in your user name and database 
name 

6. Upload the db_conn_open.php and replace the file in your vsadmin
directory 
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Once this information has been correctly entered and uploaded, you can 

e 

install the database tables and data.  

7. To do this, just open the file createdb.php in a browser by entering th
address for instance: 

http://www.yoursite.com/createdb.php 
Replacing "www.yoursite.com" with whatever is the URL of your site.  
 
The following screen will appear, please see following page: 

 

8. Then click on the button to Install Ecommerce Plus and your 
database will be created. Please remember to delete this file from your 

 

at: 

lease view our tutorial at www.ecommercetemplates.com/tutorials/

web after running it, as otherwise others could use it to destroy your
information. 

The store should be working fine now and you can check it 

www.yourdomain.com/vsadmin/admin.php and you can login with the 
default user name mystore and password changeme. 

P  for 
rther help. fu
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Files and folders 

Now the store is on the server it may be an idea to become familia
files and folders that make up the store itself. Below is an overview of w
each folder includes and its function: 

pdb: This is 

r with the 
hat 

where your database resides. (ASP version only) 

 
as”, where you can find the 

 product images. You’ll 
e 

 
files 

iliar with 
 on the 

 This folder should contain the .dwt file, usually called Main.dwt. 
hanges to your site. Once you've 

prompt and you should 
. 

lates use library items for the news sections or 
s and like 

he pages 
m on saving. (Dreamweaver only) 

that make up the site and store itself and will have 

F

Images: This folder contains all the graphics that are used in the design of the
site – it should also contain a folder called “extr
.png files and/or blank graphics. 

Prodimages: This is the default folder for placing your
see that at the beginning it contains the dozen or so images used in th
default store. 

Vsadmin: This is where all the admin pages, scripts and images are kept.
You don’t need to make any design changes here but there a couple of 
that you may need to edit once you have all the files published to your server. 

Includes: This folder contains the include pages. If you’re not fam
includes, these are files that are used on several or all of the pages
store – updating these pages will cause all pages that “include” them to be 
updated at the same time. They are typically news sections, headers, menu 
and footers. (Frontpage only) 

Templates:
This is where you should make the global c
made the changes to this file, save it and you'll be prompted if you want to 
update all the files using this template - agree to the 
be able to see the modifications you've made on subsequent pages
(Dreamweaver only) 
Library: Some of the temp
menus. These can be inserted or deleted from the editable section
he .dwt file, any changes made to the .lbi file will be made on all tt
containing the library ite
 

he other files are the ones T
a .html, .php or .asp extension. 
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Security Issues 
At Ecommerce Templates we take security very seriously and have put some 

easures in place to maximize the integrity of your online store. We strongly 
eping up with the updater releases available from 

they also include additions to improve on performance 
nd security. 

ps once you have your 

 
Make sure your database isn't downloadable (ASP Version) 
You can test this yourself by typing in the address eg 
www.yourstore.com/fpdb/vsproducts.mdb. If you receive an option to 
download the .mdb file then it probably means that people can access your 
database.  
Please check with your host if you have any doubts at all. Most hosts will 
provide you with a directory below the root of your web with the correct 
permissions already set. 
 
Change the name of the file vsproducts.mdb (ASP Version) 
This is quite simple but do back up the database first just in case. 
Rename vsproducts.mdb to whateveryoulike.mdb and in db_conn_open.asp 
change the instance there of vsproducts.mdb to whateveryoulike.mdb 
No other changes are necessary 
 
Change the name of the vsadmin folder 
This again is quite simple. Download the vsadmin folder, rename it outside of 
your HTML editor and upload it to the server again. 
In the old vsadmin folder (the one that is still called vsadmin) open 
includes.asp and add these two lines: 
disallowlogin=TRUE 
notifyloginattempt=TRUE 
For the PHP version, open includes.php and add these two lines 
 
$disallowlogin=TRUE; 
$notifyloginattempt=TRUE; 
 
When updating, remember you will need to upload the updater files to both 
the new and old folders. 
 
Change the default password / login 
This is the second thing you should do after making sure your database is not 
downloadable. Also be sure to use DIFFERENT username / password 
combinations for your control panel, FTP, bank etc etc. 
 
Back-ups 

m
recommend ke
www.ecommercetemplates.com/updaters.asp - apart from the new 
features we are adding 
a
 
Please take some time to go through the following ste
store published and database connection set. 
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Do make sure that your host has a system in place for backing up your site. 
ake regular back-ups yourself but if there is any problem with 

heck the above points at regular intervals in case permissions get changed 
r files get overwritten. 

 fraud and checks 
elp/fraud.asp 

cetemplates.com/help/checklist.asp 

You can also m
your local copy, it's important to be sure the host has a good recent copy. 
 
Check again 
C
o
 
Read our files on
http://www.ecommercetemplates.com/h
http://www.ecommer
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Chapter 2 
Main Settings & Payment Providers 
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hange admin username and password

Main admin settin
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The Control Panel  
 
Once the site is uploaded to your server and the database connection has 
been set, it’s possible to connect to the admin area. Depending on the version 
your admin area will be here: 
 
ASP Version 
 

www.yourstore.com/vsadmin/login.asp 
 
PHP Version 
 

www.yourstore.com/vsadmin/login.php 

he default username is  - mystore 
The default password is  - changeme 
 
Once you have logged in you will be presented with links to the various 
sections that make up the control panel, the main admin settings are detailed 
below. 
 

 
T

 
 
 

 
SECURITY TIP 
You can change the name of the vsadmin folder 
to make it more difficult for people to find your 
admin section.  
Download the vsadmin folder, rename it outside
of your HTML editor and upload it to the server 
again. 

In the old vsadmin folder (the one that is still 
called vsadmin) open includes.asp and add 
these two lines: 
disallowlogin=TRUE 
notifyloginattempt=TRUE 

For the PHP version, open includes.php and add 
these two lines 
$disallowlogin=TRUE; 
$notifyloginattempt=TRUE;. 
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d Password 

ve in a safe place. If you forget the combination 
ieve them, there is help in our troubleshooting

Change Username an
 
This should be your first change as all the templates come with the same 
ombination. It’s best to choose an alphanumeric combination and make sure c

you write them down and sa
later on it is possible to retr  

e and Password click on the 

page. 
 
1. To change the Usernam  

button. 
 
 and repeat this process for the Confirm Password 

option 
lick on Submit 

2. Key in your Username
3. Key in your Password

C
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Main admin settings 
 
To access the main admin s
main settings link in the left h

ettings login to your control panel and click on the 
and menu.   

ountry settings 

 
Edit admin settings 
 
This will be the next page you will want to visit and includes all the important 
information regarding the general functionality of your store. The various 
options are outlined below: 
 
C

 

 

 is possible to show your prices in up to three other currencies other than the 

 
This is where you select your country / currency default. So if your store sells 
in UK Pounds you would want to choose Great Britain and Northern Ireland. 
 
Currency Converter (optional) 
 
It
default. Sales will always be processed in the default currency but it does 
provide a guide for international purchasers regarding the approximate price 
in their local currency. 
 

 

testuser) and password 

 
You can set your own rates and change them when you like by filling in the 
rate field and selecting the currency of your choice from the drop down menu 
for symbols. 
 

• Alternatively it is possible to connect to our currency updater. This is 
currently a free service using the username (
(testpw) but in the future there may be a monthly charge for 
connecting to our updated rates. Although updated regularly these will 
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only ever be approximations and we strongly suggest that you make 
that clear on your store.  

 
If you do not want to show alternative currencies on your product and product 

il confirmation 
 
You will probably want to be notified by email once an order is placed on your 
store. You can choose that option by ticking the box here and adding your 
email address. It is important that the address you stipulate is valid for your 
store domain so it should be in the format of you@yourdomain.com rather 
than you@anotherdomain.com 
 

detail pages then leave all the fields blank and the feature will be ignored on 
your store. 
 
Ema

 

oblems receiving emails from your store, please view our 
 
If you have pr
roubleshootingt  guide. 
 
Email object (ASP version only) 
 
The email address you set in the "Email address:" section is very important. It 
has to be an address on the same domain as your website as this is a 
ecurity feature for most hosts to avoid SPAM. For instance if your website is 

www.yourwebsite.com then an email address on that domain would be say 
fo@yourwebsite.com. 

Email Object". In the drop down list you will see a 

CDO 
ASP Email (PERSITS) 

SP Mail (ServerObjects) 

so there shouldn't really be a problem. From version 
.0.1  

is also supported. 

s

in
 

ou should see a section "Y
list of the available email objects that are installed on your server. If you don't 
see any available email objects in the list, then you need to ask your host if 
they can install an email object for sending email from an ASP page like for 

stance in
CDONTS 

A
JMail (Dimac) 
Some of these are free, 
4
SMTPMail (SoftArtisans) 
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Ok, so now you can choose an email object in your admin main page. The 
best one to try first is CDONTS, as it doesn't require any further configuration. 
Set the email object to CDONTS and then press submit at the bottom of the 
admin main page, and try an "email friend" to yourself. If you receive the email 
ou are all set. 

mail to work, please ask your host if they have a test 

eed a properly configured mailserver to send 
emails from an ASP page. For this reason, don't worry about emails if you are 
testing on your local machine. It will come together when you publish to your 
host. 

y
 
f you still can't get eI
script for sending email from an ASP page. Once you have tried the test script 
using one of the email objects that we support (listed above), send us an 
email with your FTP login details and URL of the test script and we will have a 
look at why emails are not working from your Ecommerce Plus template. 
 
One other important note. You n

 
 
If you run into any problems and don’t receive emails be sure to check out the 
email troubleshooting section. 
 
Store URL 
 
This piece of information is crucial to the store functionality. In most cases the 
base URL will be the same as your domain, such as 
http://www.yourstoreurl.com/ but if you have placed your store files in a 
different folder you would need to specify that here, for example 
http://www.yourstoreurl.com/folder/ or http://folder.yourstoreurl.com/ 
 

 
 
Products Per Page 
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By default the number of products that show on your product page is eight – if 

 like to change that then enter a different value here. Remember 
g a high value will slow the page load time. 

you would
that settin
 

 

ge 

. It will apply to all products on 
our store. If you need to change the text that appears on your store for 

“handling” then this can be edited in the file vsadmin/inc/languagefile.asp/.php 
 

 
Handling char
 
This is where you can set a charge for handling
y

 
 
Shipping type 
 
Here is where you will choose your shipping method. We have ample 
instructions to help set up this part in our shipping section. Remember it is 
only possible to use one shipping method on a store, mixing them is currently 
not an option. 
 

 
 
Pack products 
 
This is where you can set the shipping totals on products individually (pack 
products separately) or on the order as a whole (pack products together). The 
option is available for UPS, USPS and weight based shipping only. 
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USPS 
 
Add your USPS username to the field provided and the zip you will be 
shipping from in the following field. 

 
 
Canada Post 
 
If using Canada Post add you Retailer ID here. 
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Stock management 
 
This allows you to set the number of items in stock and when the last item is 
added to the cart the "Buy" button is replaced by an "Out of Stock" message.  
 
The text for “Out of Stock” can be changed in the 
vsadmin/inc/languagefile.asp/.php 
 
From Version 5.4.0 the way stock is handled was changed so that if your 
store is down to the last item in stock it will allow more than one person to add 
the item to cart. It will be the first person to check out who will be able to 
purchase. If the other person also attempts to checkout then they will be 
warned that the item is no longer available and update the cart contents 
accordingly. 
 
The number of items left in stock is shown in the product admin section - each 
product will have a number after it like this: 
PC Keyboard (6) 
The number will decrease with each sale. It is necessary to "turn on" the stock 
management in your Main Admin page to use this feature. 
 
If you are using Stock Management it is also possible to download the current 
items you have in stock. This can be achieved through the products admin 
page by clicking on the “dump inventory” button. This will download a .csv file 
that can be viewed in Excel. 
 
From Version 4.4.0 you can use stock management on product options as 
well as on the overall product. On the products admin page if you are using 
stock management you should see a drop down menu which allows you to 
choose between "In Stock" that will set the stock level for the overall product 
and "By Options" which will set stock levels by the stock of the product 
options. 
An important thing to note is that if you share an option between 2 products 
the options stock is shared between 2 products. This could be useful if you 
have say only 20 disk drives, each of which could go in one of 5 different 
models of PC. However, if this is not what you intend then on the product 
options admin page we have also provided a "Clone" button to quickly create 
a copy of one product option. Using the Option Working Name you will also be 
able to distinguish these internally. 
 
From version 5.0.0 stock management will indicate if a request to add to cart 
can only be partially completed. For instance if someone wants 10 of an item, 
but only 6 are available. The number of items in stock can be shown on the 
products page with an addition to includes.asp / includes.php It is also 
possible to not show out of stock products on the products page but keep 
them in the products admin page for future use. 
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IMPORTANT NOTE 
 are remaining out of stock after the time stipulated in the 
 then go to the admin orders page and do a "power 

earch" for unauthorized and cancelled orders and delete all of them. Then hit 

If you find that orders
main admin settings
s
the "purge deleted" button and that will free up the stock again.
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Delete orders 
 
There will always be a number of “purchasers” who finally decide not to go 
through the purchase process and abandon the cart. It may be they’ve 
changed their mind or are simply finding out how the store works. In this case 
the order will show in the order admin page with a gray “authorize” button. In 

ese cases it’s important to check with your payment processor admin to find 
out if payment was made or not. In the majority of cases this won’t have 
appened so the “order” can be deleted. This feature will delete unauthorized 

It is also possible t in page. 

th

h
/ uncompleted orders in the amount of time stipulated in the drop down menu. 

o delete orders manually in the orders adm
 

 
 
Delete credit card numbers 

t 

rough the online admin orders page – we strongly 
commend setting this to a workable minimum. If you are not using the 

Capture Card method, this feature can be ignored. 
 

 
This option only applies if you are using Offline Credit Card Processing 
through our “Capture Card” method. It is a further security measure so tha
sensitive credit card information is left on the server for the minimum amount 
of time possible. You can select the amount of time that the credit card details 
an be viewed thc

re
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Admin Tweaks 
 
You should only need to select these options if you are having problems 

dmin pages, particularly the Admin Countries page. If this 
oesn’t resolve your problem we suggest using a Browser such as Netscape 

he Admin Countries page. 

viewing the a
d
7 for making changes to t
 

 

er 

 it works 

ich parts of the store you want to 
translate from your main admin page. The full set up details are outlined 
below. 
 
How to set it up 
The first thing you will need to do is to define how many languages you will be 
using and which parts of the store you are going to translate. In the main 
admin settings of the control panel you should see a drop down menu for the 
number of languages and a box with the different sections. Use Ctrl + Click for 
multiple selections. 
 

 
Remember that any changes you make on this page will only take effect aft

you have clicked on the “Submit” button. 
 
Multiple languages 
 
How
 
This feature was added in Version 4.8.0 and allows you to have up to 3 
languages running off the same database and control panel. You can select 
the number of languages you require and wh
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As you will probably want to offer the navigation and information pages in 

o is upload all the store 
r. For example, if you 

re going to have a Spanish based store then make a folder called /spanish/ 

he last thing you need to do is to tell the database which language is being 

.php for the new language store you have set up and add 
is to the list for the ASP version: 

 
languageid=2 
 
..or for the PHP version: 
 
$languageid=2; 
 
where the number 2 is the identifier of the language. As an example if you 
have the main store set up in English and language versions for Spanish and 
French then you would have the languageid as 1 for English, 2 for Spanish 
and 3 for French in the respective include pages. 
 
You can now go into your control panel and start adding the information for 
the alternative languages. As an example if you have chosen to have 
separate language product names then in the products admin you should see 
three boxes, the first for the main store language the next two for the 
alternatives: 
 

other languages then the next thing you will need to d
files and vsadmin folder to a new folder on your serve
a
on your server and upload all the files there. 
 
T
used in that particular version. Open vsadmin/includes.asp or 
vsadmin/includes
th

 
 
Once that is all set up you can add links from your main store to the two new 
language stores.
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Edit Payment Providers (Main Page) 

ent Providers Admin page shows a list of the payment processing 
 
The Paym
companies and methods currently supported by Ecommerce Templates. 
 
To access the Payment Provider click on the payment providers link from the 
left hand menu. 
 

 
 
Order Column  This column allows you to define the order that payment 

options appear on the checkout page of your store.  
 
Provider Name  The second column is the list of payment companies / 

methods currently supported. 
 
Configure You can set the necessary details of the payment method. 

 
38  © Ecommerce Templates 



 
 
Supported Payment Providers 

n will simply email you th  from a purchase. It will 
redit card information  if you would like to 

s, checks, cash on n make it clear on 
yment methods and process you are willing to accept here 

 to change the default he “Show As” field. 
hange this to some  depending on what 

 it for. 

 
Email 
 
The email optio e order details
not include any c
accept money order
your store the pa
and it’s possible
You may wish to c
you will be using
 

and can be used
delivery etc. You ca

text for “Email” in t
thing like “Check”

 

ou can have a second email type payment provider by selecting Email2 and 
 

Y
a third by downloading the files from 
www.ecommercetemplates.com/free_downloads.asp and uploading these to 
your vsadmin/inc/ folder. From the payment provider list, this would be listed 
as “Custom”. 
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Supported payment providers 
 
Please view our online help pages listed below for help with setting up wit
the supported payment providers 

h 

 
ASP Version PHP Version 
· Using 2Checkout 
· Using Author

· Using 2Checkout 
ize.net · Using Authorize.net 

· Using Linkpoint  Using PayPal ·
· Using PayPal Pro 
· Using Linkpoint 

· Using Payflow Link 
· Using Payflow Pro 

· · Using PayPal Using Payflow Pro 
· Using Payflow Link 
· Using WorldPay 

sing USAepay· U  
· 

· Using PayPal Pro 
· Using Secpay 
· Using WorldPay 
· Using USAepay Using Moneris 

· Using PSiGate 
sing Secpay· U  

· Using Ogone 
· Using PayGate 

· Using Ogone · Using Paymate 
· Using Paygate 
· Using Protx 

sing ePDQ· U  
sing Paymate· U  
sing eway· U  
sing NOCHEX· 

· Using eway 
· Using Moneris 
· Using PSiGate 
· Using Protx 

U
· Using ePDQ 
· Using NOCHEX

 
 
Capture card (ASP version) 
 
Some people want to capture their own credit card numbers to run through a 
terminal as a quick and easy way to get their online store going. For this we 
provide Capture Card, however please be aware that the fact that you are 
responsible for your customers’ credit card details makes this far from 
simple and we strongly advise using one of the online credit card 
processors unless you are fully aware of all security issues involved. 
 
You will need a SSL certificate installed, either your own or shared from your 
host. 
 
IMPORTANT NOTE 
To reduce security risks set the automatic deleting of credit card information 
to a workable minimum level - we would suggest that 2 days is more than 
mple time. This setting can be found on the main admin page. You can also 

info
p p to date with the latest ecommerce template 

hich are released at regular intervals. 

a
manually delete the credit card information from your database by hitting the 
"delete" button. We strongly advise that you delete the credit card 

rmation as quickly as possible to reduce the security risks. It is also 
erative to keep uim

updaters w
 
Requirements. 
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http://support.persits.com/encrypt/demo_cert.asp
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· W
· SS

Personal certificate  
· ASPEncrypt component installed on your server 
· Internet Explorer 5.5+  
 
Setting up the "Capture Card" system with ASPEncrypt 
installed. 
 
To set up the "Capture Card" system please do the following. 
 

1. To obtain a Personal Certificate, please go to the following URL and 
follow the onscreen instructions. 

 
http://support.persits.com/encrypt/demo_cert.asp

indows server supporting .asp pages and an Access database  
L certificate  

· 

 
2. Once you have installed your Personal Certificate in Internet Explorer, 

you must now export your Public Key. To do this, in Internet Explorer go 
to Tools -> Internet Options and click on the "Content" tab. Now click on 
"Certificates…".  

 

 
 
3. On the "Personal" tab you should see the certificate you have just 

installed. Click on this and choose "Export…" to bring up the export 
certificate wizard. 
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4. The first step of the wizard will ask you if you want to export the private 

key with the certificate. You MUST select "No, do not export the private 
 export the private key you will be key". This is most important as if you

compromising the security of the system. 
 

 
 
5. On the next page of the wizard choose Base-64 encoded X.509 (.CER) 

as the format. Now give the file a filename such as certificate.cer and 
save it on your desktop or somewhere you have easy access to it. 
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xt editor and open this certific6. Run notepad or other te ate.cer file. 
 

 
 
Remember that as certificate files are automatically created with a .cer 
extension, to look under "all files" and not just files with a .txt extension.  
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7. Open your Ecommerce Plus template online admin section, click on 
Payment Providers and then click on modify for Capture Card. 

 

 
 
8. You want to make sure the processor is "Enabled", select the credit 

card types that you want to use and in the box at the bottom where it says 
"Upload New Certificate" you want to copy and paste all the information 
in your certificate.cer file to the this box, and then click "Submit" to 
upload the certificate information. 

ow try a test transaction. After the first checkout page all information will be 
 
N
taken on a secure connection.  
 
(For instance https://www.yoursite.com/cart.asp.) For this to work you will 
need to have an SSL certificate installed on your site, and which you can 
obtain from www.thawte.com or www.geotrust.com.  
 
If you do not have an SSL certificate installed then for testing purposes you 
an override this by opening the file vsadmin/includes.asp and set the 

 
pathtossl = "http://www.yoursite.com/" 
 
(Obviously you would replace yoursite.com with the actual name of your site.) 
This will force the system to use an http (unsecure) instead of https (secure) 
connection. 

c
following  
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You can also use this method if you want to use a different URL for your 

r, both locations must be able to see 

dit card number. Log in to your Ecommerce Plus admin section and go 
 the orders page. Now click on the order you just made. You should see a 

install Xencrypt by Persits software. 

. You can also manually 
elete the credit card information from your database by hitting the "delete" 

 
1. d follow the 

nscreen instructions.  

Click on the new certificate and choose "Export"  

it to you desktop  
. Open the file certificate.cer in Notepad or your favorite text editor  

the "payment 
providers" page  

lect the credit card types you want to allow  
1. Paste all the code from the certificate.cer that you have open in 

secure connection. Though do remembe
the database. 
 
Also, the switch to secure server relies on the setting of the store URL in the 
admin main page, so do remember to set this properly. 
 
To complete a Capture Card transaction you will need a valid test credit card 
number such as 4111111111111111 and just choose any date. 
 
After completing a test transaction you now want to make sure you can view 
the cre
to
certificate pop up asking if you want to 
This is the object that will "decode" your credit card numbers, so please select 
Yes to install this if you wish to view the results of credit card transactions. 
This process only needs to be performed once. Remember to always view the 
admin orders page on an HTTPS connection. 
 
To reduce security risks set the automatic deleting of credit card information 
to a workable minimum level - we would suggest that 2 days is ample time. 
This setting can be found on the main admin page
d
button. 
 
Checklist for the ASPEncrypt method 

Go to http://support.persits.com/encrypt/demo_cert.asp an
o

2. In Internet Explorer go to Tools -> Internet Options -> Content -> 
Certificates  

3. 
4. Select "No" to export the private key  
5. Choose Base-64 encoded X.509 (.CER) as the format  
6. Name the file certificate.cer and save 
7
8. In your admin section of your ecommerce template open 

9. Click on "Modify" for the "Capture Card" option  
10. Se
1

Notepad to the box entitled "Upload new certificate"  
12. Press submit and test!  
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F.A.Q. 
 

• · What is ASPEncrypt?  
• · Can I use my host's shared SSL certificate? 
• · What is a personal certificate? 
• · Is this system really secure? 

e for better security. In 
ivate key such as digital signing 
ut jeopardizing the security of the 

eotrust or InstantSSL. 

s the credit 
ard details are encrpyted, this will be necessary so that only you have 

's as secure as we can possibly make it. If anyone was to gain access to 
your database, they wouldn't be able to see any of the sensitive information 
stored there as it is in an encrypted form. As with any web site, store or 
application you should always pay particular attention to the security issues. 
Remember to secure your database so that it cannot be downloaded, make 
regular back-ups, change your passwords, make them alphanumeric and if 
you are running your own server, keep your Windows patches updated. 
 
We have provided more information about setting up on a secure server here

 
What is ASPEncrypt? 
 
ASPEncrypt is a component that resides on your host's server. It provides a 
client-side ActiveX sub-component, called XEncrypt, which performs all 
ryptographic operations directly on your machinc

particular, operations involving the user's pr
nd data decryption can be performed withoa

private key. More information from www.aspencrypt.com. 
Not all hosts have the component installed so it is worth asking - we 
recommend the Windows hosting at www.servelink.com  
 
Can I use my host's shared SSL certificate? 
 
Yes, you can. Alternatively you can apply for your own through a company 
ke Thawte, Gli

 
What is a personal certificate? 
 
This is a data structure that stores someone's personal information such as a 
name or email address, together with this person's public key. A
c
access to the credit card information through your control panel. 
 
Is this system really secure? 
 
It
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Capture Card (PHP Version) 
Some people want to capture their own credit card numbers to run through a 
terminal as a quick and easy way to get their online store going. For this we 
provide Capture Card, however please be aware that the fact that you are 
esponsible for your customers credit card details makes this far from 

 
rocessors unless you are fully aware of all security issues involved. 

d a SSL certificate installed, either your own or shared from your 

dmin section, and click 
 

"Enabled", select the credit card types that you want to use. 
 

2. Open the file vsadmin/includes.php and set $encryptmethod=""; to 
$encryptmethod="mcrypt";. 

 
It does require the mcrypt library 2.4 or above to be compiled with PHP so 
ask your host. You also need to set a "pass phrase" in the 
vsadmin/includes.php file. For instance... 
 
$ccencryptkey = "spqncopw this is a good passphrase to use"; 
 
Do make it unique. Do add random text. Do make it at least 32 characters 
long. 
 
Please note that if someone manages to compromise your database AND 
your site so they gain access to your secret phrase, then it is possible that 
they can decrypt the credit card numbers. It is not a public / private key type 
algorithm. However it does add an important extra level of security. 
 
You can also set the encryption cypher used by setting for instance... 
$mcryptalg = MCRYPT_RIJNDAEL_128; 

r
simple and we strongly advise using one of the online credit card
p
 

ou will neeY
host. 
 

PORTANT NOTE IM
To reduce security risks set the automatic deleting of credit card information 
to a workable minimum level - we would suggest that 2 days is more than 
ample time. This setting can be found on the main admin page. You can also 
manually delete the credit card information from your database by hitting the 
"delete" button. We strongly advise that you delete the credit card 

formation as quickly as possible to reduce the security risks. It is also in
imperative to keep up to date with the latest ecommerce template 
updaters which are released at regular intervals. 
 
To set up the "Capture Card" system please do the following. 
 
1. Open your Ecommerce Plus template online a

on modify for Capture Card. You want to make sure the processor is
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...in your includes.php page. A list of cyphers supported in PHP is available 

pt.php 
 

ting purposes you can override this by opening 
e file vsadmin/includes.php and set the following  

 a different URL for your 
ecure connection. Though do remember, both locations must be able to see 

emember to set this properly. 

rce Plus admin section and go 
 the orders page. Now click on the order you just made. Remember to 

here... 
http://www.php.net/manual/en/ref.mcry

Now try a test transaction. After the first checkout page all information will be 
taken on a secure connection. ( 
 
For instance https://www.yoursite.com/cart.php.) For this to work you will need 
to have an SSL certificate installed on your site, and which you can obtain 
from www.thawte.com or www.verisign.com. If you do not have an SSL 
certificate installed then for tes
th
 
$pathtossl = "http://www.yoursite.com/"; 
 
(Obviously you would replace yoursite.com with the actual name of your site.) 
This will force the system to use an http (insecure) instead of https (secure) 
connection. 
 
You can also use this method if you want to use
s
the database. 
 
Also, the switch to secure server relies on the setting of the store URL in the 
admin main page, so do r
 
To complete a Capture Card transaction you will need a valid test credit card 
number such as 4111111111111111 and just choose any date. 
 
After completing a test transaction you now want to make sure you can view 
the credit card number. Log in to your Ecomme
to
always view the admin orders page on an HTTPS connection. 
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To reduce security risks set the automatic deleting of credit card information 

 manually 
delete the credit card information from your database by hitting the "delete" 
button. We strongly advise that you delete the credit card information as 
quickly as possible to reduce the security risks. 
 
We have provided more information about setting up on a secure server here

to a workable minimum level - we would suggest that 2 days is ample time. 
This setting can be found on the main admin page. You can also

 
Custom 
 
This option is for anyone wanting to add a payment provider that is not 
currently supported by Ecommerce Templates. 
 
It does require a solid knowledge of coding but this option will make things 
simpler as the database is already set up to handle an extra processor and 
any updates that are made in the future will not overwrite the modifications 
that have been made. If you are not confident about making the changes 
yourself, then we suggest contacting one of the developers here for a quote. 
 
Do be aware also that not all payment systems will fit into the model we have 
provided, but the vast majority should. 
 
We do have a lot of Custom payment providers already set up, so please 
check here for the latest list 
www.ecommercetemplates.com/free_downloads.asp
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Setting up a secure server 

authorize.net (AIM) and 
t portion of the process 
 of doing this. One is to 

ave a secure certificate installed on your web. (Your host can tell you if this 
 possible with your hosting plan). This means that you can access your web 

on secure (http) and secure (https) methods. For instance both 
id... 

site.com/products.asp 
om/products.asp 

 you enable a payment method that does require the checkout on a secure 
server, then the second stage of checkout will automatically switch to a 
secure server. As during testing you may not have a secure certificate 
installed, we have provided a method for you to override this. In your 
vsadmin/includes.asp/php file set the following... 
 
pathtossl = http://www.yoursite.com

 
Some payment methods like PayPal Payflow Pro, 
Capture Card amongst others require that the checkou
take place on a secure server. There are two methods
h
is
using both n
these URL´s would be val
 
http://www.your
https://www.yoursite.c
 
If

 
By doing this you will force the second stage of checkout to remain on a non 
secure (http) connection 
 
One thing to note is that if you are on an https connection and then click on 
say the link to the categories.asp/php page, you will remain on the https 
connection, which is not really desirable. To overcome this you can make all 
your links absolute. For instance, don’t link to categories.asp/php but rather 
link to http://www.yoursite.com/categories.asp 
 
Some hosting providers may provide shared space on their secure server. 
Generally this is a cheaper option as you don’t have to purchase your own 
secure certificate, but it is a bit more difficult to set up. 
 
The first thing you must make sure of is that you can access your database 
from both the secure and the non-secure areas. Your host can tell you if this 
is possible when you contract the secure space. 
 
You will need to make a copy to your secure area of the thanks.asp/php and 
cart.asp/php pages. Also, you will need any images from your images 
directory that are used by these pages and the whole vsadmin directory on 
the secure space. 
 
Now set the pathtossl, for instance... 
 
pathtossl = "https://secure.yourhost.com/yourdir/" 
pathtossl = "https://yoursubdomain.yourhost.com/" 
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As above, rememb
your customers do not get stuck on 

er to make links in your site absolute to make sure that 
the secure portion of your site. 
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Chapter 3 
Categories and Products 

ing the Categories
dding a new category  

 
 
Introduction
Access
A
Adding products
Product options

iscounts and couponsD
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Introduction 
After setting up the main settings, the next step will be to get your own 
categories and products on your store. The software does come with some 
sample data for you to work. You can have up to 10 levels of sub-categories. 
 
Accessing the Categories 
Select the “categories” link from the left hand menu. 
 
 

The following screen will appear 
 

 
 

The Screen Explained 
Order Category Path: This will give you the hierarchy of your category set 
up. The Home option refers to categories.asp / categories.php. The drop 
down option on the left allows you to order the categories on your store 
(requires MSIE 5+) 
 
Category Name: This is the working name assigned to your category – it may 
be different from the name that appears on your store depending on the 
naming system you have chosen. Text in bold denotes a category that can 
have products added to it. The number in brackets (15) refers to the category 
id and is useful when manually setting up links on the store. 
 
Discounts: Option to assign a Discount 
 
Modify: Modify the properties of the Category 
 
Delete: Delete a Category 
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Adding a New Category 
Click on the New Category button 
 

 
 
The Screen Explained 

ategory Name: This is the name of the caC tegory that will appear on your 
. 

al use only and is useful when you 
e name. 

op down allows you to choose the category 
g. In the example above, “Toshiba” will be a sub-

”. 

egory may have products added to it, in this case select “Products can 
to be further sub-categories in the 

hierarchy then select “Categories can be added to this category”. It will not be 
. 

 

 a 

store
 

ry Working Name: This is for internCatego
have categories that could have the sam
 
Sub Category Of…: This dr
bove the one you are addina

category of “laptop1
 
Category Function: There are two options when setting up a new category. 

he catT
be added to this category”. If there are 

possible to add a product to a category that has subsequent sub-categories
 
Category Image: This is an optional field where you would place the path to
the image to accompany the category name. 
 
Category Description: Also optional if you would like to describe the 
category to your users. It is possible to add HTML to this field. 
 
Login level: This is an optional field where you can set the login level to be 
used in conjunction with the client login feature. It is also possible to disable
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category (and all their products) rather than delete it so it can be put back at a
later date. (Vers

 
ion 4.8.0 + required). 

o optional if you would like to specify the static URL of the 

ynamic URLs as the store is browsed. It also works with the DHTML menu 
and avoids duplicate URLs / content on the store. (Version 4.8.4 + required). 
 
Overview 
The multiple category system allows for a hierarchy of up to a depth of 10 sub 
levels. If you inadvertently exceed the 10 levels an error will appear. Products 
can only be added to the last category in your hierarchy. Be sure that when 
creating sub categories you don’t get into a loop of categories when the "Top 
Category" of one of your categories links back to one of its own sub 
categories. If this occurs you will see the error message “LOOP”. You must fix 
this before continuing. 
 

 
Category URL: Als
category which would have been set up using the search engine friendly 
features. This now means that your menu system won't pick up on the 
d
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Adding products 
Once you have at least one category defined it’s possible to start adding 

w 
d 

tock 
 view the full inventory and full product 

formation then choose "Product Inventory" from the drop down. 

products to the store.  
 
The first screen you will see when clicking on the Edit Products link should 
look something like this. To view all the products on your store, click on "List 
Products". If you are using the Stock Management feature then you can vie
all out of stock products by clicking on "out of Stock". If you want to downloa
a .csv file with a listing of products and stock levels then select "S
Inventory" and hit the "Go" button. To
in
 

 
 

If you have a large number of products on your store then you can refine the 
product listing by using the product search feature. To search via price ranges
you can use this kind of set up 
 
50 

 

s between $10 and $50 

cts 
 

-
. . . for all products up to $50 
0-50 1

. . . for product
50- 
. . . for products above $50 
 
Editing produ
Once you have your product listing you should see a screen similar to the one
below. 
 

 
 

 red will denote that they are out of stock (if using stock 
e number in brackets refers to the number of items left in 

Products shown in
management). Th
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your inventory and you can update the inventory from this page with the 
boxes on the left. 
 
If you see a product with a red asterisk next to it (*) then it means that the 

 
ny discounts or coupons at product level then these can be assigned here 

nt has been set up in the discount admin page. To modify an 
xisting product hit 

Ctrl> + Modify. The related column is used for the upselling features added 
.  

elow we have laid out some help with the various fields available when 
duct. Fields marked with an asterisk (*) are obligatory. 

category the product has been assigned to has been deleted. If you are using
a
once the discou
existing product, click on the modify button, to clone an e
<
in version 5.1
 
Adding products 
B
setting up a new pro
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Reference 

Prod Name 
The name of your product. 
 
Section 
Choose from the categories you have set up as to where you want to place 
the product. Use the Additional Sections option below to place your product in 
more than one category. 
 
Price 
The price of the product.  
 
Wholesale Price 
This is used in conjunction with the customer login feature and will be the 
price that logged in customers will see. 
 
List Price 
This will show a price with a strikethrough like this List Price: $50.00 on the 
product and product detail pages. 
 
In Stock 
If you are using the stock management feature then you will see a drop down 
menu here. Choose in stock to specify the number of items you have in stock. 
Choose by options if you want set the stock management by product options 
and then edit the stock level through the product option admin page. If you are 
not using Stock Management then you will see a box labelled Sell Button, 
checking that will show a buy button next to the product, unchecking it will 
show an Out of Stock message. This message can be edited in 
vsadmin/inc/languagefile.asp / .php 
 
Display Product 
Checking the box here will display the product on your store. Leaving it 
unchecked will keep the product information in the database but it won't 
appear publically. 
 
Image 
This is the path to the image that appears on the product page. The default 
location for the product images is the /prodimages/ folder but you can change 
that. Click on the ... button to browse your hard drive and upload the image 
you need. For the ASP version you will need to check with your host that the 
component "ASPupload" is installed on the server and that you have this 
setting in vsadmin/includes.asp - useaspuploadforimages=TRUE 
 
Click on the "More" button to show up to 5 pictures on the products page 
 
Large Image 

The product ID must be a unique identifier. 
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This is the path to the image that will appear on the product detail page. Click 

how up to 5 pictures on the product detail page. 

ers admin page. This 
an be included on the search page to narrow down search options and be 

 

 
ain admin settings. If you choose to use dimensions then this will need to be 

The weight of the product that enables the calculation of shipping. This should 
be expressed as a decimal. 
 
Product Options 
Select the number of product options that are to be associated to a product.  
 
Drop shipper 
Select the drop shipper that is associated to the product 

escription 
his is the description that will appear on the product page. You can add 

 text to your requirements.  

t the text to your requirements. 

ne friendly features. 

on the "More" button to s
 
Giant Image 
This is the path to the image that will be linked from the product detail page. 
Click on the "More" button to show up to 5 pictures. The linked image can 
either appear on a new page or in a pop-up window. 
 
Manufacturer 
Select from the manufacturers set up in the Manufactur
c
shown on the products page. 

Dimensions 
This option will only appear if you have selected the dimensions box from the
m
set for all products. 
 
Product Weight 

 
D
T
HTML here to format the
 
Long Description 
This is the description that will appear on the product detail page. You can 

dd HTML here to formaa
 
Exemptions 
Select any exemption that apply to the product. Use <Ctrl> + click for multiple 
selections. 
 
Has static page 
Only check this box if you have set up a static product detail page. The 
roduct detail page link will take the form of. . . p

the_product_name.asp 
. . . where the page name will be made of the product name, in lower case 
with spaces replaced by underscores and non alphanumeric characters 
removed. You will need to set up the static page previously following our help 
age on search engip
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Recommended 
ick the box here if you would like this product to be shown as recommended 

he products on the publically viewable product 
ges. These can be in ascending or descending order depending on the 

 one category then select 
e number of additional sections here and choose from the available 

T
when any other product is added to cart. 
 
Product Order 
Enter a value here for ordering t
pa
setting sortBy=6 / sortBy=7 includes.asp or $sortBy=6; / $sortBy=7; in 
includes.php. 
 
Additional sections 
If you would like your product to appear in more than
th
categories. 
 

 
 

Once the number is selected you should be presented with the same number 
of drop downs where it is possible to choose the relevant categories. 
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Product Options 
Product options allow your customers to choose specific attributes or add-ons 

 

 also possible to plug-in the weight difference if applicable so shipping can 

 panel. 

for each product. This would typically be an item of clothing offered in various
colors or a build your own computer system where the buyer can choose the 
processor, memory, monitor etc. Any price changes are shown in real time - it 
is
be calculated correctly. Version 4.9.0 saw the introduction of a feature 
allowing the product option to have its own product id. 
 
Select the “product options” link from the left hand menu of your control

 
From this screen you can clone, modify or delete an existing product option or 
dd a new one. There is also the possibility to add a New Text Input Option. 

hould see a screen with this at the top: 
 

a
 
Setting up a new Product Option 
 
Click on New Option and you s

 
 
 
 
The Screen Explained 
 
Option Name: This is the name that is displayed on the products page next to 
the product it relates to. 

orking Name: This is for internal use only and helps identify the product 
 

 
W
option in the admin section. It may be that you have different product options

 
© Ecommerce Templates Page 61 of  255 



 

for colors depending on the product eg different colors available for socks and 

ption Style: Choose to show your product options as a drop down menu, 

he Multiple Purchase feature was introduced in Version 5.5.0 and allows 
age 

 to cart. It will appear on the product and / or product 
etail page like this: 

shoes. 
 
O
radio buttons or Multiple Purchase.  
 
T
customers to select different quantities of product options from the same p
before adding them all
d
 

 
 
No default: Select here if there is no default product option to be shown.  
 
Single line: Select here if you want the options to appear on the same lin
rather than one below another. 
  
"Please Select" line: If selected this will show the message "Please Select" 

e 

lection: 
t they are purchasing. 

before the product options.  
 
Force Se Check this box if you want to force the customer to select a 
product option for the produc
 

elow that box, you should see a screen like this B
 

 
 
The Screen Explained 
 
Click on the Plus button to enter a new product option anywhere in the list 

ptions / Values: These are the product options that will appear with the 
roduct it has been assigned to. 

rice Diff: If there is a price difference associated to the product option then it 
an be added here. For example if the option costs $1 more than the base 
roduct price then place "1" in the Price Diff box. If the option costs 10% more 

 
O
p
 
P
c
p
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than the base product price then check the percentage box and place "10" in 

e Price Diff box. 

eight Diff: If there is a weight difference associated to the product option 
en it can be added here. For example if the option weighs 1 kilo over the 
ase product weight then place "1" in the Weight Diff box. If the option weighs 
0% more than the base product weight then check the percentage box and 
lace "10" in the Weight Diff box. 

elect Options / Alternates to continue configuring the product options 

th
 
W
th
b
1
p
 
S
 

 
 
Alt Prod ID: Version 4.9.0 saw the introduction of this feature. It is now 
possible for the product option to have its own product ID. This can simply be
a substitute product id, for instance if the product id is "product1", the you can 
enter "product2" for the Alt Prod ID if you require this product option to change
the product id to "product2". 
 
MPO

 

 

RTANT NOTE: Please note that the substitute product id must exist in 
e database. You must create it as normal on the product admin page, and if 

you don't want it to show separately uncheck the "Display Product" checkbox. 
 
Advanced changes can also be made with the Alt Prod ID. Any instance of %s 
will be replaced with the original product id. For instance if the Alt ID is 
"%s_red" and the original id is "product1" then the result would be 
"product1_red". This is very useful when applying the same change to 
multiple products. 
Another advanced feature is "search and replace" in the product id. If you 
have a space in the Alt Prod ID, anything to the left will be searched for in the 
product id, and replace with whatever is to the right of the space. An example 
would be an Alt ID of "MARKER red" and a product id of 
"product_MARKER_42" which would yield "product_red_42". This can be very 
useful when dealing with multiple options that all modify the product id. 
 
Alt Image: From version 5.5.0 you can assign different images with the 
product option choices. This means that as a customer selects a product 
option the image will change accordingly. In this field you should place the 
path to the image you want to appear on the products page when an option is 
selected. 
 
Alt Large Image: This is where you would place the path to the image that 

ould show on the product detail page once an option has been select . 

I
th

w ed
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Adding a Text Input Option 

se  when you need the customer to add some 
 
The text input option is u d
information regarding the product. This might be a personalized message 
added to the product or if you are selling domain names, the domain that the 
customer wishes to buy. 

 
 

The Screen Explained 
 
Option Name: This is the name of the option that will appear on your store. 
 
Working Name: This is for internal use only and is useful when you have 
options that could have the same name. 
 
Default Text if any: If you need to populate the field on the store then add the 
message here. If not then leave blank. 
 
Force Selection: Check this box if you want to force the customer to add 
some text to the box. 
 
Field Width: The width of the box that will appear on the store. 
 
Field Height: If you set this to a number higher then one then you will create 
a multiline box, useful when loner input is required. 
 
Assigning a Product Option to a Product 
 
Once you have set up the product options you need you can then assign them 
to their corresponding products. From the left hand menu select Product 
Admin and then Modify for the product that needs a new option. On the 
products admin page you should see a box where you can specify how many 
different product options (eg color, size) need to be assigned to the product. 

 
Once you assign the number then the corresponding number of drop down 
choices will appear so you can select the options that need to go with that 
product. 
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F
 

requently asked questions 

tion  from the products page? 

ptions=true to includes.asp 
or e

 
 c e price difference for the product 

ptions? 
For e

cediffs=true; to includes.php  

nts and Coupons 
Dis u  you to give 
our clients special offers on products or categories, allow wholesalers to 

g 
r help clear "difficult to sell" stock amongst many other uses. Once you have 

upons you wish to use on your store you can go 

How can I hide the product op s
How can I hide the display of the price difference for the product options? 
 
How can I hide the product options from the products page? 
For the ASP version add noproducto
F  th  PHP version add $noproductoptions=TRUE; to includes.php  

an I hide the display of thHow
o

 th  ASP version add hideoptpricediffs=true to includes.asp 
For the PHP version add $hideoptpri
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Discou
co nts and coupons are powerful marketing tools that allow

y
purchase at special rates, provide incentives through your offline advertisin
o
set up the discounts and co
back to the product / category admin pages to assign the ones you want to 
use. 
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his explains theT  options you will see when you go to add a new discount or 

ble. A 
 

t below are met. Coupons are especially useful 
ns in magazines or through other advertising. 

coupon. 
  
Coupon or discount:   

The difference between a coupon and a discount is that a coupon will need a 
special code to be entered during the checkout phase for it to be applica
discount however will apply to all of your website visitors, as long as the
conditions you can se
therefore for promotio
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Coupon / Discount Effect:   

ou can set up more than one coupon or discount at a 

r 

 Name:   

n orders of $35 or more" 

upon code is GH777733D then in your magazine 
ld put the following "Special offer for readers of this 

ith some promotions you may want to limit the number available. For 

If you do not want to limit the number a ailable, just leave this field blank. 

umber Days Available:  

llows you to set a time limit in days. If you do not want to limit the time 
vailable, just leave this field blank. 

You can choose between Free Standard Shipping, Flat rate discount or 
ercentage discount. YP

time to have combinations of these. 
 

• A flat rate discount would be for instance "$20 off if you spend over 
$150 on our store". 

 
• A percentage discount would be for instance "5% discount on all ou

goods". 
 
Working

You have to assign a name or phrase to the discount you create. This text will 
also be shown to your website visitors to inform them of the discounts 
available so it should be meaningful and short. Examples of "Working Name" 
would be: 
 

• "Free Standard Shipping o
 
or 
 

• "10% discount if you buy 3 or more products from our store" 
 
Coupon Code:   

If you are creating a coupon, you will need to assign a coupon code. This is 
he code your website users will need to enter to access the discount. For t
instance, if your co
dvertising you coua

magazine. Enter the code GH777733D during checkout to receive a 5% 
discount". 
 
Number Available:   

W
instance: 
 

• "5% discount to the first 50 people who purchase". 
 

v
 
N

A
a
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Min Max Purchase Amount:  

his allows you to set minimum and maximum purchase limits for discounts to 
pply and also the ability to include discounts and coupons within a banded 
nge that can be defined here. So for example, spend between $50 and 

100 products for a 5% discount - spend between $100 and 150 for a 10% 
duction etc. 

.or you could have a simple set up like $25 off all orders over $100. 
 you do not want to use this feature, just leave the fields blank.  

in / Max Quantity:  

his allows you to set minimum and maximum limits for discounts to apply 
nd also the ability to include discounts and coupons within a banded range 
at can be defined here. So for example, buy between 5 and 10 products for 

- buy between 6 and 10 for a 7% reduction etc. 
 your "banded" discounts have the same name they will only 

s. For instance the case where 
. 

e, just leave the fields blank.  

epeat every: 

u to define how often the discount kicks in 

T
a
ra
$
re
 
..
If
 
M

T
a
th
a 5% discount 
Also note that if
be displayed once which can be advantageou
For every 11 products purchased, get one free
If you do not want to use this featur
 
R
 

oThis allows y

 
In the example above the discount will take effect following the second item 
purchased and won't be repeated until a further 10 items have been added to 
the cart ie. a minimum of purchase of 12 items. If you don't require any 
repetition and just want a flat rate discount then set Repeat Every to 0. 
 
Discount Amount:  

The actual amount of the discount. For instance for a Percentage discount of 
10%, just enter 10 here. For a flat rate discount of $15, just enter 15 here.  
 
Please note that for Free Standard Shipping, this value is ignored. 
 
Scope:  

You may want to have a discount of 5% if your customer buys 5 of a certain 
product. You may however want to offer a discount of 5% if your customer 
buys 5 of any product on your website. 
Likewise if you wanted to offer a discount of 5% if someone spends $50 or 
more on one particular product, or you may want to offer a discount of 5% if 
someone spends $50 or more on your website as a whole. 

 
68  © Ecommerce Templates 



 
 
The "Scope" allows y
 

ou to do both of these types of discount. 

ou would use the setting "Applies storewide to product totals" for setting 
e.  

Assign to cat’s for discounts on category totals" allows you to narrow 
e 

ategories admin page and you should see a column "Discounts" and click on 
the "Assign" button. 
 
"Applies storewide but to individual products" would set up a discount 
that applies to totals of a particular product. Now go to the products admin 
page and you should see a column "Discounts" and click on the "Assign" 
button. 
 
"Assign to individual products / cats" allows you to narrow down the effect 
of a discount to an individual product or category. Once you have created this 
type of discount, you can then assign it to a particular product or category. To 
do this, go to your products or categories admin pages and you will see a 

untries:  

 enables you to set 
To set the countries to 

 will see 

cked will be eligible for free standard shipping. Remember that a 

u will have to enter the product id 

 

Y
up a discount which applies to product totals on total purchase on your stor
 
Once you have set up a discount of this type it is automatically in effect and 
you need do no more. 
 
"
down the effect of a discount to individual categories. Now go to th
c

column "Discounts" with a button  
 
Restrict to certain co

This setting only applies to "Free Standard Shipping". It
ee shipping only for orders within a particular country. fr

which free shipping applies, go to your countries admin page and you
a column "FSA" which stands for "Free Shipping Applies". Only those 
ountries chec

rule will have to be set up first in your discount admin page for this to apply. 
 

uantity Pricing Q
 
In version 4.7.0 we introduced the option of quantity pricing. This means you 
can adjust the price depending on the number of items of a particular product 
purchased. To access this feature you will need to click on the Quantity 

ricing link on your main admin page. P
 
Check the box on the quantity pricing page if you want to show a drop down 
menu of all product ids you have available when setting up the price breaks. 
eaving the box unchecked means that yoL

manually. 
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Chapter 4 
Orders and Affiliates 

rders admin
rder details

rop shipping 

 
 
 
O
O
Order status types  
Affiliates program
D
Customer login
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Orders admin 
 
Hopefully the Orders Admin page will be the one you will visit most so it is 
important to know your way around. You will receive a notification email for 
each order that is placed through your store but it is a good idea to check the 
page regularly in case the purchaser didn’t make it back to your store after 
buying and the email notification wasn’t triggered. 
 
Clicking on the View orders link should bring up the orders admin page: 
 

 
 

The interface here will provide you with all the information on orders as we
as the ability to search your order database, change the order status, 
download orders etc.

ll 

 

o refine the search options you can select one or a combination of 

ge. 

o 

 Till field blank. 

er 
 the 

rder ID  

uth code 

 
The various options on this screen are outlined below: 
 
T
parameters: 
 
Orders From / On – Orders Till: This is where you can specify a date ran
Clicking on the “DP” button will bring up a calendar for easier date selection: 
 
It is also possible to add single numbers to the From / Till fields. If you need t
view orders between the last 2 to 4 days then place 2 in the Orders From box 
and 4 in the Orders Till. If you need all orders for the previous 4 days then 
place 4 in the Orders From box and leave the Orders
 
Order ID: if you know the order id you want to check then placing the numb
here will bring up the details of that particular order eg. Type “503” to view
details of order number 503. 
 
Search Text: This will allow you to perform a search selecting from the 
following parameters: 
O
Email address 
A
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Name  
Address 
Zip 
Phone number 

 and can be further refined by choosing the date selection, payment 

your orders are coming from.  

 
ill give details of the order such as address, 

price, quantity and shipping. 
 
Dump details to CSV file: This will also include the product information. 
 
New Order: Click here to manually enter an order 
 
Packing slips: Select the orders using the checkbox next to each order to view 
multiple packing slips on the same page. When printed they will print on 
separate sheets. 
 
Invoices: Select the orders using the checkbox next to each order to view 
multiple invoices on the same page. When printed they will print on separate 
sheets. 
 
Order details 
 
When viewing the order admin page or looking at the results of a search you 
will be presented with a table of results: 
 
Order ID: This is the order number and the first order on your store will be 
“501”. Click on the order number or on the Name to bring up the full details of 
that particular order. 
 
Printing the invoice / packing slip 
If you select Printable Packing Slip or Printable Invoice from the drop down 
menu you will be presented with a printable version. 
You can add your own header, address and footer to smarten it up – to do this 
you will need to make the changes in your vsadmin/includes.asp file there are 
details in our Advanced tweaks chapter and on our parameters page. 

 
Method: This will show how the client has paid. Information in red will indicate 
an uncompleted order. 
 

Affiliate id 
Invoice number 
 
…
method, state, country and/or Order Status. This will also come in useful for 
your marketing when you can make advertising decisions based on where 

 
Dump orders to CSV file: Clicking here will prompt a download of the orders.
This can be opened in Excel. It w
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Auth code: This is a very important field and particular attention should be 

pears here. Under normal circumstances, when 
thorization code will appear here – this means 

at the order has been received and the purchaser has returned to your store 

reason is that the 
uyer abandoned the cart before going through with checkout. It may be that 

they changed their mind, suffered a power failure or were simply testing the 
system, however it may also be possible that they never made it back to your 
store after purchase. For this reason it’s important to check with your credit 
card processing admin page before deleting or authorizing. If you find that the 
order did in fact take place then you can click on the authorize button and add 

rd of 

 
wn as zero. This is an incomplete order and hasn't 

een paid for. The only reason they are eft there is for the user's information, 
such as if you see a lot of incomplete orders you might want to check why 

rder is 
sed (you 
 page) 

ayment processor or ask for help on 
ur support forums. 

One thing to note, if you are using the email methods of checkout and set 
emailorderstatus to less than 3 then the order will not be closed properly as 
orders with status less than 3 are not authorized. 
 
Status: This is where you can set the status of your order and the default 
options are unauthorized, cancelled, deleted, authorized, packing, shipping, 
shipped, completed. It is possible to change these values in Admin Order 

paid to the message that ap
an order goes through an au
th
and should have received email notification of their purchase. If you see an 
“authorize” button, as in the example above, the most likely 
b

the authorization code given by the payment processor. If there is no reco
the order you can delete from the drop down in the “Status” field. 
 
IMPORTANT NOTE 
If a customer goes to the checkout page then backs out to the cart again the
rder totals may be shoo

b l

customers are not going through with the purchase. 
hen the customer makes payment and returns to the site the oW

"closed". IF after making payment and returning the order is not clo
would notice there is still an "authorize" button on the admin orders
then you should check the setup of your p
o

Status page to give a clearer message to the public if they choose to view the 
status of their order. 
Using Internet Explorer on a PC there is a quick method for changing lots of 

us changed 
ers. 

n in the system for 3 

ge deleted” will remove all trace of deleted orders. 

order status at once. If you say change an orders status to "Shipped" and hold 
down the Ctrl key the all the orders on that page will have the stat
to shipped. This is not available on other brows
 
Purge deleted: Once an order is deleted, it will remai
days – this is a security measure in case an order is deleted by mistake. 
Selecting “pur
 
At the bottom of the page it is possible to quickly flick through date ranges, for 
example, orders from a month ago, a week ago, yesterday etc. 
 
Editing order details 
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Version 4.9.0 saw the introduction of the ability to edit all the clients' order 
details. To use this feature select Edit Order Details from the drop down menu 
and click on the name of the purchaser. 

 
You will then be presented with the full order details in form fields. All of these 
can be edited but do remember to click on "recalculate" and "update" after 
making any changes. 
 
If you need to edit one of the product options click on the box under Product 
ID and the Options field will appear with a drop down of available choices. 

 
If you need to add more items to the order then click on the "+" button, to 
remove products click on the "-" button. Remember to recalculate the order 
after changes have been made. 
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Order status types 
 
It is possible to configure up to 18 parameters for the order status by clickin
on the “Edit Order Status Types” on the main admin page. 
 

g 

 
 

The first four options are pre-defined ie. Cancelled, Deleted, Authorized, 
Unauthorized. It is possible to change the text that the public will see when 
checking their order status but the meaning will be kept the same. For 
example changing the wording for “Authorized” will not change it’s meaning
for the store software. 
 

 

 
 

The following fourteen order types are free to edit as you wish. 
 
The customer can view their order status details through the page 

ww.yourstore.com/orderstatus.asp/php w
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ASP: If you do not have this page on your ASP site then
save it as orderstatus.asp and then in HTML view find th

 open the page products.asp 
e include line: 

="vsadmin/inc/incproducts.asp"--> 

tatus.asp"--> 
r with the other store pages in the root 

HP site then open the page products.php 
rstatus.php and then in HTML view find the include line: 

?php include "vsadmin/inc/incproducts.php"; ?> 
nd change it to: 
?php include "vsadmin/inc/incorderstatus.php"; ?> 
ave the page and upload to your server with the other store pages in the root 
f your web. 

<!--#include file
and change it to: 
<!--#include file="vsadmin/inc/incorders
Save the page and upload to your serve
of your web. 
 
PHP: If you do not have this page on your P
save it as orde
<
a
<
S
o
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Affiliates program 
 
This enables you to run a complete affiliate suite from your site - potential 
affiliates can sign up and enter their information and password, and you can 
iew the orders they generate through the online admin section. v

 

 
 
How the affiliate program is run is completely up to you - you decide on the 
percentage that will be paid out, how often and by what method - all the 
partner needs to do is place a link on their site including their partner code to 
earn commission. 
By default the affiliate cookie is set to 30 days - this means that if someone 
isits your site through an affiliate link one day and buys on another the 

 

 
ill need a minimum of version 4.5.0 and add the corresponding parameter in 
e vsadmin/includes.php / .asp page 

asically everything is in place for you to get started immediately - each 
template comes with a file called affiliate.asp/php - this will be where the 
partner can sign up and also log on to their account. 
 

v
partner will earn the commission as long as 30 days haven't passed since 
their first visit. You can change how long you want a cookie to stay actives in
the file vsadmin/includes.asp/php 
 
f you need to specify a default percentage that your referrers will earn, youI
w
th
 
How to set it up 
B
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The partner can choose to be notified by email of each affiliate sale that is 
made and the store owner can check the status of the acco
online admin. You may want to

unt through the 
 make a page or two previous to 

affiliate.asp/.php explaining the procedures etc. for earning commissions and 
also a disclaimer. 
 
Important information 
The referring URL will typically be in the form of 
http://www.ecommercetemplates.com/default.asp?PARTNER=name - you 
can ask affiliates to link to individual pages or sections by changing the URL 
before the question mark, for example 
http://www.ecommercetemplates.com/products.asp?PARTNER=name but it's 
very important that the page is linked to is a .asp/.php page and includes the 
following lines of code: 
ASP version: 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
 
PHP version: 
<SCRIPT LANGUAGE="php"> 
include "vsadmin/db_conn_open.php"; 
include "vsadmin/includes.php"; 
include "vsadmin/inc/languagefile.php"; 
include "vsadmin/inc/incfunctions.php"; 
</SCRIPT> 
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Drop shipping 

as added in Version 4.8.0 and allows you to group products per 
anufacturer, designer, dropshipper etc., keep track of the sales per group 

tification when a particular order is 

igner / Manufacturers link 

How it works 
This feature w
m
and includes the ability to send an email no
placed through your store. This may be to the drop shipping company, a 
manufacturer, a contributor or anyone really you need to notify of a sale. 
 
How to set it up 
The first thing you will need to do is set up an account for each drop shipper / 
manufacturer so click on the link Dropshipper / Des
from your admin home page and you will be presented with a screen like this. 
 

 
 

lickC  on the button "Click to Add New" and you will be able to set up the 
details. 
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Fill in all the details. If you want the drop shipper to receive notification of a 
sale with details of the order then select "Send Email" from the drop menu. 
Once you have set up the accounts for each entity you can then choose who 
needs to be notified from the drop down box on the product admin pages. 
 

 
 
Sales can then be tracked through the dropshipping admin page. 
 

 
 
The email address is clickable so you can contact the person directly and it
also possible to modify their details or delete the entry from the dropshipping 
admin page. 
 
You can add your own h

's 

eaders and footers to the dropshipper email as well 
as customizing the subject line. This can be done through 
vsadmin/includes.asp or .php. 
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Customer login 
 
In Version 4.2.0 we introduced the customer login feature. This allows for 
wholesale pricing / tax / shipping exemption for login customers and page 
protection. This means it is possible to offer retail and wholesale pricing 
without the need for a second database as well as offering tax and shipping 
exemption to particular users. You can also restrict access to certain pages of 
your site. 

ersion 5.3.0 saw the expansion of the customer login system to allow 

ipping addresses. 

HP Version

 

login status box on each page you will need to add 
one line of code where you would like the login box to appear. The code you 
need is the following: 
 
<!--#include file="vsadmin/inc/incminilogin.asp"--> 
 
Paste that into HTML / code view exactly where the login box should appear 
and make sure that it comes somewhere after the include lines: 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 

need to set up the login page itself. Open your thanks.asp page 

 
V
customers to create their own account, view their order history and save 
billing and sh
 
 
ASP Version 
P

Enabling customer login (ASP Version) 
If you would like to have a 

<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"-->  
 
To enable the login you will then need to go to vsadmin/includes.asp and add 
the line (if it's not already present) enableclientlogin=true 
 
Finally you'll 
and save it as clientlogin.asp. Then go in to HTML / code view and locate this 
line: 
 
<!--#include file="vsadmin/inc/incthanks.asp"--> 
 
....and change it to 
 

/incclientlogin.asp"--> <!--#include file="vsadmin/inc
 
Save clientlogin.asp and upload it to your server. 
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You should now be able to see the login box and the login page on your store.

 
Login Box 

 

 
Login Box after successfu

 
l login 

 
Login Box if enableclientlo

hasn't been set in vsadmin/in
 
 

gin=true 
cludes.asp 

 
Login Dialogue on clientlogin.asp 

 
gin you will be taken to a page to enter your email 

ddress and password 

  
Once you click on lo
a
 

 
 

Once logged in customers can view their account details, edit their shipping 
and billing address  customers to es as well as look up past orders. To allow
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sign up for an account you will need this addition to vsadmin/includes.asp  
allowclientregistration=true 
To force customers to login before purchasing add this to 
vsadmin/includes.asp 
forceclientlogin=true 
 
Customers will be prompted on checkout if they would like to log in or set up 
an account 
 

 
 
 
Setting up a client for wholesale pricing, discounts and
exemption 
 

 shipping / tax 

 your home admin page there should be a link client login admin, click to In
set up your clients' options. 
 

 
 

new client login to add the details and parameters available for 
ach particular customer. 

Click on 
e

 
 

Enter the client login name, email address, password, the relevant action (You 
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can use CTRL + Click to select more than one choice) and finally the login 
level if applicable. When done, click on submit and your client will have been 
set up with the parameters you have assigned. The promotional email box if 
checked will write the client's email address to the database and can be used 
for mail shots. 
 
Login level 
You can assign different levels of login permissions on any page to say that a 
particular page is restricted to anyone below the login level assigned in the 

inlevel=4 %> 
.where 4 is the threshold of permission for that page. This needs to come 

fore the line 

ill need to add 

inilogin.php"?> 

 
es somewhere after the include lines: 

vsadmin/inc/incfunctions.php"?> 

 need to go to vsadmin/includes.php and add 
nt) $enableclientlogin=true; 

 set up the login page itself. Open your thanks.php page 
login.php. Then go in to HTML / code view and locate this 

hanks.php"?> 

<?php include "vsadmin/inc/incclientlogin.php"?> 

login admin section. For example, if you set requiredloginlevel=4 then only 
people who you have set up with a login value of 4 or above can view the 
page when logged on. Only place the code on the pages where you need to 
restrict access, for example, it should not go on clientlogin.asp 
To add the level of restriction to individual pages you will need to add the line: 
<% requiredlog
..
anywhere be
< !--#include file="vsadmin/inc/incfunctions.asp"-->  
 
 

Enabling customer login (PHP Version) 
f you would like to have a login status box on each page you wI
one line of code where you would like the login box to appear. The code you 
eed is the following: n

 
?php include "vsadmin/inc/incm<

 
Paste that into HTML / code view exactly where the login box should appear
nd make sure that it coma

 
?php include "vsadmin/db_conn_open.php"?> <

<?php include "vsadmin/includes.php"?> 
<?php include "vsadmin/inc/languagefile.php"?> 

?php include "<
 
To enable the login you will then
the line (if it's not already prese
 
Finally you'll need to
nd save it as clienta

line: 
 
<?php include "vsadmin/inc/inct
 
...and change it to .
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Save clientlogin.php and upload it to your server. 
 
You should now be able to see the login box and the login page on your store. 
 

 
Login Box 

 

 
Login Box after successful login 

 

 
Login Box if $enableclientlogin=true; 

hasn't been set in vsadmin/includes.php 

 
Login Dialogue on clientlogin.php 

   
 
Once you click on login you will be taken to a page to enter your email 
address and password 
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Once logged in customers can view their account details, edit their shipping 
and billing addresses as well as look up past orders. To allow customers to 
ign up for an account you will need this addition to vsadmin/includes.php  

$allowclientregistration=true; 
ers to login before purchasing add this to 

ustomers will be prompted on checkout if they would like to log in or set up 
n account 

s

To force custom
vsadmin/includes.php 
$forceclientlogin=true; 
 
C
a
 

 
 
 
Setting up a client 
exemption 

for wholesale pricing, discounts and shipping / tax 

dmin page there should be a link client login admin, click to 
et up your clients' options. 

 

 
I
s
n your home a

 
 

Click on new client login to add the details and parameters available for 
each particular customer. 
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name, email address, password, the relevant action (You 
 to select more than one choice) and finally the login 

vel if applicable. When done, click on submit and your client will have been 

elow the login level assigned in the 
gin admin section. For example, if you set requiredloginlevel=4 then only 

people who you have set up with a login value of 4 or above can view the 
age when logged on. Only place the code on the pages where you need to 

?php $requiredloginlevel=4;?> 
 
...where 4 is the threshold of permission for that page. This needs to come 
anywhere before the line 
 
<?php include "vsadmin/inc/incfunctions.php"?> 

Enter the client login 
can use CTRL + Click
le
set up with the parameters you have assigned. The promotional email box if 
checked will write the client's email address to the database and can be used 
for mail shots. 
 
Login level 
You can assign different levels of login permissions on any page to say that a 
particular page is restricted to anyone b
lo

p
restrict access, for example, it should not go on clientlogin.php 
 
To add the level of restriction to individual pages you will need to add the line: 
 
<

 
The last thing you need to do is find the code at the top of your page that 
looks like this: 
 
<?php 
session_cache_limiter('none'); 
session_start(); ?><html> 
 
...and change it to: 
 
<?php 
session_cache_limiter('none'); 
session_start(); 
ob_start(); ?><html> 
 
..making sure there is no space before the code and you just have the one 
opening <html> tag. 
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hipping Methods 

PS Shipping

ping

hipping States 

 
 

Chapter 5 
S
 
 
 
U
USPS Shipping 
FedEx Shipping
No Shipping

gFlat Rate Shippin
Weight Based Ship
Price Based Shipping

anada PostC
Free Shipping 
Pack Products 
Postal Zones 
Shipping Countries
S
Shipping Estimator 
Customer Shipping Carrier Selector 
Shipping FAQ 
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UPS Shipping 

etting up your Ecommerce Plus template to automatically use the UPS 
nline® Tools Rates & Service Selection to automatically calculate your 
hipping costs is a simple matter. Just follow the steps below. 

irstly, log in to the admin section for your Ecommerce Plus template and 
 using the menu on the left. From the Shipping Type 

 
S
O
s
 
F
click on "main settings"
dropdown menu select UPS Shipping. 
 

 
 
On the same page you will see a setting "Shipping Units" where you can 
define the weight units that are used to define your product weights. Please 
note that the shipping units are limited in some countries. Notably, the United 
States is limited to specifying product weights in lbs and ounces. 
 

 
 
Now, go to the Shipping Methods admin page and click on "Register with 
UPS" and follow the steps in the registration wizard. 
 

fter completing the UPS Wizard you arA e now ready to test your system. Try 
roduct. Then 
 information, 

available UPS shipping options along with the associated 
osts. You should do a couple of tests to make sure they match what you 

adding a product to your cart where you know the weight of the p
 the checkout phase after filling out your customer and shippingin

you should see the 
c
would expect from the UPS online shipping calculator at http://www.ups.com/. 
 
NB. If you receive the following error at this stage . . . 
This measurement system is not valid for the selected country 

 

. . . then this means that you have to return to the Ecommerce Plus admin 
section, "main settings" page to change the Shipping units you are using from 
lbs and ounces to Kilograms or vice-versa. 
 
If you are using the PHP version and receive blank page instead of the UPS 
Wizard then contact your host and ask them if they have the cURL component 
installed. This is a free download and is available on the majority of hosting 
plans. 
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Oversize Packages. 
For each OS1 package, set the product weight to be 30 pounds. 

or each OS2 package, set the product weight to be 70 pounds 

er your packages to UPS for delivery can affect the 
tal cost of delivering the package. You can change the pick up type by 

"03" 

he code in quotes there would be taken from the following table... 

1 - Daily Pickup 
- Customer Counter 

6 - One Time Pickup 

9 - Letter Center 
 Center 

ouble quotes. Also, please note 
at these options are not exactly the same as you might find on the UPS 

re working on. 

S Order Tracking 
's possible for customers to track their orders from a page on your site - if 

 do to enable it is take a copy 
f products.asp and call it tracking.asp 
hen go to HTML view and change the line 

in/inc/incproducts.asp"--> 

le="vsadmin/inc/inctracking.asp"--> 

?php include "vsadmin/inc/incproducts.php" ?> 
 
to 
 

?php include "vsadmin/inc/inctracking.php" ?> 

F
 
The way that you deliv
to
setting the following in your vsadmin/includes.asp or vsadmin/includes.php file 
. . . 
 
upspickuptype=
 
 
T
 
0
03 
0
07 - On Call Air 
1
20 - Air Service
 
Remember to enclose the code above in d
th
website but we hear that is something that UPS a
 
UP
It
you don't have the tracking page, all you need to
o
T
 
<!--#include file="vsadm
 
to 
 
<!--#include fi
 
For the PHP version take the page products.php and save it as tracking.php 
Then go to HTML view and change the line 
 
<

<
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ation has been done for 
ou. Just follow the steps below. 

S and overseas shipping costs are automatically calculated according to 

tml

 
 
 
 
 
 
USPS Shipping 
 
Setting up your Ecommerce Plus template to automatically use USPS 
shipping is pretty simple as the majority of the integr
y
 
U
product weight and destination. To activate USPS shipping method you need 
to register for a username. The process is quite simple and the registration 
form is available at . . .  
http://www.uspsprioritymail.com/et_regcert.h  under the link Access USPS 

eb tools. 

ou will receive a long email from USPS with information regarding testing the 
tem before going live on the production server. We have already done this 

tep for you so that can be ignored. All that is needed is to follow the 
. 

with your USPS username. These are used in determining 
hipping costs within the USA.  

nce you have selected USPS shipping in the admin main page 

w
 
Y
sys
s
instructions for going live on the production server
 
The final step for using USPS shipping is to enter your ZIP code in the admin 
main panel along 
s
 
O
 

 
 
…then you should see a link "Edit USPS Shipping Methods" on your admin 
ome page and that is where you can select the shipping methods that your 
ackage shipment can use. 

ll that is left to do is to add the weight of each product as they are added 
rough the product admin section. The shipping cost will then be calculated 

n checkout depending on the origin, destination and weight of the order. 

h
p
 
A
th
o
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IMPORTANT NOTE: After you apply to the USPS, you will receive an email 
om them with your username. In this email will be a couple of lines about 

 profile to allow you access to the production server. Until 
p you will receive an error in checkout about not being 

USPS Order Tracking 
 
It's possible for customers to track their orders from a page on your site - if 
ou don't have the tracking page, you can set it up yourself... 

 

?php include "vsadmin/inc/incproducts.php" ?> 
 
to 
 
<?php include "vsadmin/inc/inctracking.php" ?> 

etting up your Ecommerce Plus template to use FedEx shipping rates to 
utomatically calculate your shipping costs is a simple matter. Just follow the 
teps below. 

irstly, log in to the admin section for your Ecommerce Plus template and 
lick on "Main Settings" and scroll down the page. From the Shipping Type 
ropdown menu select FedEx Shipping. 

fr
how to switch your
you follow this ste
authorized on the server. 
 
 

y
 
- ASP Version: 
Take a copy of products.asp and call it tracking.asp 
Then go to HTML view and change the line 
 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
 
to
 
<!--#include file="vsadmin/inc/inctracking.asp"--> 
 
- PHP Version 
Take a copy of products.php and call it tracking.php 
Then go to HTML view and change the line 
 
<

 
 
FedEx Shipping 
 
S
a
s
 
F
c
d
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On the same page you will see a setting "Shipping Units" where you can 
define the weight units that are used to define your product weights. Please 
note that the shipping units are limited in some countries. Notably, the United 

tates is limited to specifying product weights in lbs and ounces. 

lick on Shipping Methods from the left hand menu and click on Register 
ith FedEx 

 

S
 
Now c
w

 
 
and follow the steps in the registration wizard. Once you are registered you 
will want to choose the shipping methods you want to accept on your store so 
click on the Edit Shipping Methods button and check the appropriate choices. 
 

ou are now ready to test your system. Try adding a product to your cart 

 what you would expect from the 
edEx online shipping calculator at www.fedex.com. 

's possible for customers to track their orders from a page on your site - if 
you don't have the tracking page, all yo  need to do to enable it for the ASP 
version is take a copy of products.asp and call it tracking.asp 

<!--#include file="vsadmin/inc/incproducts.asp"--> 
 
to 
 
<!--#include file="vsadmin/inc/inctracking.asp"--> 
 
For the PHP version save products.php as tracking.php then go into HTML 
view and change 
 
<?php include "vsadmin/inc/incproducts.php" ?> 
 
to 
 
<?php include "vsadmin/inc/inctracking.php" ?> 

 

Y
where you know the weight of the product. Then in the checkout phase after 
filling out your customer and shipping information, you should see the 
available UPS shipping options along with the associated costs. You should 
do a couple of tests to make sure they match
F
 
FedEx tracking 
 
It

u

Then go to HTML view and change the line 
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ther Shipping Methods 

 are no shipping 
osts involved. 

O
 
No shipping 
As the name suggests, this is the option to choose if there
c
 

 
 
Flat rate shipping 
f you select flat rate shipping you can enter 2 sI hipping costs in the product 
dmin section. One is for the cost to ship one of an item, and the second is 
e cost to ship the second and subsequent instance of an item. First select 

a
th
Flat rate Shipping from the main admin settings page. 
 

 
 

 the cost for the first item is $5.00 and the cost for the second andIf  
uent is zero then total shipping cost will be $5.00 however many of a subseq

product is shipped. Second and subsequent is for one particular product only. 
If you sell one product x and one product y then both will be charged the first 
hipping cost. These values can be set in your product admin pages. s

 

 
 
If you want it so that store wide to ship one of any product is $XX and to ship 
any second and subsequent product is $YY then you would have to use 
weight based shipping. 
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Weight based shipping 
Shipping is calculated by product weight according to the shipping zone to 
easily facilitate national and international shipping. If weight based shipping is 
elected, then the country zone can be set in the countries admin panel, and s

new zones can be edited by following the Edit Postal Zones link in the main 
admin panel. 
 
The first thing to do is select weight based shipping in your main admin setting 
page 
 

 
 
The system works such that you can set a series of weight limits and shipping 

nces, 
ning by what you enter as the product weight in the 

ts admin page. 

costs for packages up to those weight limits. The weight limits are set in the 
admin postal zones page. The weight can be in pounds, kg, ou
whatever. You give it mea
produc
 

 
 
For instance, if you have entered a weight of 2.4 in the products pag
hat to you means 2.4 kilos, then if your weight limit is up to 3 then

e, and 
 that is up 

 3 kilos also. With the price, that will be whatever the currency you use is. If 
 dollars, then it is $4.50. 

fter adding your product weight to the products, you’ll need to set up your 
the 

t
to
it is 4.5 and you use
 
A
zones and rules in the admin postal zones page. Set up the names of 
zones you would like to use. 
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Now click on the “Edit Rules” link to set up your weight / price ratio. 
 

 

 
 

ht is 50 and the price for that is $5.00, and you set "For 
e 

k 

 
If your highest weig
every 5 above the highest weight add an extra 0.5" then at a weight of 55, th
price would be $5.50, at a weight of 60 the price would be $6.00 and so on. 
 
The final step is to make the relation between the zones you have set up and 
the countries corresponding to those zones. Click on your admin countries lin
and you should see a full list of counties and various options. 
 

 
 
Enabled Tick the boxes next to the country name for the countries you want 

age. 
rs regarding fraud so you 

Tax If you need to set a particular tax rate for a country, it can be entered 
 based in the UK you may be obliged to add VAT 

to ship to. These will appear in a drop down menu on the checkout p
Some countries have worse reputations than othe
might want to bear this in mind when making your selection 
 
 

here. For example if you are
to all UK orders, in that case you would want to add 17.5 to the tax box. 
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FSA This stands for Free Shipping Available. Tick the box if you want to offer 
free shipping to certain countries. In addition you will need to set this up
discount or coupon in your discount admin page. 

 as a 

 page. On Top of Top will be the first country that 

NOTE 
hat have a weight of zero are not considered for shipping. If weight 

t enter an "x" at the point where a given 
hipping method ceases to be available. 

Weight based shipping can be set as a percentage. To do this just add a 
ercentage sign after the value. eg 10% instead of 10 for the cost.

 
 
 
Position This refers to the position of the country in the drop down menu that 
appears on the checkout
appears, On Top will override the rest, which can be sorted alphabetically. 
 
Postal Zone Indicates the zones you set up in your admin postal zones page. 
Use the drop down choices to match the country with your zone. 
 

Products t
is not important set all weights to zero and set a really high "max weight" limit. 
 
Weight based shipping methods can be disabled at a given weight. 
On the postal zones admin page, jus
s
 

p
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Price based shipping 
The idea here is very similar to weight based shipping but you would need to 
define the price per postal zone rather than weight. 
 
First select Price based Shipping from you main admin page. 
 

 
 
Then click on "Postal Zones". As an example fill in Max Price with 1 in the first 

cost 
 a price of $1 would be $1, and in the example below prices up 

 $5.00 would be charges at $2.00 - continue like that until you have all the 
of $50, 

ipping for every increment of $5 in the price of the 
roduct. The examples here are in dollars but of course this would depend on 

s, 

column and 1 in the second column - that would mean that the shipping 
of items up to
to
prices you require. The highest price option means that over a price 
$0.50 will be added to sh
p
the currency you are using on your store ie. “5” could mean dollars, pound
euros etc. 
 

 
 

You would then need to set up your postal zones as explained above in 
Weight Based Shipping. 
 
NOTE 
P
O

rice based shipping methods can be disabled at a given price. 
n the postal zones admin page, just enter an "x" at the point where a given 

shipping method ceases to be available. 
 
Price based shipping can be set as a percentage. To do this just add a 
percentage sign after the value. eg 10% instead of 10 for the cost. 
 

Canada Post 
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You will first need to obtain a Retailer ID from Canada Post. You can then 

to production mode, until then you can set this switch for 
e ASP or PHP version to have it in test mode. From there you can also opt 

n the discount set up eg. free shipping for all orders over 
100. To set the countries to which free shipping applies, go to your countries 
dmin page and you will see a column "FSA" which stands for "Free Shipping 
pplies". Only those countries checked will be eligible for free standard 
hipping. Remember that a rule will have to be set up first in your discount 
dmin page for this to work and that it will apply store-wide. This is not 
vailable for flat rate shipping. 

 

Pack products 
For USPS, UPS, Price and Weight Based shipping there is a choice of 
packing products together or separately, this can be found on the main admin 
page. 

Postal zones 
This option is only shown if you have chosen Weight Based or Price Based 
shipping. The first screen is a "named" list of the zones you wish to support. 
The names are for your own purposes only really, and can be anything like 
"Zone 1", "Europe", "Eastern Europe" or whatever has meaning for you. Once 
you have added some zone names and clicked submit, go back to this page 
and you will see that there is a link "Edit Zone Rules" next to the zone names. 
The first column is a list of weight limits. The second column is a list of costs. 
The actual scale of the weight limits is irrelevant really and can have any 
meaning you wish, such as ounces, kilograms, pounds etc. 
If you want ALL zones to have multiple shipping methods click on the link on 
the postal zones page: 
Please click here to set all zones to use multi shipping methods, like 
"Standard" and "Express" shipping.  
If you only want certain zones to have multiple shipping methods then click on 
"Edit Zones" for that postal zone and click on the link: 
This zone is set to only use one shipping method. To use multi shipping 
methods for this zone, like "Standard" and "Express" shipping, please click 
here.  

enter that in your main admin page to get started along with the Post Code 
from where you will be shipping. After receiving the Retailer ID, Canada Post 
will need to put you in
th
to use product dimensions. These additions are made to your 
vsadmin/includes.asp / .php page. 
 

Free shipping 
 
This option is used in conjunction with discounts and coupons. It enables you 
to set free shipping only for orders within a particular country which match the 
riteria you stipulate ic

$
a
A
s
a
a
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There are regional updaters here, which will allow you to replace the US 
ies, Canadian Provinces etc. 
.3.0 up to 5 shipping methods for weight / price based 

 2 were available.) You can also set 

ou 

try to increase sales, but unfortunately some 
hers. Country tax can be set on this 
rcentage, so for instance if a 

 the 
sual alphabetical order. 

ion to 

f 
ship 

 estimate of their shipping costs from the cart and before 
and / or state where 

ill be presented with the cheapest 
hipping method available depending on the information you have set up for 

shipping choices in the admin. 

States with UK Count
Note: From version 4
shipping are now available. (Previously
the shipping method name on the admin zones page per shipping zone. 

Shipping countries 
The store software displays a list of worldwide countries in the checkout 
phase, and their attributes can be edited here. Firstly you can choose if y

. Be careful when deciding this as it is wish to ship to the country at all
mpting to support every counte

also attract more fraudulent orders than ot
page also. The figure is expressed as a pe
country incurs 16% tax, then just enter 16 in the box provided. 
The position can be used to set the order the countries are displayed in the 
checkout drop down. "On Top" will put that country on the top of the list. "On 
Top of Top" will put that country above that even. This means that you can 
have the "United States" above the "United Kingdom", and then the rest in
u
If you have chosen "Weight based shipping" you are also given the opt
set the shipping zone that applies to that country. We have ordered the 
countries roughly into the United States, the Americas, Europe and the rest o
the world, but do examine these carefully for the countries you decide to 
to.  

States 
The store software displays a list of the US states in the checkout phase, and 
n this page you are given the option of supporting that state, and if shipping o

to that state incurs any State Taxes. 

 

 

 

 

Shipping estimator 
This feature was introduced in version 4.9.0 and allows your customers to be 
presented with an
going through checkout. They need to select the country 
they are purchasing from and they w
s
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This is an optional feature and can be switched on through includes.asp / 

cludes.php 

SP Version -> Add this line to includes.asp to switch on the feature... 
stimateshipping=TRUE 

 you are using weight based shipping that is split into state zones then you 
ill need to define the State where you will be shipping from  
efaultshipstate="California" 

HP Version -> Add this line to includes.php to switch on the feature... 
estimateshipping=TRUE; 

 you are using weight based shipping that is split into state zones then you 
ill need to define the State where you will be shipping from  
defaultshipstate="California"; 

 

Customer shipping carrier selector 
 
Another feature added in version 4.9.0. This allows customers to choose 
between shipping carriers on checkout and select the price and method that 
best suits them. On the final checkout page they will be presented with a drop 
down list of carriers that you have defined and they can check the cost of 
each available price option and make their selection. 

in
 
A
e
 
If
w
d
 
P
$
 
If
w
$

 

 
© Ecommerce Templates Page 101 of  255 



 

 
This is an optional feature and can be switched on through includes.asp / 

cludes.php 

re of these lines to includes.asp depending on 
to your customers. 
 

lternateratesusps="USPS Rates" 
lternateratesweightbased="Weight Based" 
lternateratescanadapost="Canada Post" 

e those that you have chosen to offer. The text in "Quotes" such 
d" can be changed if you want to use a different language or 

n. 
 
PHP Version -> Add one or more of these lines to includes.php depending on 

o offer to your customers. 
"; 

$alternateratesusps="USPS Rates"; 
$altern ht Based"; 
$altern ada Post";" 
... only include those that you have chosen to offer. The text in "Quotes" such 

n be changed if you want to use a different language or 

 
 
 

in
 
ASP Version -> Add one or mo
which carriers you wish to offer 
alternateratesups="UPS Rates"
a
a
a
... only includ
as "Weight Base
different descriptio

which carriers you
$alternateratesups="UPS Rates

 wish t

ateratesweightbased="Weig
ateratescanadapost="Can

as "Weight Based" ca
different description. 
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Shipping FAQ 

an I use multiple shipping methods?

n of 

 
dditional item. What method should I use?

ive 
checkout. From version 5.0 it is also 

possible to use a different shipping method for domestic and international 
orders by selecting from the drop down menu in the main admin settings. 
 

I don't need to charge a per item shipping...someone can order 1 
product or 20 products and I charge the same amount - I want them to 
have the option of choosing either standard or express and not be 
charged per item. 
Using weight based shipping, set every product a very low weight, (say 0.1). 
Then set up your postal zones with only one rule per zone, which has a very 
high max weight, (say 9999) and the cost as your shipping cost. On the admin 
main page make sure "pack products together" is set. 
 

I want to charge $5 for the first item entered into the cart, and then $1 for 
each additional item. What method should I use? 
Use weight based shipping and set every weight to 1 to make things easy. 
Then in the postal zones section, set the rules so that a weight of 1 is $5, a 
weight of 2 is $6 and for each 1 above the highest weight add an extra $1. 
 

How do I set up shipping based on a percentage of the final sales price? 
In the admin main page set up the shipping type to price based shipping. 
Then for the postal zones admin page click on edit rules, and then just set 
something like... 
for every 1 above the highest weight add an extra 0.2 which would charge 
shipping at 20%. 
for every 1 above the highest weight add and extra 0.35 
..which would add shipping at 35%. 
 

C
I don't need to charge a per item shipping...someone can order 1 product or 
20 products and I charge the same amount - I want them to have the optio
choosing either standard or express and not be charged per item.
I want to charge $5 for the first item entered into the cart, and then $1 for each
a
How do I set up shipping based on a percentage of the final sales price?
How do I add tax to shipping?  
 

Can I use multiple shipping methods? 
It's not possible to mix 'n' match domestic shipping methods but you can g
your customers a choice of carrier on 
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The first example for instance would round to the nearest 20 cents of course, 

ow do I add tax to shipping? 
 vsadmin/includes.asp or php and change taxShipping=0 to 
. 

 
 
 
 
 

 

 
 
 
 
 

but you could say 
 
for every 0.5 above the highest weight add an extra 0.1 
 
 

H
Open the file
taxShipping=1
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Chapter 6 
Design Issues 
 
 
 
 
Introduction
Using Fireworks

Editing text
Editing graphic colors
Batch processing

Frontpage Issues
Frontpage includes
Frontpage includes (ASP)
Frontpage navigation (ASP)
Frontpage includes (PHP)
Configuring Frontpage for PHP

Dreamweaver issues
GoLive Issues
Cascading Style Sheets (CSS)
DHTML menus
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Introduction 
 
The great thing about working from templates is the simplicity of setting up the 
design of your store to reflect your products and needs. The hard work of 
preparing the layout of the store is already done for you – from there you can 
change color schemes, add your own graphics and modify the existing ones. 
 
All the templates come with .png files. These can be edited in Fireworks from 
Adobe – they have a 30 day free trial available if you don’t already have the 
program. 
 
Graphics and sections, which are repeated on many pages, are usually set up 
as include pages for Frontpage, components for GoLive or form part of the 
Dreamweaver .dwt file or library items. 
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Using Fireworks 
You don’t have to own a copy of Fireworks to work with our templates but 
does make graphic editing simpler. The .png files are found in the 
images/extras folder. There are blank gifs which you can use in other grap
programs to add your own text to. 
 

it 

hics 

File>Open and browse to the image you need to edit and click on the text tool, 
Editing text 

the icon is an “A” 
 

 
 
Place your cursor on the text and type your wording. 
 

 
 
Save your graphic by going to File>Export Preview 
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Choose the format (usually as a GIF) and settings you want for the graphic, 
paying particular attention to file size / quality 
 

 

 

 
108  © Ecommerce Templates 



 
 
You can change the color of the text by choosing the select tool (the white 
arrow). 
 

 
 
Click on the graphic and select the color from the properties window. 
 

 
 
You can also change the font by selecting from the drop down list in the same 
window. 
 

 
 
If you need to change the background color choose Modify>Canvas>Canvas 
Color. 
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Effects such as drop shadow, bevel etc. can be added by clicking on the plus 
sign next the word “effect” in the properties window and selecting the options 
until you get the look that best suits your needs. 
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Editing graphic colors 

 – in Fireworks you can see 
em in the Layers Window. 

Most of the templates have small rounded corner graphics, menu tops or 
bottoms etc., which are easily changed. These usually consist of a 
background color, which can be changed as above and a rounded image 
which is modified by selecting it and changing the color in the properties 
window. 
Often a graphic is made up of different layers
th

 

 
 
Click on the name and you’ll see the layer highlighted and the properties 
window will show the color and any effects that have been applied. 
 

 
 
You can change the color of the individual elements (layers) by clicking on th
olor next to the paint icon and selecting th

e 
e color of your choice. c
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NB There are quite a few windows available in Fireworks, probably the most 
important being the tools and properties – if you don’t see these, select them 
from the “window” menu at the top of the screen. 
 
Always export your graphic by going to File>Export Preview and choosing the 
format (usually as a GIF) – it’s best not to use .png files on your site as not all 
browsers recognize the format and the file size will be much larger too. 
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Batch processing 
A very useful feature of most graphics programs is the ability to change a 

rge number of graphics to the same specifications. This is really useful for 
mplates when preparing the product images for the product 

he first thing to do is place all your images in a folder on your hard drive. 
ks and choose File > Batch Process from the top menu 

la
the ecommerce te
and product detail pages. 
 
T
Then open Firewor
 

 
 

Browse to the folder where you saved your images and select the ones you 
want to change or choose to select them all 
 

 

 
© Ecommerce Templates Page 113 of  255 



 

 
 

ow you can set up the rules for the changes you want to make to the 
nt to export the picture as a .jpg file 

N
images. For photos you will probably wa
 

 
 

raphic And you’ll probably want to set a uniform size. To avoid distorting the g
’s best to set the width (in the example at 150 pixels) and allow the height to it

scale accordingly by choosing variable 
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The Rename and Commands options probably won’t be needed. Click on 
next and you will be given the option of where you would like to save your 
newly modified files and the option of saving the script so it can be used 
at a later date. 
 

again 

 
 

Clicking batch will modify all the files you selected to the specifications you set 
up. 
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Frontpage issues 
The majority of the colors on the templates are cell backgrounds, which can 
be changed by right clicking on the cell in normal view and choosing “cell 
roperties”. p

 

 
 

ou can then select the color of your choice. 
 

 
 
 
 

Y
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Frontpage includes 

 
aking changes on a single page. They are typically 

sed for news items, header and footer sections - anything really that appears 
the same on all or most of the pages on a site. The include pages are kept in 
a folder called /includes/. We've added a brief explanation below on how to 
use them with the ASP and PHP templates. 
 

 

All the Frontpage ecommerce templates use include files. These allow you to
update the whole site by m
u

 
 
The ASP templates use Frontpage includes - they're very simple to use and 
an be added to and deleted at will. 

 
Modifying an include page (ASP Version) 
In Frontpage folder view, open the includes folder and double click on the file 
you want to change. Make the modifications and on saving, all the pages that 
are linked to that include file will be automatically updated. There are only a 
couple of things to be wary of. If the include file uses graphics, make sure that 
your new graphics will fit into the space provided for them. Some include files, 
typically ones used for news sections, use smaller text. This is achieved 
through .css class - take a look at the code and you'll probably see something 
like this: <td class="smaller"> or <p class="smaller"> - if this is the case, and 
you want to maintain the look, you may need to manually add the class to the 

c
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<p> tag when adding a new paragraph. Speaking of <p> tags, be careful as 
sometimes Frontpage will add them to your code, both on the include page 
and the main page which contains the include - this may cause some extra 
spacing to occur and will mess up your design, particularly in Netscape 7. To 
delete them open the page in HTML view, delete and save, making sure you 
have the "Preserve existing HTML" box checked in Page Options. There is 
further help on using CSS in this chapter. 
 
NB. Only code that is between the opening and closing <BODY> tags will be 
read in include files, so if you have to put some script into the <HEAD> 
section, it will have to be moved to the <BODY> section. 
 
 
Frontpage Navigation (ASP Version) 
 
A few of the ASP version Frontpage ecommerce templates use a theme so it 
is easy to add new buttons and pages without having to open your graphics 

tree structure in Navigation View it means the

ne line 
allotted on the button. In Frontpage, go 

to Navigation View and right click on the page icon in the tree structure, 
e of the page you need. 

program. If there is not a 
te

 
mplates relies on Frontpage includes for navigation. 

 
Changing Button Names 
Button names are based on the Title of the page. They must be kept short 
because FrontPage will not wrap button names. They will appear on o
and will need to fit within the space 
in
choose Rename and type the nam
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You will probably also want to change the name of the page itself so right click 
on the page name in folder view, choose Rename and type the new .htm or 
.asp name you require. It’s best to keep names lower case and without 
spaces. 
 
If you need to change the wording of the “home” link go to Tools>Web 
Settings>Navigation and place your wording there. 
 

 

 
 
 
Adding a Page 
To make more pages on the same navigation level, open a page > go to File 
> Save As > assign a new Page title by clicking on Change > type in the new 
title > OK > type in a new File name. Save. This will give you an exact copy of 
the first page without altering the first page. Drag the new page's file name 
into Navigation View in the place on the menu where you would like it to 
appear. FrontPage will automatically add the new page to the navigation bar. 
To finish the new page, insert appropriate content. 
 
For some reason Frontpage won’t allow you to have a .asp page as a parent 
file in navigation view so what you will need to do is change the extension to 
.htm, attach the page in the navigation tree chart and then change the 
extension back to .asp. 
 
Deleting a Page 
In Navigation View, right click on the icon of the page you wish to remove > 
Delete > Delete this page from the Web > OK. 
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Troubleshooting 
If your Frontpage navigation doesn’t show when you publish your site to your 
erver then go to Tools > Recalculate Hyperlinks to see if that will bring it up. s

Also check that the theme has been attached. 
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Modifying an include page (PHP Version) 

P 

 
nd a neat way around these issues, but there are a 

ouple of things to bear in mind.  

pages, we have just used PHP includes. It's already set up 
 included pages in the includes folder. Unlike 

s however, all links will be relative to the file that is doing 
e including. So, for this reason we recommend you use links relative to the 

ite root if you want to use the same include files in folders and sub folders. 

rent ways to link pages are . . .  

k: mypage.php  
is is a link relative to the site root: /mypage.php  

his is an absolute link: http://www.mysite.com/mypage.php  

he include page will not show up when you preview in a browser, so you'll 
s a 

tility that will allow you to view your changes in Frontpage and they have a 
y free trial

There are a couple of issues with the Frontpage version when using the PH
templates. Frontpage extensions do not work with pages with the .php 
extension, so this means that FrontPage Includes and FrontPage Navigation
do not work. We have fou
c
 
First, for include 
for you, and you will find the
FrontPage include
th
s
 
Examples of diffe
 
This is a relative lin
Th
T
 
T
need to upload the site to your server to view your modifications. There i
u
30 da  available. 

on the server: 

" on the server 
pen Frontpage  

eb 

 
You can also work "live" 
 
How to work "live
O
Select File > Open W
 

 
 

 the box that appearsIn  type your full URL eg. http://www.yourdomain.com/  
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ou'll now be prompY ted for your Frontpage user name and password  
 

 
 
Once verified, your site will be open and live, any changes you make on 

aving" will be made to your live site 

s and navigation 
avigation is not available, you will have to make up and 

ver buttons for the navigation. (This does not apply to templates which use 
DHTML PopOut menus as navigation or text based menus.) To change 

ch contains the navigation. (Normally 

"s
 
 
PHP include
Because FrontPage N
o

navigation, open the page whi
includes/leftnavigation.htm.) You will see some lines of code such as . . . 
addrollover('special.php','images/special.gif','images/specialov.gif'); 
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To add buttons to the navigation, just add extra lines here, or edit the existin
ones. The parameters are: 

g 

r relative to the site root: /about.php 
  

he "normal" state of the image: images/menu/about.gif 
ver" state of the image: images/menu/aboutov.gif 

ply about relative links as for the FrontPage Includes 

 
The link. 
This can be relative: about.php 
o
or absolute: http://www.mysite.com/about.php
T
The "mouseo
 
The same rules ap
however.
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Configuring Frontpage for PHP 
If Frontpage doesn't recognize the .PHP pages, you'll need to configure it like 

is: 

 Frontpage go to Tools>Options>Configure Editors  

th
 
In
 

 
 
Choose "Add" 
 

 
  
 
Put PHP for file type  

t the same information as you have for htm, html etc. - this is usually: 
rontPage 

.exe  

Pu
Editor Name: F
Command: frontpg
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Adding a new page 
The simplest way to add new pages to your site is to open an existing page, 
such as about.htm and save it under a new name, such as new.htm. If the 
template uses Frontpage navigation then remember to drag the page into 
navigation view so that the menu shows up correctly. 

s of your cells and tables in 
 
Frontpage tip: Be careful not to drag the border
n attempt to change the layout – always work with cell and table properties.a
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Dreamweaver Issues 

emember that before making any changes to a Dreamweaver template you 
 Site from the 

reamweaver top menu. There are full details in our introductory chapter.  

ain.dwt 

 to the 
update all the files using the 

mplate 

 
R
will first need to define your site by selecting Site > New
D
 
M
Global changes should be made in the file Templates/Main.dwt. These will 
typically be the header, menu and footer sections. On making a change
file Main.dwt you will be asked if you want to 
te
 

 
 

Agree to the prompt and all the pages will be updated. If you are not prompted 
en th it probably means that your site hasn’t been defined. 

typically be a library file and if present will be found in 
 This file can be used to update all the pages that are linked 

 it. If you need different news sections on different pages, save New.lbi 
 

ique to each page will be set up as an Editable Region. 
ontent will be typically called “Body” and is represented by 

ound the area that can be edited. 

 
 
News.lbi 

 will The news section
e Library folder.th

to
under a new name, make the text changes and drag it into the place on the
page where the original library item was located. 
 

ditable Regions E
Content which is un

cThe main body of 
light blue box ara 

 

 
 

 as an arrow within an editable region and as a circle with 

ckground colors in Dreamweaver, click in the cell in design 
ew and then select the bg color from the Properties Window. 

The cursor will show
a line through it in the locked region of the page. 
 

o change the baT
iv
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it under a new name, such as new.htm.

 
Adding a new page 
The simplest way to add new pages to your site is to open an existing page, 
such as about.htm and save 
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GoLive Issues 

he first thing to do when you've opened up Adobe GoLive is to go to File > T
Open from the top menu. 
 

 
 
Browse to the folder where you extracted the template to and locate the .site 
file. 
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You should then see the listing of all the files and folders that make up your 
GoLive shopping cart. 
 

 
 
You'll find the package has some sample pages, the store .asp/php pages 

es to the design, adding and a number of folders. To make site-wide chang
your company name, changing the menu etc. you'll need to work from the 
components. These can be opened by double clicking on the various 
components that make up a page. 
 

 
 
Once you've made the changes, save the file and you'll be prompted if you 

template - agree to the prompt and you 
ns you've made. 

want to update all the files using this 
hould be able to see the modificatios
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Adding a new page 
The simplest way to add new pages t
uch as about.htm and save it under a new name, such as new.htm.

o your site is to open an existing page, 
s
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Cascading Style Sheets (CSS) 

n the ecommerce templates we use cascading style sheets (css) to allow 
ou to easily manage the font and hyperlink properties. In the root of your web 

ed style.css and on each page a link to it like 
is <LINK REL=STYLESHEET TYPE="text/css" HREF="style.css">. This can 

or 
d. 

yperlink properties with CSS 
ile you should see some lines like this: 

:link { 

color: #3366FF; 

: none; 

s are pretty clear, any hex value will suffice for the color and if 
e when the cursor passes over a link, change "none" 
t some browsers, notably Netscape 4x will ignore the 

rties with CSS 
is also set in the css file, here's an example: 

rial; 

font-size: 12px; 

 
O
y
you will have a file typically call
th
be edited in Frontpage, GoLive or Dreamweaver by double clicking on it 
can be opened and modified in a text editor like Notepa
 
Editing the h
After opening the f
 
A
color: #3366FF; 
text-decoration: none; 
} 
 
A:visited { 

text-decoration: none; 
} 
 
A:active { 
color: #3366FF; 
text-decoration
} 
 
A:hover { 
color: #FF9966; 
text-decoration: none; 
} 
 
The parameter
you require an underlin
to "underline". Note tha
hover option. 
 
Editing the font prope
The font type and size 
 
TD { 
font-size: 12px; 
font-family : Verdana,A
} 
 
P { 
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font-family : Verdana,A
} 

rial; 

This means that all text that is between <TD> or <P> tags will be Verdana, 
alled on the user's machine then it will revert to 

rial. If you want to change the color of the text from the default then add a 

; 

00; 

 

00;  

h CSS 

 
solid; 

rder-color: #006AC8;  

 allow you to vary your styles on a page, for example giving a 
ction smaller text or different link properties - this can be really handy when 

xt-decoration: none; 

.dark:visited { 

 

size12 - if Verdana is not inst
A
line like this for red text: 
 

D { T
font-size: 12px
font-family : Verdana,Arial; 

lor: #CC00co
} 
 

 { P
font-size: 12px;
font-family : Verdana,Arial; 

lor: #CC00co
} 
 
Editing the horizontal rule properties wit
 
This line of code will give you a blue horizontal rule, one pixel in height: 
 
HR { 
height: 0; 

: 1px 0 0 0;border-width
order-style: b

bo
} 
 
Using CSS classes 
 
CSS classes
se
for example you have light and dark backgrounds and you need your links to 
show up well on both. Here's an example of using a class for hyperlink 

roperties: p
 
A.dark:link { 
color: #FFFFFF; 
te
} 
 
A
color: #FFFFFF; 
text-decoration: none; 
} 
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A.dark:active { 
color: #FFFFFF; 
text-decoration: none; 
} 
 
A.dark:hover { 
color: #FF9966; 
text-decoration: none; 

his will give you white links with an orange mouseover. To apply it to 
links you'll need to add the class like this: 

ef="mylink.html">link text</a> 

o change text size or color between <TD> or <P> tags you might have 

nt-size: 11px; 
nt-family : Verdana; 

; 

smaller { 
nt-size: 11px; 

 Verdana; 
0; 

pixel size text when you add a class like this for a 

 class="smaller"> 

td class="smaller"> 

 

} 
 
T
individual 
 
<a class="dark" hr
 
T
something like this: 
 
TD.smaller { 
fo
fo
color : #CC0000
} 
 
P.
fo
font-family :
color : #CC000
} 
 
This will give you red 11 
paragraph: 
 
<p
 
...or for the cell 
 
<
 

Editing the category layout 
In version 4.1.0 we added the possibilty of showing the categories in multiple 
columns rather than in one vertical list. As people will want to align the text
and images in different formats, we added CSS classes to make the 
modifications as simple as possible. 
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The first thing you will want to do is set up the category format that best suits 

e, this involves adding a parameter to your vsadmin/includes.asp or 

 your CSS file, this is found in the root of your store 
le.css or stylesheet.css 

argin-bottom: 4px;  

order-thickness: 1px;  

ertical-align:top;  

ertical-align:top;  

 

D.catnavigation {  

xt-align: left;  

he classes explained 

.catname: The alignment of the category name 
y description 

your sit
vsadmin/icludes.php files, depending on your version. 
 
Next thing to do is open
and is typically called sty
 
Copy and paste these lines into the CSS file: 
 
P.catname { 
text-align: center;  
margin-top: 0px;  
m
vertical-align:top;  
text-align: center; 
} 
 
P.catdesc {  
margin-top: 0px;  
margin-bottom: 4px;  
vertical-align:top; 
} 
 
IMG.catimage {  
border:1px;  
b
border-color: #000;  
border-style: solid;  
v
} 
 
TD.catimage {  
v
}  
 
TD.catname {  
vertical-align:top;  
text-align: center;  
} 
 
T
vertical-align:middle; 
te
} 
 
T
 
P
P.catdesc: The alignment of the categor
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IMG.catimage: The properties of the category image 
TD.catimage: The alignment of the category image 
TD.catname: The alignment of the category name 
TD:catnavigation: the alignment of the top category navigation 

 page as in the 

 
Some examples 
 
Using the settings as listed above would show the category
example here: 
 

 
 
If you would like the titles and text left aligned and without an image border, 

e CSS would need to be changed like this: 

ertical-align:top;  

.catdesc {  

order-color: #000;  
order-style: solid;  
ertical-align:top;  

th
 
P.catname { 
text-align: center;  
margin-top: 0px;  
margin-bottom: 4px;  
v
text-align: left; 
} 
 
P
margin-top: 0px;  
margin-bottom: 4px;  
vertical-align:top; 
} 
 
IMG.catimage {  
border:0px;  
border-thickness: 1px;  
b
b
v
} 
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TD.catimage {  
vertical-align:top;  
}  
 
TD.catname {  
vertical-align:top;  

 

ould look like this: 

text-align: left;  
}  
 
TD.catnavigation { 
vertical-align:middle; 
text-align: left;  
} 
 
...and the layout w
 

 
 
To move the top navigation to the right, change 

D.catnavigation {  
ertical-align:middle; 
xt-align: left;  

to 
 
TD.catnavigation {  
vertical-align:middle; 
text-align: right;  
} 
 
The best thing is to play around with the settings until you find the one that 
best suits your site. You can always come back here to get the default 
settings if you run into difficulty. 

 
T
v
te
} 
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Editing the mini cart and mini login 

here are two CSS classes that can be used in conjunction with the mini cart 
nd mini login. If you purchased a template with the mini cart incorporated 
en these classes should already be present in style.css, if not you can add 
ese (Please note the class is called mincart, not minicart: 

D.mincart { 
nt-size: 10px; 
nt-family : Verdana; 

nt-size: 10px; 

his will make the text size 10px and the font Verdana. 

ce color 

e added the possibilty of changing the color of the price from 
ll you need to do is add the following to style.css, this 

xample would make the price show as red: 

 

ging the format of the product 
eed to do is add the following to 

red with Verdana 11px 

ELECT.prodoption { 
font-size: 11px; 
font-family : Verdana; 
color : #FF0000; 
} 
 
If you are using stock management with the product options, introduced in 
version 4.4.0, it's possible to "grey out" the options which are no longer in 
stock by adding the following to your main style.css file 
 
OPTION.oostock { 
color : #A0A0A0; 

 
T
a
th
th
 
T
fo
fo
} 
 
P.mincart { 
fo
font-family : Verdana; 
} 
 
T
 
Editing the pri
 
In version 4.1.6 w
the style sheet. A
e
 
SPAN.price {
COLOR: #FF0000; 
} 
 
Editing the product options properties 
 
In version 4.2.0 we added the possibilty of chan
options from the style sheet. All you n
style.css, this example would make the text show as 
font: 
 
S
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} 
 

he text that introduces the product option then you need 
ion 5.2.2 required) 

font-family : Verdana; 
color : #FF0000; 
} 
 
SPAN.detailoption { 
font-size: 11px; 
font-family : Verdana; 
color : #FF0000; 
} 
 
Editing the top product navigation 
 
In version 4.6.0 we added the possibilty of changing the format of the top 
product navigation eg. Home >> Product from the style sheet. All you need to 
do is add the following to style.css, this example would make the text show as 
red with Verdana 11px font: 
 
td.prodnavigation { 
font-size: 11px; 
font-family : Verdana; 
color : #A0A0A0;  
} 
 
P.prodnavigation { 
font-size: 11px; 
font-family : Verdana; 
color : #A0A0A0; 
} 
 
Editing the table backgrounds 
 
Version 4.7.0 allows you to set the table and cell background properties in the 
files search / tracking / order status / checkout via CSS classes. 
 
The new classes are: 
TABLE.cobtbl for the table. 
TD.cobhl for the cell highlights 
TD.cobll for the cell lowlights 
 
For example the following addition to your style.css file would give you a 
search table looking like this: 
 

If you want to edit t
these classes (Vers
 
SPAN.prodoption { 
font-size: 11px; 
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TABLE.cobtbl{ 
background-color: #FF0000; 
}  

D.cobhl{ 
: #FFC42B; 

olor : #666666; 

possibilty of changing the format of the page 
umbers from the style sheet. All you need to do is add the following to 

; 

 version 5.1 you can also change the appearance of the page number 

olor: #FF0000; 

bold and in red like this: 

 
T
background-color
} 
 
TD.cobll{ 
background-color: #FFF7B8; 
c
} 
 
Editing the page numbers 
 
In version 4.7.0 we added the 
n
style.css, this example would make the page numbers show as Verdana size 
12: 
 
P.pagenums { 
font-size: 12px; 
font-family : Verdana
} 
 
In
currently being viewed for example 
 
SPAN.currpage { 
c
font-weight: bold; 
} 
 
...would show a page number 
 

 
 
  
Editing the currency format 
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In version 4.7.0 we also included the possibility of changing the format of the 

ion 4.9.0 we added some new classes which are specific to the 

 
s of the text "Product ID" 

product detail page 
 the product detail 

td.detailimage: The alignment of the product image on the product detail page 

e long product description 
ns on the product detail 

div.detailprice: The properties of the price on the product detail page 
e properties of the alternative currencies on the product 

 
iv.prodid: The properties of the text "Product ID" 

the product name on the product page 
iv.proddiscounts: The properties of the discounts text for the product page 

 the product image on the product page 
g.prodimage: The properties of the product image 

ties of the text in the short product description 
iv.prodoptions: The properties of the product options on the product page 

 the price on the product page 
iv.prodcurrency: The properties of the alternative currencies on the product 

diting the number of items in stock message 
show the number of items in stock in 

e products page. This is the class that governs the look of the entry. 

iv.prodinstock { 
nt-size: 10px; 

alternative currencies. All you need to do is add the following to style.css, this 
example would make the currencies show in Verdana, size 10 and gray: 
 
SPAN.extracurr { 
font-size: 10px; 
font-family : Verdana; 
color: 666666  
} 
 
In vers
product detail page: 

div.detailid: The propertie
div.detailname: The properties of the product name on the 
div.detaildiscounts: The properties of the discounts text for
page 

img.prodimage: The properties of the product image 
div.detaildescription: The properties of the text in th
div.detailoptions: The properties of the product optio
page 

div.detailcurrency: Th
detail page 
 
The product page 
 
In version 4.9.0 we added some new classes which are specific to the product 
page: 

d
div.prodname: The properties of 
d
td.prodimage: The alignment of
im
div.proddescription: The proper
d
div.prodprice: The properties of
d
page 
 
 
E
In version 5.0.0 we added the ability to 
th

d
fo
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font-family : Verdana; 
color: 666666  
} 

 
Editing the productbody3 display 
 

 version 5.0.0 we added a new proIn duct layout, which by default should look 
something like this 
 

 
 

The set up of this layout requires the productbody3 setting in includes.asp or 
includes.php 
 
These are the classes associated with the display 
 
table.cpd - outer table background color which forms the outlines of the cells 
td.cpdll - cell background 
td.cpdhl - header background 
div.cpdhlid - product id header 
div.cpdhlimage - product image header 
div.cpdhlname - product name header 
div.cpdhldescription - product description header 
div.cpdhldiscounts - discounts header 
div.cpdhllistprice - list price header 
div.cpdhlprice - price header 
div.cpdhlpriceinctax - price including tax header  
div.cpdhlinstock - number in stock header 
div.cpdhloptions - product options header 
div.cpdhlquantity - quantity box header  
div.cpdhlbuy - buy button header  
div.prod3id - product id properties 
div.prod3name - product name properties 
div.prod3discounts - discounts porperties 
div.prod3description - product description properties 
div.prod3listprice - list price properties 
div.prod3price - price properties 
div.prod3pricetaxinc - price including tax properties 
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div.prod3instock - number in stock properties 
div.prod3quant - quantity box properties 
div.prod3buy - buy button properties 
 
For example to have a table looking like this 
 

 
 

ou would need to add this to style.css Y
 
cpd { .

background : #FFCC00; 
 }

 
cpdll { .
background : #000; 
olor: #F0F0F0; c

} 
 
.cpdhl { 
ackground : #666; b

c
fo
olor: #F0F0F0; 
nt-weight: bold; 

} 
 
Editing the list price display 
 
In version 5.1.3 we added the possibility of editing the list price display, 
typically people would want to center the text like this: 
 
div.listprice { 
text-align: center; 
} 
 
Please note that the strikethrough and font color are set in 
vsadmin/inc/languagefile.asp / .php 
 
For the product detail page the class would be div.detaillistprice and was 
added in version 5.2.6 
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Editing the cart thumbnail image 
introduction of adding a thumbnail image to the cart. This 

as its own class: 

k properties in the store pages 
o saw the addition of a new class for all links in the store and 

et like this: 
.ectlink:link { 

xt-decoration: none; 

xt-decoration: none; 

n 5.4 can be formatted like this for the 
roduct page: 

iv.prodsku { 

. and for the product detail page: 

iv.detailsku { 

 

Version 5.4 saw the 
h
img.cartimage { 
width: 100px; 
border:1px; 
} 
 

Editing the lin
ersion 5.4 alsV

they can be s
A
color: #333; 

xt-decoration: none; te
} 

.ectlink:visited { A
color: #333; 
te
} 

.ectlink:active { A
color: #333; 
te
} 
A.ectlink:hover { 
olor: #8D2800; c

text-decoration: none; 
} 
 

Editing the sku properties 
 
The SKU display introduced in Versio
p
 
d
color: #333; 
} 
 
..
 
d
color: #333; 
} 
 

Editing the manufacturer properties 
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The Manufacturer display was introduced in Version 5.5 and can be formatted 

iv.prodmanufacturer { 

iv.detailmanufacturer { 

 you want the same formatting on both the product and product detail page 
ass. 

es 

review showallreview (the text properties for the "Show all") 
r.review (the horizontal rule) 

span.review clickreview (the text properties of the "Click review") 
of the person and date of review) 

pan.review reviewcomments (the comments left for the review of the 

like this for the product page: 
 
d
color: #333; 
} 
 
... and for the detail page 
 
d
color: #333; 
} 
 
If
then just set the div.prodmanufacturer cl
 

Editing the product reviews and ratings format 
 
These are the classes available for the product reviews and rating featur
introduced in Version 5.5.0.: 
 
span.review reviewheader (the title of the review) 
span.review numreviews (the number of reviews and average rating) 
span.
h

span.review reviewname (the name 
s
product) 
 
To achieve the following layout 
 

 
 
... add the following to your css file 
 
.review { 
color: #000; 
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font-weight: bold; 
} 
 
.showallreview, .reviewcomments { 

eviewname { 
color: #999; 
font-weight: bold; 
} 
 
hr.review { 
width: 100%; 
text-align:left; 
height: 0; 
border-width: 1px 0 0 0; 
border-style: dashed; 
border-color: #006AC8; 
} 

s 

 
 they will 

 in a 
 

and subfolders it’s best to make all links 

e in 
 

tdelay(800) 

e... 

color: #000; 
font-weight: normal; 
} 
 
.r

 

DHTML Menu
 

ome of the templates use DHTML drop down or pop-out menus. In S
Frontpage these will be include files, found in the Includes folder – In
Dreamweaver they form part of the .dwt template files and In GoLive
e set up as a component. The link colors are set in the .css file. Like any b

script these won’t show up in design view and when previewing them
browser they will not show correctly as they are dependent on the database
connection. Once published to a server they should show correctly. 
 
If your site has a hierarchy of folders 

lative to the root like this: /folder/subfolder/page.asp re
 

OTE N
Please note that a new version of the pop-out menu was made availabl
June 2006. A default delay is now set automatically, but you can also change
this with for instance... 

ymenu.sem
...setting the delay time in milliseconds. 

lso, you can set a rollover color for the menu cells with for instancA
mymenu.mainmenucolorov("#E0E0FF") 
mymenu.submenucolorov("#E0E0FF") 
Those who have products with a menu will automatically get an updated 
ersion when you get the updaters. v
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How the hierarchy works 
The top level of links ie. the ones that show on the menu with no interaction 

ing like this: 

ymenu.addMenu("help","HELP", "help.asp") 
","AFFILIATES", "affiliate.asp") 

 
ymenu.addMenu("checkout","CHECKOUT", "cart.asp") 

 pop-outs it’s necessary to set a main top option, in 

e code for the first pop-out level from the HELP link would look like this 

) 

AQ – the text that appears on the menu 
ed the user won’t go to  a new page, 

ften you would place a real link like faq.asp here 

ymenu.addSubMenu("faq", "", "COMPATIBILITY", "compatibility.asp") 

will be no 
rther pop-outs the next space can be left blank with "" 

 

indow 
k at this example: 

ymenu.addSubMenu("examples", "", "<b>virtual blue</b>", 

t if a section name is not a link 
ometimes it is not necessary to have a section linked, but the section has a 

keep things tidy instead of having 
>", "main.htm") where the link is to 

 change it to mymenu.addMenu("main","<b>main</b>", "#") 
 you maintain the link color but are not taken anywhere in case anyone tries 

are set up with the code look
 
m
mymenu.addMenu("affiliates
mymenu.addMenu("search","SEARCH", "search.asp")
m
 
help – this is the id of your menu option 
HELP – the text displayed on your menu 
help.asp – the link 
 
So before you can have
the example above with the id help 
 
Th
 
mymenu.addSubMenu("help", "faq", "FAQ", "#"
 
help - this is the parent id defined above 
faq – this is the id for the next pop-out 
F
# - this is a null link, meaning that if click
o
 
For a second level popout 
 
m
 
The faq refers to the id we set up previously and because there 
fu
 
You can have as many levels of pop-outs as you need.
 
How to open a link in a new w
If you want to make the link open in a new window, loo
m
'http://www.ecommercetemplates.com/dwpopoublue/" target="_blank') 
Be careful with the punctuation here 
 
How to get a text rollover effec
S
number of pop-outs - to 
mymenu.addMenu("main","<b>main</b
main.htm, you can
so
to click. 
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How to get rid of the default help links and corresponding pop-outs 
 

irst delete this line: 

ymenu.addMenu("help","HELP", "help.asp") 
 
and then all the pop-outs that it spawns, which will be: 
 
mymenu.addSubMenu("help", "faq", "FAQ", "#") 
mymenu.addSubMenu("help", "tutorials", "TUTORIALS", "#") 
 
mymenu.addSubMenu("faq", "", "COMPATIBILITY", "#") 
mymenu.addSubMenu("faq", "", "DHTML MENUS", "#") 
mymenu.addSubMenu("faq", "", "DHTML MENUS", "#") 
mymenu.addSubMenu("faq", "", "GRAPHICS", "#") 
mymenu.addSubMenu("faq", "", "LICENSE", "#") 
 
mymenu.addSubMenu("tutorials", "", "TEMPLATE SET UP", "#") 
mymenu.addSubMenu("tutorials", "", "INCLUDE PAGES", "#") 
mymenu.addSubMenu("tutorials", "navigation", "NAVIGATION", "#") 
 
mymenu.addSubMenu("navigation", "", "FP NAVIGATION", "#") 
mymenu.addSubMenu("navigation", "", "DW NAVIGATION", "#") 
mymenu.addSubMenu("navigation", "", "GL NAVIGATION", "#") 
 
How to set up categories and products manually 
By default the menu generates the category and product links from the 
information passed on from the database. But deleting these two sets of lines 
will remove that functionality: 
 
 
 
/* <% 
 ' Please note, the following line of code is used to automatically create 
the links for the product sections If you do not want to use this feature, please 
delete this line of code in your Main.dwt template along with the 
corresponding section below. 
%> */ 
mymenu.addMenu("products","O PRODUCTS", "categories.asp") 
 
// Delete these 7 lines and the corresponding lines above if you  
// don't want an automatically generated popout menu. 
<% if false then %> </script> <% end if 
menuprestr = "O " 
menupoststr = "" %> 
<!--#include file="../vsadmin/inc/incmenu.asp"--> 
<% if false then %> <script language="JavaScript1.2"> <% end if %> 

Heres an example but the theory is the same for all the templates using the
DHTML menu. 
 
F
 
m
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Important notes 
Don’t use category id’s with spaces, keep them lowercase and with no 
trange characters 

 in the .js file. 
he .js file and clearpixel.gif must go in the root of your site.  

 

 

s
Make sure a main category id is set up before making a corresponding pop-
out. 
There must be at least one pop-out in the menu for it to function correctly. 
There is nothing that needs editing
T
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Chapter 7 

ow to add a buy button to your home page 

ross selling
Product reviews and ratings 
How to add a search box to each of your pages

Tweaks 
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How to skin the control panel 
H
Adding HTML to your product descriptions 
C

Minimum and maximum price search
Customer defined product sort order
Advanced parameters and tweaks (ASP version) 

dvanced parameters and tweaks (PHP version)A
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store. 

Introduction 
 
This chapter deals with some of the tweaking you can employ in the 
ecommerce templates to get even more functionality out of your 
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How to skin the control panel. 

n the code behind the admin is ongoing. 

e admin section is now skinable, 
graphics. 

e some instructions below to help you change things around. 

yout and colors can be found in your 
nstyle.css. You will see that we have added 

ments to the file so you can see how the various sections are set up. 

k up of 

d color is set to light blue #E6E9F5 and can be changed 

 

h the header which gives the 

ackgr
 
Chang
 
By def
border: 1px dotted #194C7F; 
Other options are dashed, solid, double… 
 

ther ges 

ks. These should be self explanatory.  

 
Version 4.8.0 saw the introduction of the CSS based skinable control panel. 
 
The design itself is 100% CSS based and XHTML transitional compliant, work 
o
 
Apart from speeding up download times th
allowing for simple changes in colors and 
 
We hav
 
The Stylesheet 
 
The stylesheet that governs the la
sadmin folder and is called admiv

com
 
Before making any changes we strongly suggest making a bac
dminstyle.css so you can always go back to the original. We would also a

suggest not making any changes at all if you are not confident editing CSS. 
 
Changing the backgrounds 
 

he main backgrounT
here: 
background: #E6E9F5; 
The main body is white, although it's probably best to keep it that way it can
be changed under #main: 
background: #FFF; 
The header section is set at #BFC9E0: 
background:#BFC9E0; 
 
There is also a background image associated wit

unded effect at the top of the header: ro
b ound-image: url('adminimages/newtoptopbg.jpg');  

ing the table borders 

ault there is a dotted line around the table borders: 

O CSS chan
 

ost of the other changes that can be made relate to the color of the input M
boxes, alternate cell colors, text and lin
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NB 

We strongly suggest not making any differ
eleme
different resolutions  

Changing the graphics 

The images associated with the control panel can be found in the folder 
/adminimages/ and we would suggest keeping the same dimensions 

Logo: 

adminimages/ecommerce_templates.gif" width="278" height="53"  

es/administration.jpg" width="150" height="31" 

ges/product_admin.jpg" width="150" height="31" 

dminimages/shipping_admin.jpg" width="150" height="31" 

ions 

l panel but do check in 

 

 
 
 

ences to the absolute positioning of 
nts and remember to preview the admin section in different browsers at 

Left hand menu titles: 

adminimag

adminima

a

adminimages/extras.jpg" width="150" height="31"  

Horizontal line graphic between menu items: 

adminimages/hr.gif  

bservatO

That should give you the basics for skinning the contro
different browsers and at different resolutions. Do make a back up of the 
original files before starting but if things become irreparable then get the latest
updater and replace the stylesheet and images from the original. 
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How to add a buy button to your home page. 
ded to other 

e. 

ducts on your store as you will 

hod="post" action="cart.asp">  
e="XXXXXX">  

e="hidden" name="mode" value="add">  
input type="image" src="images/buy.gif" border="0">  

here xxxxxx is the id of your product. 

PHP version, change cart.asp to cart.php

This is pretty simple, and of course your buy button can be ad
pages, it doesn’t have to be the home pag
 
The first thing you need to do is to get the pro
need to copy and paste some code. 
 
Where you need the button to appear place this code: 
 
<form met
<input type="hidden" name="id" valu
<input typ
<
</form>  
 
W
 
For the 
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Adding HTML to product descriptions 

his is a great way of formatting your product pages and product detail pages, 
 

 and 

o add colour to your text put them between font tags like this <font 
0000>This is red text</font> 

This is <b>Bold text</b> 

mple of add  descr
o add a head  or a uct photos. 

s/specia th="350" hei

fac  

a href=”anotherpage.htm”>Another Page</a> 

com

eck out the CSS h for CSS classes that can be used in the 
ld. Y  tinym e plug-in available from 

T
sometimes simply spacing out text rather than using blocks can make reading
the information much easier. You can use any valid HTML in the product 
description field. Here are some examples: 
 
<p>To make a double space between lines, put them between opening
closing <p> tags</p> 
 
T
color=”#CC
 

 
Here’s an exa ing an image to the iption, for example you 
might want t ing for “special offers” dd extra prod
 
<img src="image loffers.gif" wid ght="30"> 
 
Or you might want to link to another page, manu turer’s site or wherever:
 
<
 
<a href=”http://www.e mercetemplates.com”>Another Site</a> 
 
Also ch elp file 
product description fie

mercetemplates.com/free_down
ou can also use the c

www.ecom loads.asp 
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Cross Selling 
 
In Version 5.1.0 we introd ng fea u to 
how recommended, bes
lso purchased by previou  customers on the cart p
articularly useful for upse ling products and is extre
onfigurable. 

will nee

!--#include file="vsadmin/inc/inccart.asp"--> 

wn there. If for example you 
d to show bestsellers and related products in that order then you 

 and then you can start configuring the four features. 

up 

nc/inccart.php" ?> 

uced the cross selli ture. This allows yo
s t selling and related products as well as the items 
a s age. This feature is 
p l mely flexible and 
c
 
ASP Version 
 
Initial set up 
 
The first thing you d to do is open the file cart.asp and find the line 
 
<
 
...and just after that add the line 
 
<!--#include file="vsadmin/inc/inccrosssell.asp"--> 
 
Save cart.asp 
 
Now you need to define the features you want to appear on the cart page so 
open includes.asp and add this to the list 
 
crosssellaction="recommended,related,alsobought,bestsellers" 
 
This will show the four features in the order sho
only wante
would change the line to 
 
crosssellaction="bestsellers,related" 
 
Save the file includes.asp
 
PHP version 
 
Initial set 
 
The first thing you will need to do is open the file cart.php and find the line 
 
<?php include "vsadmin/i
 
...and just after that add the line 
 
<?php include "vsadmin/inc/inccrosssell.php" ?> 
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Save cart.php 

so 
he list 

his will show the four features in the order shown there. If for example you 
ts in that order then you 

ge the line to 

 
 the four features. 

he number of recommended products you choose to show is completely up 
to as each one you check in the products admin page will appear here. 

our Ecommerce Template control 
anel click on products admin and then click "Modify" for the product you want 

 

 
Now you need to define the features you want to appear on the cart page 
open includes.php and add this to t
 
$crosssellaction='recommended,related,alsobought,bestsellers'; 
 
T
only wanted to show bestsellers and related produc
would chan
 
$crosssellaction='bestsellers,related'; 

Save the file includes.php and then you can start configuring
 
Configuring recommended products 
 

his will add a row of recommended products that you have chosen from your T
inventory to display on the cart page once any item has been added to cart. 
T

 
To configure a recommended product, in y
p
to show as recommended. At the bottom of the page there is a checkbox like
this: 
 

 
 
Check the box if you want it to appear as a recommended product when any 
other product is added to the cart. 
 
Configuring related products 
 
Related products are ones that you configure through the product admin 
age. They will typically be products that customers who have added a similar 

ice, a superior model to the one already in 
e cart or simply an extra item that you think would be of interest to 

ed in rows below the cart. 

In your Ecommerce Template control panel click on products admin and then 
click on the "related" button. If 

is is the first time you are setting up a relation then you will see a message 
are no related product so then click on "List Products" and you should 

p
/ complimentary item to cart would be interested in. That may be something 
like batteries for an electronic dev
th
somebody who is planning on purchasing. Each related product will be 
display
 

for the product you want to create relations for 
th
there 
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see a screen like this where you can select the product which can be related 
 the item you have selected. to

 
 

 
"Update Relations". Now click on "Back to Listing" and the "Related" 

utton should now show with red text to indicate that it has related products 
 

Check the boxes which you want to relate to the original product and then
click on 
b
configured.
 

 
 

ow when somebody adds the product to cart (the Professional scanner in 
ducts you have configured as related will be shown 

n the cart page. 

onfiguring also bought products 

his handy feature will show products that were bought by previous 

art will be shown on the cart page. 

 selling items in your inventory. 

N
the example above), pro
o
 
C
 
T
customers in conjunction with the item(s) already added to the cart. 
 
There is no configuration necessary for this feature as any products 
previously purchased by customers who also bought the item added to the 
c
 
Configuring best selling products 
 
These are simply the best
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There is no configuration necessary for this feature as the best selling 
roducts are dynamically pulled from the database and will be shown on the 

weaking the display (ASP Version) 

een set, you will probably want to tweak how they 
how on your cart page. Open the files includes.asp and add the parameters 

snobuyorcheckout=TRUE 

his will remove the red discount text from the display 

RUE 
his will remove the product options from the display  

 if you need to make changes that are specific to 
e layout here and not effect the main product page display. The easiest way 

ne style, which can be added just before the cart 
clude line like this for example 

his would center the product name, price and currency display even if on 
your main products page they were left aligned for example. 

weaking the display (PHP Version) 

e the product options from the display  

p
cart page. 
 
T
 
Now the features have b
s
below depending on the display you require... 
 
c
This will remove the buy and checkout buttons from the display 
 
csnoshowdiscounts=TRUE 
T
 
csnoproductoptions=T
T
 
You can also tweak the CSS
th
to do this is with an inli
in
 
<style type="text/css"> 
.prodname,.prodprice,.prodcurrency { 
text-align:center; 
} 
< /style> 
<!--#include file="vsadmin/inc/inccart.asp"-->  
 
T

 
T
 
Now the features have been set, you will probably want to tweak how they 
show on your cart page. Open the files includes.php and add the parameters 
below depending on the display you require... 
 
csnobuyorcheckout=TRUE; $

This will remove the buy and checkout buttons from the display 
 

TRUE; $csnoshowdiscounts=
This will remove the red discount text from the display 
 
$csnoproductoptions=TRUE; 

his will removT
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You can also tweak the CSS if you need to make changes that are specific to 
e layout here and not effect the main product page display. The easiest way 

enter; 

 
 they were left aligned for example. 

th
to do this is with an inline style, which can be added just before the cart 
include line like this for example 
 
<style type="text/css"> 
.prodname,.prodprice,.prodcurrency { 
ext-align:ct
} 
< /style> 

cart.php" ?>  <?php include "vsadmin/inc/inc
 
This would center the product name, price and currency display even if on
your main products page
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Product reviews and ratings 
 
Product reviews are a great way of providing on-topic content, useful to both 
ustomers and search engines alike. As they are provided by visitors and 

 owner before publishing you can be guaranteed fresh 
nd relevant copy for your store. 

ersion 5.5.0 saw the addition of product reviews and ratings to Ecommerce 
 set up details are outlined below. 

nd rating feature you will need to add one line to 
.asp or vsadmin/includes.php depending on the version of 

nning. 

SP Version: enablecustomerratings=TRUE 

hould see 
omething like this 

c
reviewed by the store
a
 
V
Templates and the
 
To enable the review a
vsadmin/includes
the store you are ru
 
A
PHP Version: $enablecustomerratings=TRUE; 
 
You can now visit any of your product detail pages and you s
s
 

 
Clicking on the link will allow your customers to give the product a rating and a 
review 
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All customer reviews are sent to the store control panel for approval before 
lows you to weed out any unwanted additions if you need 

e such a bad thing and 
lowing reports on everything on the store may appear quite contrived so it's 

e. 

publication. This al
to. Constructive criticism of a product may not b
g
good to achieve a balanc
 

 
 
New reviews will appear in red in your ratings admin page, and this is where 

approval the review will be 
ent to your product detail page. 

you can view, approve or delete the review. On 
s
 

 
 

You can specify the number of product reviews you want to appear on the 
product detail page with the a one line addition to vsadmin/includes.asp or 
sadmin/includes.php 

 

HP Version: $numcustomerratings=2; 

v

ASP Version: numcustomerratings=2 
P
 
Clicking on the "Show All" link will take you to the main product review page. 
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rt the reviews by rating or date submitted. You can 
pecify the number of reviews you want per page on the main ratings listing 

SP Version: allreviewspagesize=30 
PHP Version: $allreviewspagesize = 30; 

ou can restrict the product review feature to logged in customers only. All 
 the reviews and ratings but only those who are 

llowed to submit a review or rating. To activate 
sp or 

hange the ratings graphics 

The customer can so
s
with this line in vsadmin/includes.asp or vsadmin/includes.php 
 
A

 
Y
users will be able to see

gged into your site will be alo
this feature you will need to add a line to vsadmin/includes.a
sadmin/includes.php v

 
ASP Version: onlyclientratings=TRUE 
PHP Version: $onlyclientratings=TRUE; 
 
Product review tweaks 
 
Limit reviews per day 
 
It is possible to limit the number of reviews allowed in a 24 hour period with 
this addition to vsadmnin/includes.asp or vsadmin/includes.php 
 
ASP Version: dailyratinglimit=10 
PHP Version: $dailyratinglimit=10; 
 
C
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The default graphics are shown in the screenshot above but we have some 
xtra sets of graphics on our free downloads page that you can upload to your 

ou can make your own graphics. You will need three and they should be 
called reviewcart.gif, reviewcarthg and reviewcartg.gif for the full image, half 

e
main images folder. 
 
Y

image and dimmed image. 
 
Change the separator between reviews 
 
If you want to use a cross browser horizontal line color between the product 
reviews then add this to you .css file 
 
hr.review { 

eight: 0; h
border-width: 1px 0 0 0; 
border-style: dashed; 
border-color: #006AC8; 
} 
 
This will give you a blue dashed line. 
 

---------------------------------------------------------------------- 
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How to add a search box to each of your pages 

this by copying and pasting the following code.  

> 
input type="text" name="stext" size="16"/><br/> 

mit" name="Search"/> 

button them 

his is the most basic search, searching for "All Words" in all categories. But 
you could also use any of the parameters outlined in the tweak below 

 search or to search 
pecific categories. 

arch 
duction of the minimum price parameter, which 

 

 selObj.selectedIndex=0; 

As well as the all signing, all dancing search page, you may want to have just 
a little search box in the left or right navigation column, or at the top of every 
page for instance. You can do 
 

<form method="POST" action="search.asp"> 
<input type="hidden" name="posted" value="1"/
<
<input type="sub

/form> <
 
If you want to include your own graphic (search.gif) for the search 
change  
 
<input type="submit" name="Search"/> 
 
to 
 
<input type="image" name="Submit" src="images/search.gif" border="0"/> 
 
T

as hidden fields to create a really powerful custom
s
 
Minimum and Maximum Price Se
Version 4.8.4 saw the intro
ow means it is possible to search by price ranges, either by simple links or n

from a drop down menu. The code below uses the Dreamweaver Jump Menu
- Dreamweaver > Forms > Jump menu but the code can be copied into other 

TML editors. H
 

lace this code before the closing </HEAD> tag P
 

<script language="JavaScript" type="text/JavaScript"> 
<!-- 
function MM_jumpMenu(targ,selObj,restore){ //v3.0 
 eval(targ+".location='"+selObj.options[selObj.selectedIndex].value+"'"); 

re)  if (resto
} 
//--> 
</script> 

 
Place this where you want the drop down menu to appear: 
 

<form name="form1"> 
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  <select name="menu1" onChange="MM_jumpMenu('parent',this,0)"> 
<option value="#" selected>Please select</option>   
<option 
value="search.php?pg=1&sminprice=0&sprice=10&nobox=true">
  10 
  <option 

under 

value="search.php?pg=1&sminprice=10&sprice=100&nobox=true">10 
- 100 

value="search.php?pg=1&sminprice=101&sprice=200&nobox=true">1

ive a drop down menu with the options of searching ranges of 

 simple link then to search products priced between 100 

 - 

r customer the choice of sorting 
e 

  <option 

01 - 200   
</form>   </select>

 
That will g
 
Under 10 
10 - 100 
100 - 200 
 
Change search.php to search.asp for the ASP version. 
 
If you want to set up a
and 200 you would need something like this: 
<a href="search.php?pg=1&sminprice=101&sprice=200&nobox=true">100
200</a> 
 
Customer defined product sort order 
From Version 5.1 it is possible to provide you
the products on your products page with a drop down box that will appear lik
this on products.asp / .php 
 

 
 

For the ASP version add this code somewhere before the products includ
line in products.asp 

e 

select name="sortby" size="1"> 

 
<form method="post" action=""> 

% <
if session("sortby")<>"" then thesortorder=int(session("sortby")) 
if request.form("sortby")<>"" then thesortorder=int(request.form("sortby")) 
%> 
<
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<option value="1"<% if thesortorder=1 then response.write " 
selected"%>>Sort by product name</option> 
<option value="2"<% if thesortorder=2 then response.write " 

 if thesortorder=3 then response.write " 
elected"%>>Sort by product price</option> 

<option value="4"<% if thesortorder=4 then response.write " 
option> 

option value="5"<% if thesortorder=5 then response.write " 

ere before the products include 

> 

rtorder==1) print ' selected'?>>Sort by 

 ' selected'?>>Sort by 

>Sort by 

>Sort by 

/form> 

selected"%>>Sort by product id</option> 
<option value="3"<%
s

selected"%>>Sort by product price (descending)</
<
selected"%>>Sort by product order</option> 
</select> 
<input type="submit" value="Go" /> 

/form>  <
 
For the PHP version add this code somewh
ne in products.php li

 
form method="post" action=""<

<?php 
(@$_SESSION['sortby'] != '') $thesortorder=(int)$_SESSION['sortby']; if

if(@$_POST['sortby']!='') $thesortorder=(int)$_POST['sortby']; 
?> 
<select name="sortby" size="1"> 
<option value="1"<?php if(@$theso

roduct name</option> p
<option value="2"<?php if(@$thesortorder==2) print ' selected'?>>Sort by 
roduct id</option> p

<option value="3"<?php if(@$thesortorder==3) print
product price</option> 
<option value="4"<?php if(@$thesortorder==4) print ' selected'?>
product price (descending)</option> 
<option value="5"<?php if(@$thesortorder==5) print ' selected'?>

roduct order</option> p
</select> 
<input type="submit" value="Go" /> 
<
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Advanced parameters (ASP version) 
 
In the folder vsadmin there's a file called includes.asp - this is where you can 

ing, tax, and the display 
hat 

 variables below to the page includes.asp. For 
 expireaffiliate=30 you will need to add it to 

he list is not important. 

specify some important options regarding mail, shipp
options for your product pages. Below is a guide to preparing the set up t
best suits your needs. If you are updating your store from a previous version, 
you will need to add the
xample if you don't have the linee

the list. The order of t
 
Contents 
  
Email Options Layout Options Payment Options 
· Email a friend · Product listings · Setting the path to your SSL
· HTML emails · Product layout options · Disabling SSL
· Email orders · Continue shopping link  · Encryption
· Email headers and footers · Category layout options  · Dump credit card numbers
· Order status email · DHTML menu · Force form submission
· Order tracking · Product separation · Authorize.net
· Collect email addresses · Product detail static page · Capture card order status
· Remove mailing list checkbox · Cart product image · Force CVV credit card code
· Mailing list confirmation · Cart product image link · 2Checkout
 · Multi-purchase columns · PayPal
  · Google Checkout
Shipping / Tax Options Display Options Affiliate Options 
· Adding tax to shipping · Product page display numbers · Affiliates cookie
· Removing the shipping 
address

· Removing buy and checkout 
buttons

· Affiliates commission

· Will pick up option · Remove top navigation   
· Show tax inclusive prices · Terms and Conditions   
· UPS options · Quantity boxes   
· Commercial location · Zero price message   
· Shipping insurance · Show product id   
· Invoice / packing slips · Hide product options   
· Canadian tax · Extra checkout fields   
· Per payment provider 
handling charge

· Forcing minimum purchase 
amount

  

· Split heavy packages · Alternative currency format   
· Canada Post · Product detail link   
· Per product tax rate · Hide product option price   
· Shipping estimator · Remove category ID  
· Shipping carriers switch · Show products in stock  
· Combine shipping and 
handling

· Optional zip (postal) code  

· Shipping tracking · Cross selling  
· FedEx discounts · Force product detail link  
 · Limit product description  
 · Remove remember me  
 · Show the product SKU  
 · Show manufacturer in search  

 
· Show manufacturer on 
products page

 

Discount Options Customer Login Admin Tweaks 
· Remove discount / coupon 
feature

· Enable customer login · SQL Server
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· Hide discount / coupon text · Wholesale pricing · Currency formats
  · Forwarding page · Adjust date
  · Force customer login · Character sets
  · Self registry · Multiple languages
  · Remove login prompt · Save admin settings
 · Customer login link · IP blocking
  · Admin login
  · Our ESolutions Quickbooks
  · Product admin HTML editor
  · State abbreviations
  · Static page redirection
Image Tweaks Customer Reviews  
· Change buttons to images · Enable customer reviews  

· Giant image properties
· Logged in customer reviews 
only

 

· Image upload · Display options  
· Default image folders · Limit daily reviews  

 
 

Product listings (Minimum version 1.3.7) 
 

 choose how to sort your pYou can now roduct listings - you can do this 
by id or by price. There are four options: 

roducts alphabetically  
roducts by id  
roducts by price (cheapest first)  
roducts by price (most expensive first)  

 depending on the value added 

roducts in descending order depending on the value added 
x in the product admin page. 

 version 5.4.0) 
his will sort the products in ascending order depending on the date added.  

alphabetically, 
 
1 = sorting the p

g the p2 = sortin
3 = sorting the p
 = sorting the p4

So for example if you wanted to list your products alphabetically you would 
choose this option: 
sortBy = 1 or by product id like this sortBy = 2 
 
sortBy=6  
(Minimum version 5.1.0) 

 orderThis will sort the products in ascending
to the "Product Order" box in the product admin page.  
sortBy=7  
Minimum version 5.1.0) (

This will sort the p
to the "Product Order" bo
 
sortBy=8 
Minimum(

T
sortBy=9 
(Minimum version 5.4.0) 
This will sort the products in descending order depending on the date added. 
 

Setting the path to your SSL (Minimum version 1.3.7) 
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If you are using a payment provider that requires SSL then what the system is
going to look by default is your website URL on an HTTPS connection, ie 

 

 not go to https 

To display the product page number links at the top of the page as well as the 

isabling SSL (Minimum version 3.5.4) 

card 
n 

n. 

IMPORTANT NOTE: 

d 

 (Minimum version 3.5.9) 
 

1 - if not 

https://www.yoursite.com/cart.asp 
If you have shared ssl space which requires a different url, or if you want to 
override the switch to SSL for testing purposes then you can override it like 
his: t

 
ww.yourhostssl.com/yourdir/" pathtossl = "https://w

. . . or . . .  
pathtossl = "http://www.yoursite.com/" 
 . . to keep it on http and.

Product page display numbers (Minimum version 1.3.7) 
 

bottom set pagebarattop=1 
 

 

D
 
Setting nochecksslserver=TRUE will disable the checking with capture 
and other payment systems that require an SSL server that check you are o
an SSL connectio
 

This should not be set unless you are most certainly sure that you are on 
HTTPS when viewing the credit card details. Our check for SSL can be foole
the way some servers set up their shared SSL certs so all this switch does is 
remove the warning in this case. It should NOT be used to enable yourself to 
view CC details on a non-SSL connection. 

Adding tax to shipping

If you need to add tax to shipping you'll need to choose taxShipping=
leave it as it is ie. taxShipping=0 
 
Setting taxShipping=2 will add the shipping tax to the state and country tax 
totals. 
 

imum version 3.6.3) Shipping address (Min
 
Use: 
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noshipaddress=true 

 a shipping address entry section not to be shown on the checkout 
age if set. 

mum version 4.1.0 - only for UPS / USPS / 

"Will Pickup" 
 you want to allow your customers the option of picking up their purchase 

hanged as necessary. 

of picking up from your location. Set to zero if there is no 
harge 

 

um version 1.3.7) 

rmats for 

usedetailbodyformat=1 

rmat to 2 like this useproductbodyformat=2 the 
e product options, price and buy button below 
productbodyformat is set to 1 the product 

isplayed in the number of columns specified by 

 

 
to cause
p
 

"Will pick up option" (Mini
weight and price based shipping.) 
Use: 
willpickuptext=
If
from your physical location. The text here can be c
 
Use 
willpickupcost=1.32 
To set the cost 
c

 

Layout options (Minim
 
In version 1.3.7 we have added the possibility for different layout fo
your products: 
 
productcolumns=2 
 
useproductbodyformat=1 
 
usesearchbodyformat=1 
 

 
usecategoryformat=1 
 

llproductsimage="" a
 
By setting useproductbody fo
products are displayed with th

e product image. When useth
options, price and buy button are displayed to the right of the product image. 
 
The reason we added this second layout is that it lends itself well to having 

ore than one column of products. So, when using useproductbodyformat=2 m
the products will be d
productcolumns, such as 
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productcolumns=2 
 
You can have as many as you like in theory, but just make sure they fit on 
our page. 

he useproductbodyformat set to 1 the productcolumns 
etting will be ignored. 

. 

here is also a second product detail format available now. Setting 
usedetailbodyformat=2 will display the product detail page with the image to 

xt and description to the right of the image choose 

s" and the 

 able to select the columns you 
nd customizing . . . 
e,discounts,listprice,price,priceinctax,instock,optio

ounts,listprice,price,Inc. Tax,In 
tock,Options,Quant, " 

mail a friend (Minimum version 1.3.7) 

e 

rward the information regarding a product to a friend. If you wish to use this 

 2.0.0)  

checkout buttons as well as the price 
y choosing nobuyorcheckout=true and 

y
 
Please note that with t
s
 
To allow you to specify the search results independently of the general 
product display, you can set usesearchbodyformat to 1 or 2 in the same way
 
T

the left of the product description, price, quantity and buy button. 
 

y teIf you need the categor
usecategoryformat=2 
 

llproductsimage="" allows you to specify an image for "All Producta
path can be inserted here. 
 
usecategoryformat=1 
 
useproductbodyformat=3 (Version 5.0.0 required) 
This will be a "list" like layout, and you will be
wish to display by setting a
pdcolumns="id,image,namc

ns,quantity,buy" 
. . . and the column headers like for instance . . . 
cpdheaders="ID,Name,disc
S
 

E
 
You can now add the option of emailing a friend from your product detail pag
 this adds a link to a pop-up window with a form that you can fill out to -

fo
feature set the parameter like this useemailfriend=true - if you would like to 
disable the feature then you need useemailfriend=false 
 

Removing store functions (Minimum version
 

te the buy and You can simply elimina
for all products, this is done b
noprice=true. 
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Affiliates cookie (Minimum version 2.0.0) 
 
By default the affiliate cookie stays active for 30 days, this means that if 
omebs ody clicks on an affiliate link and then comes back later to purchase as 

 within 30 days, the sales will be accredited to the affiliate partner. If 
hen the value here expireaffiliate=30 will have to be 

ffiliates commission (Minimum version 4.5.0) 

ou can now set an affiliate percentage in the affiliates admin, and set a  
  

ew affiliates 

 version 2.0.0) 

n the Microsoft Access database then 
ou will need to put sqlserver=true. Also make sure you change your 

users 
tion. 

 (Minimum version 3.0.0) 
 

tion choose nogiftcertificate=true. 

d coupon text that appears on category and 

 
ive price on the products 

age use 

rom version 5.4 to only show tax inclusive price, set 

long as it's
you need to change this t
modified. 
 

A
 
Y
defaultcommission=12
to set a default commission for n
 

SQL server (Minimum
 
If you need to use SQL server rather tha
y
connection string as suggested in the instructions. The majority of 

 from Access and won't need to use this ophowever will be working
 

Discounts / coupons

To remove the discount and coupon func
 

Hide discount or coupon text (Minimum version 4.1.0) 
To remove the discount an
product pages 

e noshowdiscounts=tru
 

how tax inclusive prices (Minimum version 3.1.2) S

To show tax exclusive price followed by the inclus
p
$showtaxinclusive=TRUE; 
the wording for the tax can be changed in vsadmin/inc/languagefile.php. 
 
F
$showtaxinclusive=2; 

UPS Options (Minimum version 3.5.0) 
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The way that you deliver your packages to UPS for delivery can affect the 

admin/includes.asp file . . . 

he code in quotes there would be taken from the following table... 

er 
6 - One Time Pickup 

07 - On Call Air 

0 - Air Service Center 

te 

at UPS are working on. 

.. 

the product value, but not ask the 

ould like shipping insurance on the checkout 

.5.0) 

ox on 
ly set for 

ally set by your country settings, but 
ometimes servers don't seem to have locales installed, and some have 

total cost of delivering the package. We have set the default as "Customer 
Counter", though you can change this by setting the following in your 
vs
 
upspickuptype="03" 
 
T
 
01 - Daily Pickup 
03 - Customer Count
0

19 - Letter Center 
2
 
Remember to enclose the code above in double quotes. Also, please no

 the same as you might find on the UPS web that these options are not exactly
site but we hear that is something th
 

e.The signature options available for UPS ar
signatureoption="direct" 
signatureoption="indirect" 
signatureoption="adult" 
 
To add UPS shipping insurance based on 
customer... 
addshippinginsurance=1 
To ask the customer if they w
form... 
addshippinginsurance=2 
 

Commercial location (Minimum version 3

Set commercialloc=true if you want to place a question and checkb
checkout for shipping to a commercial location. This is automatical
UPS but can be used for other shipping methods. 

Currency formats (Minimum version 3.1.2) 
 
Normally the currency is automatic
s
special needs. These are the parameters available: 
 
overridecurrency=TRUE 
- Switches the currency overriding on 
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orcsymbol="US$" 

rmally the same, but can be handy if 
 € or 

it to EURO or YEN 

eamount=FALSE 
 currency symbol before or after the amount. 

If you need to force the settlement in US Dollars even if you are selling from 

At the moment for using the "capture card method", credit card encryption can 

ethod="none". Remember that by doing so, you have to 
ke sure the database is secure and to delete the card 

 
 

 
 

e >> category >> product 
en set showcategories=false 

 you need to make your customers agree to your terms and conditions on 

ou will also need to create a page with your terms and conditions called 
 420 x 380 popup. 

- The currency symbol used on product pages. 
 
orcemailsymbol="US$" 
- The currency symbol used in emails. No
you wish to set your product page currency symbol to an HTML code like
¥ and then in the email set 
 
orcdecplaces=2 
- How many decimal places your currency has. 
 
orcpr
- If you want to display the
 
o
- 
rcurrencyisosymbol="USD" 

another country. 
 

Encryption (Minimum version 3.5.0) 
 

be used if ASPEncrypt is available on the server so the parameter will be 
encryptmethod="aspencrypt". If you do not want encryption, you have to 
explicitly set encryptm
take extra care to ma
numbers from the database as soon as they are processed. If you are unsure
about your site security, it might be an idea to contact one of the developers
here for consultation. 
 

op navigation (Minimum version 3.5.0)T

If you need to remove the top navigation ie. hom
th
 

erms and Conditions (Minimum version 3.6.0) T
 
If
checkout, set termsandconditions=true 
Y
termsandconditions.asp ...which will be shown in a
 

Quantity boxes (Minimum version 3.6.1) 
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Setting the following to TRUE will put up a quantity box on the products and 
the product details page (not available if using usedetailbodyformat=2): 
 
showquantonproduct=FALSE 

ricezeromessage="<b>Price: Please call</b>" 

.then in the case where a price is set to zero, this message will be printed 

 as Price: $0.00 as usual. 

lay on the product pages. The text "Product 

ptions=true 

oduct options on the products page. 

eheader="<img src='images/logo.gif' border='0'><br><br>" 

der and set the path / name correctly. 

><br>" 

ss on the invoice. As you can see it is possible to 
se HTML for formatting. 

 

showquantondetail=FALSE 
 

Zero price (Minimum version 3.6.3) 
 
If you set this, for instance... 
 
p
 
..
instead. If the pricezeromessage is not set then products with a zero price will 
be displayed
 

Show product id (Minimum version 3.6.3) 
 
showproductid=true 
 
...will cause the product id to disp
ID" is from the vsadmin/inc/languagefile.asp as xxPrId 
 

Hide product options (Minimum version 3.6.4) 
 
noproducto
 
...this will hide all the pr
 

Invoices / packing slips (Minimum version 3.6.6) 
 
invoic
 
...this will print your logo at the top of the invoice. Obviously you will need to 
upload the logo to your images fol
 
invoiceaddress="<br><b>EcommerceTemplates.com</b><br>My 
Address<br>MyTown, 90210<br>California<br
 
... this will print your addre
u
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invoicefooter="<br><br><font size='1'>Thank you for shopping with 
EcommerceTemplates.com</font>" 
 
..will print the footer information you need to include. Again HTML can be 
used for formatting 

ailable for packing slips, mirroring the invoice versions to 
n the 

ackingslipaddress="packing slip address" 
packingslipheader="packing slip header" 

are 
s cannot be 

ecrypted in a CSV file. 
 

ontinue shopping (Minimum version 3.6.6) 

ctionaftercart=1 

.or not setting anything will mean that the continue shopping button will take 
/languagefile.asp which is 

e current default. 
 

tely back to 

ersion 4.9.9) 

.will skip the page showing "The products have been added to your cart" 
when adding products to the cart. 

 

Packing slip headers and footers (Minimum version 5.3.0) 
 
These settings are av
provide separate headers for the packing slip. HTML can be used as i
invoice examples above. 
p

packingslipfooter="packing slip footer" 
 

Dump credit card numbers (Minimum version 3.6.6) 
 
dumpccnumber=true 
 
...this will dump the credit card numbers to the .csv file. Note that if you 
using ASPEncrypt this option will not be available as the number
d

C
 
a
 
..
the URL from the xxHomeURL from the vsadmin/inc
th

actionaftercart=2 
 
...will make the cart "continue shopping" button return to the page you just 
came from when you are on the cart contents page. 
 

ctionaftercart=3 a
 
...when you add something to your cart, you will refresh immedia
the products page you came from without going to the cart contents page. 
 
actionaftercart=4 (Minimum v
 
..
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cartrefreshseconds=2 (Minimum version 5.1.2) 
 
... can be used 
has been added to your cart" is shown. If set to ze
edirect rather than a refresh. 

to control the number of seconds that the message "The items 
ro this will perform an HTTP 

ours. 

s 4 hours. This is so that if your server time is not the 
 then you can adjust for this. 

ather than 

PS 
ing 

ith insurance. If using 

ith shipping types other than UPS, you have to also set an amount, 

ce=1 then in this example 5% of the product price total 
ill be added to the shipping cost for insurance. 

If addshippinginsurance=2 then in this example 5% of the product price total 
rance IF the user checks the "yes I 

r
 

Adjust date (Minimum version 3.6.6) 
 
dateadjust=3 
 
...would adjust the date the order status was updated by 3 h
 
dateadjust=-4 
 
...would adjust it by minu
same as your local time
NB 
Version 4.6.3 allows for the date adjust in the admin section too r
only in public view as before. 
 

Shipping insurance (Minimum version 3.6.6) 
 
Shipping insurance can now be added to more shipping types than just U
shipping. If using UPS shipping, then add
 
ddshippinginsurance=1 a

 
to your includes.asp file will calculate shipping costs w
UPS shipping then add 
 
addshippinginsurance=2 
 
will ask the user if they would like shipping insurance, and if so add it to the 
shipping cost. 
 
W
shipinsuranceamt 
for instance... 
shipinsuranceamt=5 
If addshippinginsuran
w

will be added to the shipping cost for insu
want shipping insurance" box on checkout. 
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If addshippinginsurance=-1 then in this example 5.00 (of your monetary units, 

s, 
 the shipping cost for insurance IF the user 
ing insurance" box on checkout. This method will 

rance is not available. 

 if you wish by adding the following switch: 

 use a value less than 3 then the orders are not 

ered "completed". If this isn't what is 
w order status like "Received email 

rder" and assign the emailorderstatus to that new status id. That way the 

 4.1.0) 

e 

 is possible to add two new fields to your cart checkout page. The 

" - adds a company name field to the top of 
 the text can be edited here for other uses. 

extraorderfield1required=true - will make this field obligatory, setting to false 

say Dollars) will be added to the shipping cost for insurance. 
If addshippinginsurance=-2 then in this example 5.00 (of your monetary unit
say Dollars) will be added to
checks the "yes I want shipp
not work with USPS shipping for which shipping insu
 

HTML email (Minimum version 4.0.0) 
 

TMLEmails can be sent in H
tmlemails=true h

 

Email orders (Minimum version 4.0.0) 
If you need to set email orders as Unauthorized in your admin orders page, 
set 
emailorderstatus=2  
Please note that if you
authorized your cart will not clear after purchase. 
 
IMPORTANT NOTE 
An order status below 3 is not consid
needed, then it is better to make a ne
o
order will be "completed". 

Category layout (Minimum version
categorycolumns=1 - will give you a vertical list of categories in a single list 
categorycolumns=2 - will show the categories in two columns 
categorycolumns=3 - will show the categories in three columns 
' catseparator="" - is required to use the new category set up - no changes ar
necessary here 
 

Extra checkout fields (Minimum version 4.1.0) 
It
extraorderfield1 will go at the top of the billing and shipping form and the 
extraordefield2 at the bottom of the billing and shipping form. 
 
extraorderfield1="Company Name
your cart checkout page,
 

will make it optional 
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extraorderfield2="Another Field" - will add an additional field to the bottom of 
ere. 

extraorderfield2required=true - will make this field obligatory, setting to false 

on 5.3.0) 

ill appear in the 
iscellaneous" section, following the additional information field. You can 

use these in the following way... 

xtracheckoutfield1="Checkout Field" 

seful if you are using a checkbox or similar small control. To do that just 

just use something like this for example... 

x"" 

xtracheckoutfield1html="<select name="" ordcheckoutextra1"" 

es"">Yes</option></select>" 

xtra address line on checkout (Minimum version 4.9.0) 

m, use the 
llowing switch... 

3) 
ard details are taken on an SSL 
ameter: 

econds. If you want to change 
t 

the cart checkout page, obviously the text will need editing h
 

will make it optional 
 

Extra checkout fields (Minimum versi
 
There are 2 new "checkout" parameters which w
"M

 
e
extracheckoutfield2="2nd Checkout Field" 
 

o make these required use... T
 
xtracheckoutfield1required=TRUE e

 
There is also a parameter to switch the control and the text which can be 
u
add... 
xtracheckoutfield1reverse=TRUE e

 
To specify custom HTML for these 
 
extracheckoutfield1html="<input type=""checkbo
name=""ordcheckoutextra1"" value=""Yes"">" 
e
size=""1""><option value=""No"">No</option><option 
value=""Y
 

E
 
To enable the use of an "Address Line 2" entry on the checkout for
fo
 
useaddressline2=TRUE 
 

Force form submission (Minimum version 4.1.
For payment processors where the credit c
connection on your site you can set the par
forcesubmit=true 
...which will submit the form by default in 5 s
that 5 second interval you can se
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forcesubmittimeout=5000 

5 
 delay. 

o enable the customer login box you will need to add the line (if it's not 

holesale pricing (Minimum version 4.6.0) 
this add the parameter 

 

 logged in customers with the wholesale 

um wholesale purchase amount and message 

inwholesaleamount=23.00 

mail headers and footers (Minimum version 4.2.2) 
either for 

r depending on the payment system chosen. 
oter to all emails then just add the following 
 

ystem 
t now the 

rst column is the payment provider id. Take a note of the id of the payment 
er 

ent provider, you will see that the id is 4. All you 
ave to do is add the id "4" after emailheader or emailfooter like this... 

mailheader4="This is your email header for the email payment provider" 
emailfooter4="This is your email footer for the email payment provider" 

eaders and footers (Minimum version 4.8.0) 

where the time is set in miliseconds, so the above example would result in a 
second
 

Enable customer login (Minimum version 4.2.0) 
T
already present) 
enableclientlogin=true 
 

W
Wholesale prices can be set for product options. To do 
wholesaleoptionpricediff=true
 
You can disable discounts for
attribute by adding the parameter 
nowholesalediscounts=true 
 
You can set a separate minim
by setting the following 
m
minwholesalemessage="Your message" 

E
This feature allows you to add email headers and footers to emails 
all payment systems, o
If you want to add a header or fo
to your vsadmin/includes.asp file
 
emailheader="This is your email header" 
emailfooter="This is your email footer" 
 
If you want to add a header or footer only for a particular payment s
then first go to your admin payment providers page. You will see tha
fi
provider you are interested in. Now if for instance you wanted to add a head
or footer for the "Email" paym
h
 
e

 
Dropshipper h
 
If you want to add a header or footer for the email sent out to dropshippers 
then the general header / footer for all payment types would be like this: 
dropshipheader="<br>general drop ship header<br>" 
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dropshipfooter="general drop ship footer<br>" 

here is an additional Header / footer only for payment method 4 (Email Only) 
dropshipheader4="drop ship header for drop shipper 4<br>" 

ou can now set the system to send an email to customers when you change 
dmin orders page. To turn this feature on you need to 

dd the following parameter for example... 
s been 

pdated from %oldstatus% to %newstatus% on %date% and the additional 
fo%" 

.where %statusinfo% is the information added to the Status Info field in the 
admin orders page. 

 
tmlemails=true setting. The following parameters will be replaced with the 

 

ssubject for the order status emails in 

" 
ubject "Order status updated" will 

 
Using the setting 
alwaysemailstatus=true  
will mean that the checkbox for "email order status change" is always set by 
default.  
 

DHTML menu (Minimum version 4.6.0) 
You can now limit the number of "popout levels" that the DHTML pops out to 
by setting the parameter 
menupoplimit=2 
. . . where 2 in this example would limit to 2 popout levels. 
 

 
T

dropshipfooter4="drop ship footer for drop shipper 4<br>" 
 

Order status email (Minimum version 4.5.0) 
Y
the order status on the a
a
orderstatusemail="Your order id %orderid% from %orderdate% ha
u
comments are %statusin
..

The message can be anything you like, and can contain HTML if you have the
h
actual order and order status details... 
%orderid% 

orderdate% %
%oldstatus% 

newstatus% %
%date% 
%statusinfo%  
 
From version 4.8.6 %ordername% can be added to the order status emails 
and will be replaced by the customer’s name. Also, you can use %nl% for new
ines. l
 
You can also set a parameter orderstatu
the vsadmin/includes.asp file, for example... 

rderstatussubject = "Place text hereo
If you don't set this then the default email s
be used for the order status emails. 
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Authorize.net (Minimum version 4.5.0) 

ize.net merchant id and 

 parameter  
ck=true  
 eChecks. You will need to have your authorize.net account set up 

r accepting eChecks. 

t AIM method ith the  
ce system usi

 order stat  4.6
 orde g 

us=5
. . which in this case wou d set the order status of a capture card order to 5. 
o see the order status id umbers just look on your order status admin page. 

CVV credit card c  checkout (Minimum version 4.7.4) 
rs t to you own site, you can set 

true 
stomer to enter their CVV credit card code on checkout. 

mum
adian st , including the Price 

 Quebe  p vincial tax to the product 
rnment tax. To  you wou need to download the 

plug-in ete . 
ue 

rovider h rge (Minimum version 4.3.0) 
ou can set a "per payme har e. On the payment 
roviders admin page, ea  show  a unique id. You would 
se the text handlingcharge + the unique id to assign the charge. Say for 

nstance if you wanted to  2Checkout" payment 
rovider, then if you look ent providers min page you will see 

kout is 2, et the follo

you need to add tax to h eed to cho dling=1 - if not 
ave it as it is ie. taxHand

Add the parameter secretword to encrypt your author
transaction key in the database for extra security. For example... 
secretword="this is my secret word" 
Please note that if you set this, you will have to reset your merchant id and 
transaction key in your admin payment providers page for authorize.net 
 
f you are using the authorize.net AIM system you can now set theI
accepteche
o allow fort
fo
 
Authorize.ne  can now be used w  WellsFargo
SecureSour ng the setting 
wellsfargo=true 

Capture Card us (Minimum version .0) 
You can set the order status of "Capture Card" rs by setting the followin
capturecardorderstat  
. l
T  n
 

Force ode on
For payment processo hat are integrated in r 
requirecvv=
. . . to force the cu

Canadian tax (Mini  version 4.3.0) 
Support for the Can  PST / GST / HST tax sy em
Edward Island and c systems of adding the ro
total + gove  use this feature ld 
current Canadian and also set the param r..
canadataxsystem=tr
 

Per payment p andling cha  
Y nt provider" handling c g
p ch payment provider s
u
i add a $2.35 charge t

on the paym
o the "

p ad
the ID for 2Chec  so you would s wing... 
handlingcharge2=2.35 
 
If andling you'll n ose taxHan
le ling=0 
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Setting taxHandling=2 wil ax to th  country tax 

tals.  

dd a handling charge pe payment provider which f the cart 
g + handlin u could s

4=
dling . Taxes are not counted 

can also qualify for taxes. (Minimum 

lit heavy packages (Minimum version 4.5.0) 
Adding the parameter splitpackat when using UPS or USPS shipping will split 

to multiple packages. For instance... 
plitpackat=70 

urchase amount (Minimum version 4.3.0) 

 the parameter minpurchasemessage to display a 
l if the minimum purchase amount is not met. For instance... 

inpurchaseamount=4.99 
'm sorry, we have a minimum purchase amount of 

urrency format (Minimum version 4.7.0) 

="<b>€</b>%s" 
s" 

laced by the actual currency value. Be careful that 
. 

version 4.7.0) 

l add the handling t e state and
to
 
A r is a percentage o
total + shippin g. For instance yo et . 
handlingchargepercent 5 
. . . to add a 5% han
in this total as the handling charge 

charge to "Email" payments

version 5.0.0) 
 

Sp

heavy packages in
s
 

anada Post (Minimum version 4.6.0) C
To place Canada Post in test mode on the testing server, please use the 
following parameter 
canadaposttest=TRUE 
 

Forcing minimum p
Setting the parameter minpurchaseamount will force a minimum purchase 
amount. You can also set
message / htm
m
minpurchasemessage="I
£4.99. Please go back and <b>buy some more</b>"  
 

Alternative c
You can now have total control over the display of the currency conversions if 
you require. For instance use the following. . . 
 
currFormat1
currFormat2="<b>£</b>%
currFormat3="<b>$</b>%s" 
 
In each of these %s is rep
the symbols match the currencies you have chosen on your admin main page

f course you can place any formatting or text here. O
 

Product detail link (Minimum 
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Instead of having the product “details” link leading to the proddetail.asp page, 
you can specify your own link by adding the following (for example) to you
vsadmin/includes.asp file. 
 
detailslink="<a href=""%largeimage%"" target=""_blank"">" 
detail
 
Any instances of %pid% will be replaced by the product id 
of %largeim
image in your admin products page. This will
product.  

r 

sendlink="</a>" 

and any instances 
age% will be replaced by the the value of you have set for large 

 allow you to vary the links per 

 

ide product option price difference (Minimum version 4.7.0) 

wn menus 
. Only the total price will be shown. 

 
es . . . 

ection pages. 

Multiple languages (Minimum version 4.8.0) 

 you need to have more than one language then set: 

language is being used for that particular admin section. 

lient login forwarding page (Minimum version 4.8.0) 

he forwarding 
age for all pages you can set for instance . . . 

lientloginref="referer" 
tionally you can set . . . 

lientloginref2="otherpage.asp" 

H
By setting the switch . . .  
hideoptpricediffs=true 
. . . you can hide the price difference in the product option drop do
and the checkout page
 

Character sets (Minimum version 4.7.0) 
Greater support is now given for “Wide” Character sets such as Japanese and
Chinese. You can set the following 2 switch
 
emailencoding="shift_jis" 
adminencoding="shift_jis" 
 
. . . changing “shift_jis” for the actual character encoding used in your emails 
and admin s
 

 
If
languageid=2 
to indicate which 
 

C
You can set per login level forwarding pages for the client login system or 
send the logged in client back to the referring page. To set t
p
clientloginref="yourpage.asp" 
Or to use the "referring" page set . . . 
c
Or op
c

 
© Ecommerce Templates Page 185 of  255 



 

. . . to set say a forwarding page for only those logged in with login level 2. 

Setting... 

ill force the checkout to use 
kout's v2 system. 

g the switch . . . 
=TRUE 

y 
he database. 

imum version 4.8.0) 

ase=10 
.where 10 here is the maximum number of purchases by that particular IP 

dmin login (Minimum version 4.9.0) 

hen somebody tries to enter your admin section 

ur admin section set: 

n disable the vsadmin directory and create a copy in a 

er product tax rate (Minimum version 4.8.0) 

 
Force the checkout to use 2Checkout's v2 system (Minimum version 
4.8.6) 
 

use2checkoutv2=TRUE 
. . . in your vsadmin/includes.asp file w
2Chec
 

Save admin settings (Minimum version 4.8.4) 
 
Settin
saveadmininapplication
. . . will save the admin settings in the server application state saving man
calls to t
 

IP Blocking (Min
 
To limit the number of transactions in a 24 hour period per IP set: 
blockmultipurch
..
address in 24 hours. 
 

A
 
To receive notification of w
set: 
notifyloginattempt=TRUE 
To disable the login to yo
disallowlogin=TRUE 
This means that you ca
directory with your choice of name that hackers will never know exists.  
 

P
 
To set a tax rate per product add this and a tax rate box will appear in the 
product admin page... 
perproducttaxrate=true 
 

Shipping estimator (Minimum version 4.9.0) 
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To place a shipping estimator on the cart page before checkout use 
estimateshipping=TRUE 
There is also this parameter you can set if you are using a shipping method 

rice based shipping where the ship state is necessary . . 

, this is not necessary for UPS / USPS / Canada Post shipping as 
 is the zip / postal code that is used. 

to not set a default zip (postal) code for the shipping 
stimator (Minimum Version 5.0.0). . . 

e this with . . . 

d="Weight Based" 
st="Canada Post" 

g type. 

age links . . . 

m version 5.0.0) 
A separate tracking number can be set in the admin orders page, and this can 

r status email by specifying %trackingnum% 
he default text for the tracking number would be for instance . . . 

%nl% will be 

us email therefore could be: 
dername%%nl%Your order id %orderid% from 

%oldstatus% to %newstatus% on 
date%%nl%%trackingnum%%nl%Additional Information: %statusinfo%" 

like weight based or p
. 
defaultshipstate="California" 
Please note
it
 
This switch is available 
e
nodefaultzip=TRUE 
 

Shipping carrier switch (Minimum version 4.9.0) 
 
If you need the ability to allow the customer to switch between different 
shipping carriers at checkout you can enabl
alternateratesups="UPS Rates" 
alternateratesusps="USPS Rates" 
alternateratesweightbase
alternateratescanadapo
Please note, the above text can be anything you like and will be included in 
the shipping selector dropdown from which your customers can choose the 
shippin
 

Remove category id from Product Detail page (Minimum version 4.9.2) 
 
Set the following switch . . .  
nocatid=TRUE 
if you don't want the category id added to the product detail p

rder tracking (MinimuO

be set in the orde
T
Your tracking number is: AAAAABBBBBBBCCCCCC 
You can optionally set the text that is displayed for the tracking number by 
setting trackingnumtext. For instance . . . 
trackingnumtext="This is your tracking number: %s %nl%" 

er. The %s will be replaced with the actual tracking numb
s always.  replaced by a newline a

 
An example of the order stat
orderstatusemail = "Dear %or
%orderdate% has been updated from 
%
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Combine shipping and handling (Minimum version 5.0.0) 
andling can be combined with the switch . . . 
ghandling=TRUE 

 / out of stock products on the products page 
 5.0.0) 

 
ock items to appear on your products page  

de on checkout (Minimum version 5.0.0) 

ur ESolutions Quickbooks Integration Utility (Minimum version 5.0.0) 

uresolutionsxml=1 

on the admin orders 
ls in a format compatible with the Our ESoltutions 

uickbooks integration utility. Setting the value to 1 will dump the product id 
 the product name 

um version 5.1.0) 

es up) between 

ion 5.1.0) 

Shipping and h
combineshippin

Showing stock totals
(Minimum version
Set the following switch . . .  
showinstock=TRUE 
to show the number of items in stock on your products page  
 
Use 
noshowoutofstock=TRUE
if you don't want out of st
 

Optional zip (postal) co

This will make the zip code an optional item on the checkout page. 
zipoptional=TRUE  

O
You can use the following switches . . . 
o
ouresolutionsxml=2 

s.asp file to add a menu item . . . to the vsadmin/include
age to dump order detaip

Q
and product description and setting the value to 2 will dump
and the product description in the output.  
 

Product separation (Minim
 
You can remove the horizontal line (and the space it tak
products with the addition of 
 
noproductseparator=TRUE 
 
If you want to add a custom sepration between products then use this 
 
prodseparator="<p align=""center"">---------</p>" 
 

Product detail static page (Minimum vers
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You can set the character of your choice that is used between the individua
words of the product name which make up the product detail static page. Fo
example if you want to separate the words with a hyphen then set 
urlfillerchar="-" 

l 
r 

.to get a page name like this product-name.asp 

he cross selling features you want to display below 

commended,related,alsobought,bestsellers" 

sed depending on what information you would like to 

xt  

Minimum version 5.1.0) 

etting the limit of text in the short product description (Minimum 

..
 

Cross selling (Minimum version 5.1.0) 
 
This addition will show t
the cart: 
 
crosssellaction="re
 
These options are also u
diplay there 
 
csnobuyorcheckout=TRUE 
...will remove the buy and checkout buttons  
csnoproductoptions=TRUE 
...will remove the product options  
csnoshowdiscounts=TRUE 
...will remove the discounts te
 
Full set up details can be found on the cross selling help page. 
 

Force product detail link (
 
Adding.... 
 
forcedetailslink=TRUE 
 
...to includes.asp will force a link to the corresponding product detail page 
even if there is no long description added through the product admin page. 
 

S
version 5.1.0) 
 
If you want to limit the number of characters used on the products page for 
the product description then use this setting... 
 
shortdescriptionlimit=100 
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...where 100 is the number of characters that will be shown on the products 
t you can use the same description in both the long and 

e truncated at that point. 

duct admin page then add this 

arately from our free 
nd upload them as per the instructions there.  

CKeditor product admin HTML editor (Minimum version 5.5.0) 

sp . . . 

Add... 

sestateabbrev=TRUE  

(Minimum version 5.1.2) 

usps" and "fedex". For instance... 
efaulttrackingcarrier="usps" 

emoving FedEx discounted rates (Minimum version 5.2.1) 

RUE 

page. This means tha
short descriptions but the short description will b
 

TinyMCE product admin HTML editor (Minimum version 5.1.0) 
 
If you want the built in HTML editor for your pro
to includes.asp . . . 
htmleditor="tinymce" 
You will need to download the Tinymce files sep
downloads page a
 

F
 
f you want the built in FCKeditor HTML editor for your product admin page I
then add this to includes.a
 
tmleditor="fckeditor" h

 
You will need to download the FCKeditor files separately from our free 
downloads page and upload them as per the instructions there. 
 

State abbreviations (Minimum version 5.1.0) 
 

 
u
 
to use state abbreviations rather than state names 
 

Default shipping tracking 
 
This allows selection of the default shipping carrier on the tracking page. The 
choices are "ups", "
d
 

R
If you receive discount rates from FedEx, this setting will give the customer 
the full default rate 
uselistshippingrates=T
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Force the PayPal locale (Minimum version 5.2.4) 
To force the PayPal payment page locale to one of your choosing you could 
set... 
aypallc="FR" p

...to force the default language / locale to French. 
 

PayPal PayFlow Pro (Minimum version 5.4.4) 
Replacing the SDK method for PayPal PayFlo
senvpforpayflowpro=TRUE 

w Pro set... 

n/includes.asp 

er 
 the switch in vsadmin/includes.asp... 
liveredstate=5 

pping (Minimum version 5.3.1) 

 for any reason Google can't connect to your site, or there is a lot of network 

 

oogledefaultshipping=25.0 

r email is added to the database for you to 

dmin/includes.asp file then by default the box 
ill be checked. 

um version 5.3.0) 
ecking out 

u
...in vsadmi

Google Checkout order status (Minimum version 5.2.5) 
You can change the delivered status that Google will set for a delivered ord
by setting
oogledeg

...to whatever you like. 
 
Google Checkout default shi
 
If
traffic and the callback takes over 3 seconds, then Google will fail the 
callback. When we pass the cart to Google we are obliged to set a default 
shipping rate in case this happens and we set that to $999 so that it stands
out and integration problems can be resolved. But you can override this 
efault shipping rate if with the setting... d

g
... or to whatever you like. 
 

Collect email addresses (Minimum version 5.3.0) 
ustomers are asked on checkout if they would be willing to receive C

promotional emails and if so thei
use with your mailshots. 
f the following is set in the vsaI
w
allowemaildefaulton=TRUE 
 

Force customer login (Minim
To force customers to create an account before ch
orceclientlogin=true f
 

Self register (Minimum version 5.3.0) 
o enable customers / clients to self register T

allowclientregistration=true  
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Remove login prompt (Minimum version 5.3.0) 
 you need to remove the prompt on cart.asp to login then add this to your 

... 
oclientloginprompt=TRUE 

 you are using static pages, an attempt to locate the page on the old 
ermanently" and a redirect 
llowing setting in your 

sadmin/includes.asp file... 

emove the "remember me" box from checkout  (Minimum version 
5.3.0) 

 the checkout page then 
dd this to vsadmin/includes.asp... 

ludes.asp 

p. By 
mail to verify their address and intention. 

 
 you want to show a thumbnail image in the cart of the product a customer 

has purchased, add this to vsadmin/includes.asp 

) 
art to its product detail page, 

Show the SKU on the product and detail pages  (Minimum version 5.4.0) 
 detail pages then 

dd this to vsadmin/includes.asp... 

If
vsadmin/includes.asp file
n

Static page redirection (Minimum version 5.3.0) 
If
dynamic URL will result in an HTTP "301 Moved P
to the static page. To enable this feature use the fo
v
redirecttostatic=TRUE 
 

R

If you want to remove the Remember Me feature from
a
noremember=TRUE 

Remove mailing list checkbox (Minimum version 5.3.1) 
Set this in vsadmin/includes.asp 
nomailinglist=TRUE 
to remove the mailing list checkbox. 
 

Stop email confirmation for mailing list  (Minimum version 5.4.0) 
etting this in vsadmin/incS

noconfirmationemail=TRUE 
will stop the email a customer receives to verify their mailing list sign-u
efault the customer will receive an ed

Show thumbnail image in the shopping cart  (Minimum version 5.4.0)
If

useimageincart=TRUE 
 

Link the thumbnail image in the shopping cart  (Minimum version 5.4.0
If you want to link the thumbnail image in the c
add this to vsadmin/includes.asp 
linkcartproducts=TRUE 
 

If you want to show the SKU in the products and product
a
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showproductsku="ISBN" 
...you will need to add the SKU to the product admin page. 

Show the manufacturers on the search page  (Minimum version 5.4.0) 
fine the search by 

anufacturer, use this setting... 
rer="Manufacturer" 

.you will need to define the manufacturers in the manufacturer admin page 

ulti-purchase columns (Minimum version 5.5.0) 

ns=3 

ts page, add 

ustomeraccounturl="clientlogin.asp" 
 

hanging default buttons to images (Minimum version 5.5.0) 

 you would like to use your own images instead of the browser generated 
ersion, 

onfigure Options and Buy the add the following to vsadmin/includes.asp 

gcontinueshopping="images/imgcontshop.gif" 

imgprintversion="images/imgprintable.gif" 

gbuybutton="images/buy.gif" 

 

To show a drop down and allow customers to re
m
searchbymanufactu
..
and select them from the product admin page. 
 

M
 
If you are using the multi purchase feature, you can specify the number of 
columns for the quantity boxes with the following setting 
 
multipurchasecolum
 

Show the manufacturer on the products page (Minimum version 5.5.0) 
 
To show the manufacturer field on the produc
 
manufacturerfield="Manufacturer" 
 

Customer login link (Minimum version 5.5.0) 
 
To provide a link to the customer account in the login minibox, add the 
following 
 
c

C
 
If
buttons for Continue Shopping, Update Totals, Delete, Printable V
C
 
im
imgupdatetotals="images/imgupdtots.gif" 
imgdelete="images/imgdelete.gif" 

imgconfigoptions="images/imgconfopts.gif" 
im
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You will need to upload your own images to the main images folder on your 
tore. 

age linked from the product detail page then to 
indow, use the following 

idth=450 
t=600 

images=TRUE 

nable customer reviews and ratings (Minimum version 5.5.0) 

=TRUE 

ers only (Minimum 

ew 

s
 

Giant image properties (Minimum version 5.5.0) 
 
If you are using the giant im
have it appear in a pop-up w
 
giantimageinpopup=TRUE 
 
To set the height and width of the pop-up window, use 
 
giantimagepopupw
giantimagepopupheigh
 
If you prefer not to have a pop-up window and have the image open on a 
separate page then set 
 
giantimageinpopup=FALSE 
 

Image upload (Minimum version 5.5.0) 
 
To enable the image upload in the product admin page add this to 
vsadmin/includes.asp 
 
useaspuploadfor
 

ASPupload installed on the server to Please note that your host must have 
use this feature so please check with them first. 
 

E
 
If you would like your customers to rate and review your products, add this 
line to vsadmin/includes.asp 
 
enablecustomerratings
 

Restrict customer reviews to logged in custom
version 5.5.0) 
 
If you only want logged in customers to be able to add a rating and / or revi
then set 
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onlyclientratings=TRUE 
 

nt to appear 
n the product detail page with the following addition 

umcustomerratings=6 

 reviews per page on the all reviews page(s) 

allreviewspagesize=30 

.0) 

 you want to limit the number of reviews submitted in a 24 hour period then 

ailyratinglimit=10 

efault product and category image folder (Minimum version 5.5.0) 

ged for the 

imagefolder/” 

Customer review display options (Minimum version 5.5.0) 
 
You can set the maximum number of reviews and ratings you wa
o
 
n
 
To set the number of
 

 

Limit the number of reviews submitted per day (Minimum version 5.5
 
If
set the following 
 
d
 

D
 
The default folder for images is /prodimages/ but this can be chan
location of the product images with this addition 
 
defaultprodimages = “new
 
... and this one for category images 
 
defaultcatimages = “newcatimagefolder/” 
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Advanced parameters (PHP version) 
In the folder vsadmin there's a file called includes.php
specify some important options regarding mail,

 - this is where you can 
 shipping, tax, and the display 

set up that 
 in your list, it can be 

important to functionality. 

options for your product pages. Below is a guide to preparing the 
best suits your needs. If the include line is not present
added and the position of the line is not 
 
Contents 
  
Email Options Layout Options Payment Options 
· Email a friend · Product listings · Setting the path to your SSL
· HTML emails · Product layout options · Disabling SSL
· Email orders · Continue shopping link  · Encryption
· Email headers and footers · Category layout options  · Dump credit card numbers
· Order status email · DHTML menu · Force form submission
· Custom headers · Product separation · Authorize.net
· Order tracking · Product detail static page · Capture card order status
· Collect email addresses · Cart product image · Force CVV credit card code
· Remove mailing list checkbox · Cart product image link · PayFlow Pro
· Mailing list confirmation · Multi-purchase columns · 2Checkout
  · PayPal
  · Google Checkout
Shipping / Tax Options Display Options Affiliate Options 
· Adding tax to shipping · Product page display numbers · Affiliates cookie
· Removing the shipping 
address

· Removing buy and checkout 
buttons

· Affiliates commission

· Will pick up option · Remove top navigation   
· Show tax inclusive prices · Terms and Conditions   
· UPS options · Quantity boxes   
· Commercial location · Zero price message   
· Shipping insurance · Show product id   
· Invoice / packing slips · Hide product options   
· Canadian tax · Extra checkout fields   
· Per payment provider 
handling charge

· Forcing minimum purchase 
amount

  

· Split heavy packages · Alternative currency format   
· Canada Post · Product detail link   
· Per product tax rate · Hide product option price   
· Shipping estimator · Remove category ID  
· Shipping carriers switch · Show products in stock  
· Combine shipping and 
handling

· Optional zip (postal) code  

· Shipping tracking · Cross selling  
· FedEx discounts · Force product detail link  
 · Limit product description  
 · Remove remember me  
 · Show the product SKU  
 · Show manufacturer in search  

 
· Show manufacturer on 
products page

 

Discount Options Customer Login Admin Tweaks 
· Remove discount / coupon 
feature

· Enable customer login · cURL compilation

· Hide discount / coupon text · Wholesale pricing · Currency formats
  · Forwarding page · Adjust date
  · Force customer login · Character sets
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  · Self registry · Multiple languages
  · Remove login prompt · IP blocking
 · Customer login link · Admin login
  · Our ESolutions Quickbooks
  · Product admin HTML editor
  · State abbreviations
  · Static page redirection
Image Tweaks Customer reviews  
· Change buttons to images · Enable customer reviews  

· Logged in customer reviews 
· Giant image properties

only
 

· Default image folders · Display options  
 · Limit daily reviews  

 
 
  

Product listings 
 
You can now choose how to sort your product listings - you can do this 
lphabetically, by id or by price. There are four options: a

 
 = sorting the products alphabetically  1

2 = sorting the products by id  
3 = sorting the products by price (cheapest first)  
4 = sorting the products by price (most expensive first)  

 alphaSo for example if you wanted to list your products
hoose this option: 

betically you would 

d 

e products in descending order depending on the date added. 

h to your SSL 

c
$sortBy = 1; 
or by product id like this  
$sortBy = 2; 
 
$sortBy=6;  
(Minimum version 5.1.0) 
This will sort the products in ascending order depending on the value added 
to the "Product Order" box in the product admin page.  
$sortBy=7;  
(Minimum version 5.1.0) 
This will sort the products in descending order depending on the value adde
to the "Product Order" box in the product admin page. 
 
$sortBy=8; 
(Minimum version 5.4.0) 
This will sort the products in ascending order depending on the date added.  
$sortBy=9; 
(Minimum version 5.4.0) 
This will sort th
 

Setting the pat
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If you are using a payment provider that requires SSL then what the system is 

 shared ssl space which requires a different url, or if you want to 
verride the switch to SSL for testing purposes then you can override it like 

/yourdir/"; 

com/"; 
. . to keep it on http and not go to https 

nochecksslserver=TRUE; 
ill disable the checking with capture card and other payment systems that 

n an SSL connection. 

 credit card details. Our check for SSL can be fooled 
ers set up their shared SSL certs so all this switch does is 

enable yourself to 
iew CC details on a non-SSL connection. 

 

ks at the top of the page as well as the 

g 

 shipping you'll need to choose 

etting $taxShipping=2; 
als. 

 version 3.6.3) 

going to look by default is your website URL on an HTTPS connection, ie 
https://www.yoursite.com/cart.php 
If you have
o
this: 
 
$pathtossl = "https://www.yourhostssl.com
. . . or . . .  
$pathtossl = "http://www.yoursite.
. 

Disabling SSL 
 
Setting $
w
require an SSL server that check you are o
IMPORTANT NOTE: 
This should not be set unless you are most certainly sure that you are on 
HTTPS when viewing the
the way some serv
remove the warning in this case. It should NOT be used to 
v

Product page display numbers 
 
To display the product page number lin
bottom set 
$pagebarattop=1; 
 

Adding tax to shippin
 
If you need to add tax to
$taxShipping=1; 
if not leave it as it is: 
$taxShipping=0; 
 
S
will add the shipping tax to the state and country tax tot
 

Shipping address (Minimum
 
Use: 
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$noshipaddress=true; 
 

ddress entry section not to be shown on the checkout to cause a shipping a
page if set. 
 

"Will pick up" option (Minimum version 4.1.0 - only for
weight and price based shipping.) 

 UPS / USPS / 

ation. The text here can be changed as necessary. 

$willpickupcost=1.32; 
here is no 

t layout formats for 
your products 

$usesearchbodyformat=1; 

$allproductsimage=""; 

 with the product options, price and buy button 
elow the product image. When useproductbodyformat is set to 1 the product 

 image. 

g 

Use: 
$willpickuptext="Will Pickup"; 
If you want to allow your customers the option of picking up their purchase 
from your physical loc
 
Use 

To set the cost of picking up from your location. Set to zero if t
charge 
 

Layout options 
 
In version 1.0.3 we have added the possibility for differen

 
$productcolumns=2; 
 
$useproductbodyformat=1; 
 

 
$usedetailbodyformat=1; 
 
$usecategoryformat=1; 
 

 
Those who are upgrading from previous versions will need to add these 
parameters.. 
 
By setting useproductbody format to 2 like this  

; $useproductbodyformat=2
he products are displayedt
b
options, price and buy button are displayed to the right of the product
 
The reason we added this second layout is that it lends itself well to havin
more than one column of products. So, when using  
$useproductbodyformat=2; 
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the products will be displayed in the number of columns specified by 
productcolumns, such as 
 
$productcolumns=2; 
 
You can have as many as you like in theory, but just make sure they fit on 

ith the useproductbodyformat set to 1 the productcolumns 
etting will be ignored. 

he general 
roduct display, you can set usesearchbodyformat to 1 or 2 in the same way. 

w. Setting  

 you need the category text and description to the right of the image choose 
$usecategoryformat=2; 

ed 

ersion 5.0.0 required) 
l be able to select the columns you 

opti

rs like for instance . . . 
cpdheaders="ID,Name,discounts,listprice,price,Inc. Tax,In 

. If you wish to use this 
ature set the parameter like this $useemailfriend=true; 

emoving store functions  

your page. 
 
Please note that w
s
 
To allow you to specify the search results independently of t
p
 
There is also a second product detail format available no
$usedetailbodyformat=2; 
will display the product detail page with the image to the left of the product 
description, price, quantity and buy button. 
 
If

 
$allproductsimage=""; 
allows you to specify an image for "All Products" and the path can be insert
here. 
 
$useproductbodyformat=3; (V
This will be a "list" like layout, and you wil
wish to display by setting and customizing . . . 
$cpdcolumns="id,image,name,discounts,listprice,price,priceinctax,instock,
ons,quantity,buy"; 
 . . and the column heade.
$
Stock,Options,Quant, "; 
 

Email a friend  
 
You can now add the option of emailing a friend from your product detail page 
- this adds a link to a pop-up window with a form that you can fill out to 
forward the information regarding a product to a friend
fe
if you would like to disable the feature then you need 
$useemailfriend=false; 
 

R
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You can simply eliminate the buy and checkout buttons as well as the price 

choosing  
nobuyorcheckout=true; 

Affiliates cookie  

s 
the sales will be accredited to the affiliate partner. If 

ou need to change this then the value here 

 

ow set an affiliate percentage in the affiliates admin, and set a  
defaultcommission=12; 

inimum version 3.0.0) 

nogiftcertificate=TRUE; 

inimum version 3.1.2) 

 inclusive price on the products 

inc/languagefile.php. 

w tax inclusive price, set 

UPS Options (Minimum version 3.5.0) 

for all products, this is done by 
$
and  
$noprice=true; 
 

 
By default the affiliate cookie stays active for 30 days, this means that if 
somebody clicks on an affiliate link and then comes back later to purchase a
long as it's within 30 days, 
y
$expireaffiliate=30; 
will have to be modified.
 

Affiliates commission  
 
You can n
$
to set a default commission for new affiliates 
 

Discounts / coupons (M
 
To remove the discount and coupon function choose 
$
 

Hide discount or coupon text (Minimum version 4.1.0) 
To remove the discount and coupon text that appears on category and 
product pages 
$noshowdiscounts=TRUE; 
 

Show tax inclusive prices (M
 
To show tax exclusive price followed by the
page use 
$showtaxinclusive=TRUE; 
the wording for the tax can be changed in vsadmin/
 
From version 5.4 to only sho
$showtaxinclusive=2; 
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The way that you deliver your packages to UPS for delivery can affect the 

tal cost of delivering the package. We have set the default as "Customer 
Counter", though you can change this by setting the following in your 

e above in double quotes. Also, please note 
same as you might find on the UPS web 

ureoption="indirect"; 
option="adult"; 

t ask the 

; 

g insurance on the checkout 

addshippinginsurance=2; 

n 
for 

 parameters available: 

overridecurrency=TRUE; 
- Switches the currency overriding on 

to

vsadmin/includes.php file . . . 
 

"03"; $upspickuptype=
 

he code in quotes there would be taken from the following table... T
 
01 - Daily Pickup 
03 - Customer Counter 
06 - One Time Pickup 
07 - On Call Air 
19 - Letter Center 
20 - Air Service Center 
 
Remember to enclose the cod
that these options are not exactly the 
site but we hear that is something that UPS are working on. 
 
The signature options available for UPS are... 
$signatureoption="direct"; 
$signat
$signature
 
To add UPS shipping insurance based on the product value, but no
customer... 
$addshippinginsurance=1
 
To ask the customer if they would like shippin
form... 
$

Commercial location (Minimum version 3.5.0) 
Set $commercialloc=TRUE; if you want to place a question and checkbox o
checkout for shipping to a commercial location. This is automatically set 
UPS but can be used for other shipping methods. 
 

Currency formats (Minimum version 3.1.2) 
 
Normally the currency is automatically set by your country settings, but 
sometimes servers don't seem to have locales installed, and some have 
special needs. These are the
 
$

 
202  © Ecommerce Templates 



 
 
$orcsymbol="US\$"; 

EURO or YEN 

ncy has. 

rator. Normally a "." but can be "," 

orcthousands=","; 
ally a "," but can be a "." 

orcpreamount=FALSE; 

 

 does require the mcrypt library 2.4 or above to be compiled with PHP so ask 
hrase" in the vsadmin/includes.php 

ot 
 this"; 

o make it unique (don't just copy the example above). Do add random text 
t 32 characters long (and not 

- The currency symbol used on product pages. 
 
$orcemailsymbol="US\$"; 
- The currency symbol used in emails. Normally the same, but can be handy if 
you wish to set your product page currency symbol to an HTML code like € or 
¥ and then in the email set it to 
 
$orcdecplaces=2; 
 How many decimal places your curre-

 
$orcdecimals="."; 

the decimal sepa- The symbol used for 
 
$
- The symbol used for the thousands separator. Norm
 
$
- If you want to display the currency symbol before or after the amount. 
 
$orcurrencyisosymbol="USD"; 
- If you need to force the settlement in US Dollars even if you are selling from 
another country. 
 
Please note, the dollar sign ($) is a special character in PHP and so must be
preceeded with a slash, as in "US\$" 
 

Encryption (Minimum version 3.5.0) 
 
For those using Capture Card, the encryption method "mcrypt". You can set 
this by adding... 
 
$encryptmethod="mcrypt"; 
 
It
your host. You also need to set a "pass p
file. For instance... 
 
$ccencryptkey = "adhdhdhe3sk39 add your own random text here and do n
copy
 
D
(not the random text above). Do make it at leas
using the text above). 
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Please note that if someone manages to compromise your database AND 
your site so they gain access to your secret phrase, then it is possible that 

lgorithm. However it does add an important extra level of security. 

ion cypher used by setting for instance... 

p 

product 

 version 3.6.0) 

termsandconditions.php ... which will be shown in a 420 x 380 popup. 

etting the following to TRUE will put up a quantity box on the products and 
the product details page (not available if using $usedetailbodyformat=2;): 

SE; 
showquantondetail=FALSE; 

 set this, for instance... 

...then in the case where a price is set to zero, this message will be printed 
price will 

e displayed as Price: $0.00 as usual. 

they can decrypt the credit card numbers. It is not a public / private key type 
a
 

he encryptYou can also set t
$mcryptalg = MCRYPT_RIJNDAEL_128; 
.in your includes.php page. A list of cyphers supported in PHP is available ..

here... 
http://www.php.net/manual/en/ref.mcrypt.ph
 

Top navigation (Minimum version 3.5.0) 
 

ategory >> If you need to remove the top navigation ie. home >> c
then set 
 
$showcategories=FALSE; 
 

erms and Conditions (MinimumT
 
If you need to make your customers agree to your terms and conditions on 
checkout, set $termsandconditions=TRUE; 
You will also need to create a page with your terms and conditions called 

 

Quantity boxes (Minimum version 3.6.1) 
 
S

 
$showquantonproduct=FAL
$
 

Zero price (Minimum version 3.6.3) 
 
If you
 
$pricezeromessage="<b>Price: Please call</b>"; 
 

instead. If the pricezeromessage is not set then products with a zero 
b
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Show product id (Minimum version 3.6.3) 

.will cause the product id to display on the product pages. The text "Product 
php as xxPrId 

e products page. 

.6) 

 top of the invoice. Obviously you will need to 
 folder and set the path / name correctly. 

My 

. this will print your address on the invoice. As you can see it is possible to 

invoicefooter='<br><br><font size="1">Thank you for shopping with 

an be 
g 

Packing slip headers and footers (Minimum version 5.3.0) 
lips, mirroring the invoice versions to 

rovide separate headers for the packing slip. HTML can be used as in the 

lipaddress="packing slip address"; 
packingslipheader="packing slip header"; 

ump credit card numbers (Minimum version 3.6.6) 

 
$showproductid=TRUE; 
 
..
ID" is from the vsadmin/inc/languagefile.
 

Hide product options (Minimum version 3.6.4) 
 
$noproductoptions=TRUE; 
 
..this will hide all the product options on th.
 

Invoices / packing slips (Minimum version 3.6
 
$invoiceheader='<img src="images/logo.gif" border="0"><br><br>'; 
 
...this will print your logo at the
pload the logo to your imagesu

 
invoiceaddress='<br><b>My Company LLC</b><br>10, My Road<br>$

Town, MyCity 90210<br>USA<br><br>'; 
 
..
use HTML for formatting. 
 
$
EcommerceTemplates.com</font>'; 
 
..will print the footer information you need to include. Again HTML c
used for formattin
 

These settings are available for packing s
p
invoice examples above. 
$packings
$
$packingslipfooter="packing slip footer"; 
 
 

D
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$dumpccnumber=TRUE; 
 
...this will dump the credit card numbers to the .csv file. 

ontinue shopping (Minimum version 3.6.6) 

actionaftercart=1; 

opping button will take 
e URL from the xxHomeURL from the vsadmin/inc/languagefile.php which is 

 default. 

.will make the cart "continue shopping" button return to the page you just 
came from when you are on the cart contents page. 

=3; 

 

cart" is shown. If set to zero this will perform an HTTP 

djust date (Minimum version 3.6.6) 

dateadjust=3; 

ot the 

hipping insurance (Minimum version 3.6.6) 
 

 

C
 
$
 
...or not setting anything will mean that the continue sh
th
the current
 
$actionaftercart=2; 
 
..

 
$actionaftercart
 
...when you add something to your cart, you will refresh immediately back to
the products page you came from without going to the cart contents page. 
 
$actionaftercart=4; (Minimum version 4.9.9) 
 
...will skip the page showing "The products have been added to your cart" 

hen adding products to the cart. w
 
$cartrefreshseconds=2; (Minimum version 5.1.2) 
 
... can be used to control the number of seconds that the message "The items 
has been added to your 
redirect rather than a refresh. 
 

A
 
$
 
...would adjust the date the order status was updated by 3 hours. 
 
$dateadjust=-4; 
 
...would adjust it by minus 4 hours. This is so that if your server time is n
same as your local time then you can adjust for this. 

S
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Shipping insurance can now be added to more shipping types than just UPS 

g. If using UPS shipping, then adding 

 your includes.asp file will calculate shipping costs with insurance. If using 

e shipping insurance, and if so add it to the 
hipping cost. 

unt, 

 $addshippinginsurance=1; then in this example 5% of the product price total 
will be added to the shipping cost for insurance. 

 of the product price total 

surance=-1; then in this example 5.00 (of your monetary 
st for insurance. 

pping cost for insurance IF the user 
. This method will 

rsion 4.0.0) 

witch: 

a value less than 3 then the orders are not 
authorized your cart will not clear after purchase. 

at is 

shippin
 
$addshippinginsurance=1; 
 
to
UPS shipping then add 
 
$addshippinginsurance=2; 
 
will ask the user if they would lik
s
 
With shipping types other than UPS, you have to also set an amo
shipinsuranceamt 
for instance... 
$shipinsuranceamt=5; 
If

If $addshippinginsurance=2; then in this example 5%
will be added to the shipping cost for insurance IF the user checks the "yes I 
want shipping insurance" box on checkout. 
If $addshippingin
units, say Dollars) will be added to the shipping co

 $addshippinginsurance=-2; then in this example 5.00 (of your monetary If
units, say Dollars) will be added to the shi
checks the "yes I want shipping insurance" box on checkout
not work with USPS shipping for which shipping insurance is not available.  
 

HTML email (Minimum ve
 
Emails can be sent in HTML if you wish by adding the following s

htmlemails=true; $
 

Email orders (Minimum version 4.0.0) 
If you need to set email orders as Unauthorized in your admin orders page, 
set 
$emailorderstatus=2;  
 
Please note that if you use 

IMPORTANT NOTE 
An order status below 3 is not considered "completed". If this isn't wh
needed, then it is better to make a new order status like "Received email 
order" and assign the emailorderstatus to that new status id. That way the 
order will be "completed".  
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Category layout (Minimum version 4.1.0) 
f categories in a single list 

will show the categories in two columns 
 

gories in three columns 

 of the billing and shipping form. 

this field obligatory, setting to 
ke it optional 

"Another Field"; - will add an additional field to the bottom of 
 the text will need editing here. 

 use... 

$extracheckoutfield1required=TRUE; 

e control and the text which can be 
box or similar small control. To do that just 

$extracheckoutfield1reverse=TRUE; 

$categorycolumns=1; - will give you a vertical list o
 
$categorycolumns=2; - 

$categorycolumns=3; - will show the cate
 

 to use the new category set up - no changes $catseparator=""; - is required
are necessary here 
 

Extra checkout fields (Minimum version 4.1.0) 
It is possible to add two new fields to your cart checkout page. The 
extraorderfield1 will go at the top of the billing and shipping form and the 

tomextraordefield2 at the bot
 
$extraorderfield1="Company Name"; - adds a company name field to the top 
of your cart heckout page, text can be edited here for other uses. 
 
extraorderfield1required=TRUE; - will make $

false will ma
 

=$extraorderfield2
the cart checkout page, obviously
 
$extraorderfield2required=TRUE; - will make this field obligatory, setting to 
false will make it optional 
 

Extra checkout fields (Minimum version 5.3.0) 
There are 2 new "checkout" parameters which will appear in the 
"Miscellaneous" section, following the additional information field. You can 

ng way... use these in the followi
 
$extracheckoutfield1="Checkout Field"; 
$extracheckoutfield2="2nd Checkout Field"; 
 
To make these required
 

 
There is also a parameter to switch th
useful if you are using a check
add... 
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To specify custom HTML for these just use something like this for example... 
 

Extra address line on checkout (Minimum version 4.9.0)
To enable the use of an "Address Line 2" entry on the checkout form, use the 
following switch... 
$useaddressline2=TRUE; 
 

Force form submission (Minimum version 4.1.3) 
For payment processors where the credit card details are taken on an SSL 
connection on your site you can set the parameter: 
$forcesubmit=TRUE; 
...which will submit the form by default in 5 seconds. If you want to change 
that 5 second interval you can set 
$forcesubmittimeout=5000; 
where the time is set in miliseconds, so the above example would result in a 5 
second delay. 
 

Enable customer login (Minimum version 4.2.0) 
To enable the customer login box you will need to add the line (if it's not 
already present) 
$enableclientlogin=true; 
 

Wholesale pricing (Minimum version 4.6.0) 
Wholesale prices can be set for product options. To do this add the parameter 
$wholesaleoptionpricediff=TRUE; 
 
You can disable discounts for logged in customers with the wholesale 
attribute by adding the parameter 
$nowholesalediscounts=TRUE; 
 
You can set a separate minimum wholesale purchase amount and message 
by setting the following 
$minwholesaleamount=23.00; 
$minwholesalemessage="Your message"; 
 

Email headers and footers (Minimum version 4.2.1) 

$extracheckoutfield1html="<input type=\"checkbox\" 
name=\"ordcheckoutextra1\" value=\"Yes\">"; 
$extracheckoutfield1html="<select name=\" ordcheckoutextra1\" 

\"No\">No</option><option size=\"1\"><option value=
value=\"Yes\">Yes</option></select>"; 
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This feature allows you to add email headers and footers to emails either for 
all payment systems, or depending on the payment system chosen. 
If you want to add a header or footer to all emails then just add the following 
to your vsadmin/includes.php file 
 
$emailheader="This is your email header"; 
$emailfooter="This is your email footer"; 
 
If you want to add a header or footer only for a particular payment system 
then first go to your admin payment providers page. You will see that now the 
first column is the payment provider id. Take a note of the id of the payment 
provider you are interested in. Now if for instance you wanted to add a header 
or footer for the "Email" payment provider, you will see that the id is 4. All you 
have to do is add the id "4" after emailheader or emailfooter like this... 
 
$emailheader4="This is your email header for the email payment provider"; 
 
$emailfooter4="This is your email footer for the email payment provider"; 
 
Dropshipper headers and footers (Minimum version 4.8.0) 
 
If you want to add a header or footer for the email sent out to dropshippers 
then the general header / footer for all payment types would be like this: 
$dropshipheader="<br>general drop ship header<br>"; 
$dropshipfooter="general drop ship footer<br>"; 
 
There is an additional Header / footer only for payment method 4 (Email Only) 
$dropshipheader4="drop ship header for drop shipper 4<br>"; 
$dropshipfooter4="drop ship footer for drop shipper 4<br>"; 
 

Order status email (Minimum version 4.5.0) 
You can now set the system to send an email to customers when you change 
the order status on the admin orders page. To turn this feature on you need to 
add the following parameter for example... 
$orderstatusemail="Your order id %orderid% from %orderdate% has been 
updated from %oldstatus% to %newstatus% on %date% and the additional 
comments are %statusinfo%"; 
...where %statusinfo% is the information added to the Status Info field in the 
admin orders page. 
The message can be anything you like, and can contain HTML if you have the 
$htmlemails=true; setting. The following parameters will be replaced with the 
actual order and order status details... 
%orderid% 
%orderdate% 
%oldstatus% 
%newstatus% 
%date% 
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%statusinfo%  
From version 4.8.6 %ordername% can be added to the order status emails 
and will be replaced by the customers name. Also, you can use %nl% for 
newlines. 
 
You can also set a parameter $orderstatussubject for the order status emails 
in the vsadmin/includes.php file, for example... 
$orderstatussubject = "Place your text here"; 
If you don't set this then the default email subject "Order status updated" will 
be used for the order status emails. 
 
Using the setting 
$alwaysemailstatus=true; 
will mean that the checkbox for "email order status change" is always set by 
default. 
 

DHTML menu (Minimum version 4.6.0) 
You can now limit the number of "popout levels" that the DHTML pops out to 
by setting the parameter 
$menupoplimit=2; 
. . . where 2 in this example would limit to 2 popout levels. 
 

Authorize.net (Minimum version 4.5.0) 
Add the parameter $secretword to encrypt your authorize.net merchant id and 
transaction key in the database for extra security. For example... 
$secretword="this is my secret word"; 
Please note that if you set this, you will have to reset your merchant id and 
transaction key in your admin payment providers page for authorize.net 
 
If you are using the authorize.net AIM system you can now set the parameter  
$acceptecheck=true; 
to allow for eChecks. You will need to have your authorize.net account set up 
for accepting eChecks. 
 
Authorize.net AIM method can now be used with the WellsFargo 
SecureSource system using the setting 
$wellsfargo=true; 
 

Capture card order status (Minimum version 4.6.0) 
You can set the order status of "Capture Card" orders by setting the following 
$capturecardorderstatus=5; 
. . . which in this case would set the order status of a capture card order to 5. 
To see the order status id numbers just look on your order status admin page. 
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Force CVV credit card code on checkout (Minimum version 4.7.4) 
For payment processors that are integrated into your own site, you can set 
$requirecvv=TRUE; 
. . . to force the customer to enter their CVV credit card code on checkout. 
 

PayPal PayFlow Pro (Minimum version 4.7.4 to 5.4.4) 

By default it is assumed that payflow pro support has been compiled into 
PHP. If using the command line version of the pfpro module however, you can 
set the following . . . 

$pathtopfpro = "/path/to/pfpro"; 

Those using the PHP version on a windows server can set . . 
.$pathtopfpro=="COM"; 
. . . to use the PFProCOMControl COM Component. 

You can also use . . . 
$pathtopfprocert = "/path/to/certificate"; 
. . . to specify the directory to the payflow pro certificate. 

PayFlow Pro (Minimum version 4.8.2 to 5.4.4) 

Setting $pathtopfprolib can be set in the vsadmin/includes.php file to specify 
the location of the payflow pro libraries for Verisign.  

PayPal PayFlow Pro (Minimum version 5.4.4) 
Replacing the SDK method for PayPal PayFlow Pro set... 
$usenvpforpayflowpro=TRUE; 
...in vsadmin/includes.php 
 

Canadian Tax (Minimum version 4.3.0) 
Support for the Canadian PST / GST / HST tax system, including the Price 
Edward Island and Quebec systems of adding the provincial tax to the product 
total + government tax. To use this feature you would need to download the 
current Canadian plug-in and also set the parameter... 
$canadataxsystem=true; 
 

Per payment provider handling charge (Minimum version 4.3.0) 
You can set a "per payment provider" handling charge. On the payment 
providers admin page, each payment provider shows a unique id. You would 
use the text $handlingcharge + the unique id to assign the charge. Say for 
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instance if you wanted to add a $2.35 charge to the "2Checkout" payment 
provider, then if you look on the payment providers admin page you will see 
the ID for 2Checkout is 2, so you would set the following... 
$handlingcharge2=2.35; 
 
If you need to add tax to handling you'll need to choose 
$taxHandling=1; 
if not leave it as it is: 
$taxHandling=0; 
 
Setting $taxHandling=2; 
will add the handling tax to the state and country tax totals. 
 
Add a handling charge per payment provider which is a percentage of the cart 
total + shipping + handling. For instance you could set . 
$handlingchargepercent4=5; 
. . . to add a 5% handling charge to "Email" payments. Taxes are not counted 
in this total as the handling charge can also qualify for taxes. (Minimum 
version 5.0.0) 
 

Split heavy packages (Minimum version 4.5.0) 
Adding the parameter $splitpackat when using UPS or USPS shipping will 
split heavy packages into multiple packages. For instance... 
$splitpackat=70; 
 

Canada Post (Minimum version 4.6.0) 
To place Canada Post in test mode on the testing server, please use the 
following parameter 
$canadaposttest=TRUE; 
 

Forcing minimum purchase amount (Minimum version 4.3.0) 
Setting the parameter $minpurchaseamount will force a minimum purchase 
amount. You can also set the parameter $minpurchasemessage to display a 
message / html if the minimum purchase amount is not met. For instance... 
$minpurchaseamount=4.99; 
$minpurchasemessage="I'm sorry, we have a minimum purchase amount of 
£4.99. Please go back and <b>buy some more</b>"; 
 

Alternative currency format (Minimum version 4.7.0) 
You can now have total control over the display of the currency conversions if 
you require. For instance use the following. . . 
 
$currFormat1="<b>€</b>%s"; 
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$currFormat2="<b>£</b>%s"; 
$currFormat3="<b>$</b>%s"; 
 
In each of these %s is replaced by the actual currency value. Be careful that 
the symbols match the currencies you have chosen on your admin main page. 
Of course you can place any formatting or text here. 
 

Product detail link (Minimum version 4.7.0) 
Instead of having the product “details” link leading to the proddetail.asp page, 
you can specify your own link by adding the following (for example) to your 
vsadmin/includes.asp file. 
 
$detailslink="<a href=\"%largeimage%\" target=\"_blank\">"; 
$detailsendlink="</a>"; 
 
Any instances of %pid% will be replaced by the product id and any instances 
of %largeimage% will be replaced by the the value of you have set for large 
image in your admin products page. This will allow you to vary the links per 
product. 
 

Hide product option price difference (Minimum version 4.7.0) 
By setting the switch . . .  
$hideoptpricediffs=true; 
. . . you can hide the price difference in the product option drop down menus 
and the checkout page. Only the total price will be shown. 
 

cURL compilation (Minimum version 4.3.0) 
An alternative is provided for those that don't have cURL compiled into PHP, 
but where the host provides cURL on the command line. This would only 
affect those users who wish to use UPS shipping calculations or Authorize.net 
AIM and receive an error about curl_init() being undefined. To use this feature 
you need to set the path to the cURL binary on your server in the parameter 
$pathtocurl. For instance... 
$pathtocurl="/usr/local/curl";  
 

Character sets (Minimum version 4.7.0) 
Greater support is now given for “Wide” Character sets such as Japanese and 
Chinese. You can set the following 2 switches . . . 
 
$emailencoding="shift_jis"; 
$adminencoding="shift_jis"; 
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. . . changing “shift_jis” for the actual character encoding used in your emails 
and admin section pages.  
 

Multiple languages (Minimum version 4.8.0) 
If you need to have more than one language then set: 
$languageid=2; 
to indicate which language is being used for that particular admin section. 
 

Client login forwarding page (Minimum version 4.8.0) 
You can set per login level forwarding pages for the client login system or 
send the logged in client back to the referring page. To set the forwarding 
page for all pages you can set for instance . . . 
$clientloginref="yourpage.php"; 
Or to use the "referring" page set . . . 
$clientloginref="referer"; 
Or optionally you can set . . . 
$clientloginref2="otherpage.php"; 
. . . to set say a forwarding page for only those logged in with login level 2. 
 
Force the checkout to use 2Checkout's v2 system (Minimum version 
4.8.6) 
 
Setting... 
$use2checkoutv2=TRUE; 
. . . in your vsadmin/includes.php file will force the checkout to use 
2Checkout's v2 system. 
 

Custom headers (Minimum version 4.8.4) 
 
You can set the parameter $customheaders in your vsadmin/includes.php file 
for hosts that require non-standard email headers. Instances of %from% will 
be replaced by the "From:" address and instances of "%to%" (not normally 
needed) will be replaced by the "To:" address. For example . . . 
$customheaders = "MIME-Version: 1.0\nFrom: %from%\nContent-type: 
text/plain; charset=iso-8859-1\n"; 
 

Per product tax rate (Minimum version 4.8.0) 
 
To set a tax rate per product add this and a tax rate box will appear in the 
product admin page... 
$perproducttaxrate=TRUE; 
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Shipping estimator (Minimum version 4.9.0) 
 
To place a shipping estimator on the cart page before checkout use 
$estimateshipping=TRUE; 
There is also this parameter you can set if you are using a shipping method 
like weight based or price based shipping where the ship state is necessary . . 
. 
$defaultshipstate="California"; 
Please note, this is not necessary for UPS / USPS / Canada Post shipping as 
it is the zip / postal code that is used. 
 
This switch is available to not set a default zip (postal) code for the shipping 
estimator (Minimum Version 5.0.0). . . 
$nodefaultzip=TRUE; 
 

Shipping carrier switch (Minimum version 4.9.0) 
 
If you need the ability to allow the customer to switch between different 
shipping carriers at checkout you can enable this with . . . 
$alternateratesups="UPS Rates"; 
$alternateratesusps="USPS Rates"; 
$alternateratesweightbased="Weight Based"; 
$alternateratescanadapost="Canada Post"; 
Please note, the above text can be anything you like and will be included in 
the shipping selector dropdown from which your customers can choose the 
shipping type. 
 

IP Blocking (Minimum version 4.8.0) 
 
To limit the number of transactions in a 24 hour period per IP set: 
$blockmultipurchase=10; 
...where 10 here is the maximum number of purchases by that particular IP 
address in 24 hours. 
 

Admin login (Minimum version 4.9.0) 
 
To receive notification of when somebody tries to enter your admin section 
set: 
$notifyloginattempt=TRUE; 
 
To disable the login to your admin section set: 
$disallowlogin=TRUE; 
This means that you can disable the vsadmin directory and create a copy in a 
directory with your choice of name that hackers will never know exists. 
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Remove category id from Product Detail page (Minimum version 4.9.2) 
 
Set the following switch . . .  
$nocatid=TRUE; 
if you don't want the category id added to the product detail page links. 
 

Order tracking (Minimum version 5.0.0) 
 
A separate tracking number can be set in the admin orders page, and this can 
be set in the order status email by specifying %trackingnum% 
The default text for the tracking number would be for instance . . . 
Your tracking number is: AAAAABBBBBBBCCCCCC 
You can optionally set the text that is displayed for the tracking number by 
setting trackingnumtext. For instance . . . 
$trackingnumtext="This is your tracking number: %s %nl%"; 
The %s will be replaced with the actual tracking number. %nl% will be 
replaced by a newline as always.  
 
An example of the order status email therefore could be: 
$orderstatusemail = "Dear %ordername%%nl%Your order id %orderid% from 
%orderdate% has been updated from %oldstatus% to %newstatus% on 
%date%%nl%%trackingnum%%nl%Additional Information: %statusinfo%"; 

Combine shipping and handling (Minimum version 5.0.0) 
 
Shipping and handling can be combined with the switch . . . 
$combineshippinghandling=TRUE; 
 

Showing stock totals / out of stock products on the products page 
(Minimum version 5.0.0) 
 
Set the following switch . . .  
$showinstock=TRUE; 
to show the number of items in stock on your products page  
 
Use 
$noshowoutofstock=TRUE; 
if you don't want out of stock items to appear on your products page 
 

Optional zip (postal) code on checkout (Minimum version 5.0.0) 
 
This will make the zip code an optional item on the checkout page. 
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zipoptional=TRUE 
 

Our ESolutions Quickbooks Integration Utility (Minimum version 5.0.0) 
 
You can use the following switches . . . 
$ouresolutionsxml=1; 
$ouresolutionsxml=2; 
. . . to the vsadmin/includes.php file to add a menu item on the admin orders 
page to dump order details in a format compatible with the Our ESolutions 
Quickbooks integration utility. Setting the value to 1 will dump the product id 
and product description and setting the value to 2 will dump the product name 
and the product description in the output. 
 

Product separation (Minimum version 5.1.0) 
 
You can remove the horizontal line (and the space it takes up) between 
products with the addition of 
 
$noproductseparator=TRUE; 
 
If you want to add a custom sepration between products then use this 
 
$prodseparator="<p align=\"center\">........</p>";  
 

Product detail static page (Minimum version 5.1.0) 
 
You can set the character of your choice that is used between the individual 
words of the product name which make up the product detail static page. For 
example if you want to separate the words with a hyphen then set 
$urlfillerchar='-'; 
...to get a page name like this product-name.php 
 

Cross selling (Minimum version 5.1.0) 
 
This addition will show the cross selling features you want to display below 
the cart: 
 
$crosssellaction='recommended,related,alsobought,bestsellers'; 
 
These options are also used depending on what information you would like to 
diplay there 
 
$csnobuyorcheckout=TRUE; 
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...will remove the buy and checkout buttons  
$csnoproductoptions=TRUE; 
...will remove the product options  
$csnoshowdiscounts=TRUE; 
...will remove the discounts text  
 
Full set up details can be found on the cross selling help page. 
 

Force product detail link (Minimum version 5.1.0) 
 
Adding.... 
$forcedetailslink=TRUE; 
...to includes.php will force a link to the corresponding product detail page 
even if there is no long description added through the product admin page. 
 

Setting the limit of text in the short product description (Minimum 
version 5.1.0) 
 
If you want to limit the number of characters used on the products page for 
the product description then use this setting... 
$shortdescriptionlimit=100; 
...where 100 is the number of characters that will be shown on the products 
page. This means that you can use the same description in both the long and 
short descriptions but the short description will be truncated at that point. 
 

TinyMCE product admin HTML editor (Minimum version 5.1.0) 
If you want the built in HTML editor for your product admin page then add this 
to includes.php . . . 
$htmleditor="tinymce";  
You will need to download the Tinymce files separately from our free 
downloads page and upload them as per the instructions there. 
 

FCKeditor product admin HTML editor (Minimum version 5.5.0) 
 
If you want the built in FCKeditor HTML editor for your product admin page 
then add this to includes.php . . . 
 
$htmleditor="fckeditor"; 
 
You will need to download the FCKeditor files separately from our free 
downloads page and upload them as per the instructions there. 
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State abbreviations (Minimum version 5.1.0) 
Add... 
$usestateabbrev=TRUE; 
to use state abbreviations rather than state names 
 

Default shipping tracking (Minimum version 5.1.2) 
This allows selection of the default shipping carrier on the tracking page. The 
choices are "ups", "usps" and "fedex". For instance... 
$defaulttrackingcarrier="usps"; 
 

Removing FedEx discounted rates (Minimum version 5.2.1) 
If you receive discount rates from FedEx, this setting will give the customer 
the full default rate 
$uselistshippingrates=TRUE; 
 

Force the PayPal locale (Minimum version 5.2.2) 
To force the PayPal payment page locale to one of your choosing you could 
set... 
$paypallc="FR"; 
...to force the default language / locale to French. 
 

Google Checkout order status (Minimum version 5.2.3) 
You can change the delivered status that Google will set for a delivered order 
by setting the switch in vsadmin/includes.php... 
$googledeliveredstate=5; 
...to whatever you like. 
 
Google Checkout default shipping (Minimum version 5.3.1) 
 
If for any reason Google can't connect to your site, or there is a lot of network 
traffic and the callback takes over 3 seconds, then Google will fail the 
callback. When we pass the cart to Google we are obliged to set a default 
shipping rate in case this happens and we set that to $999 so that it stands 
out and integration problems can be resolved. But you can override this 
default shipping rate if with the setting... 
$googledefaultshipping=25.0; 
... or to whatever you like. 

Collect email addresses (Minimum version 5.3.0) 
Customers are asked on checkout if they would be willing to receive 
promotional emails and if so their email is added to the database for you to 
use with your mailshots. 
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If the following is set in the vsadmin/includes.php file then by default the box 
will be checked. 
$allowemaildefaulton=TRUE; 

Force customer login (Minimum version 5.3.0) 
To force customers to create an account before checking out 
$forceclientlogin=true; 

Self register (Minimum version 5.3.0) 
To enable customers / clients to self register 
$allowclientregistration=true; 

Static page redirection (Minimum version 5.3.0) 
If you are using static pages, an attempt to locate the page on the old 
dynamic URL will result in an HTTP "301 Moved Permanently" and a redirect 
to the static page. To enable this feature use the following setting in your 
vsadmin/includes.php file... 
$redirecttostatic=TRUE; 
 
Please note, to use this you must have output buffering on the products.php 
and categories.php pages. To do this, simply open these pages in HTML view 
and right at the top add this line 
 
ob_start(); 
right after the line 
session_start(); 

Remove login prompt (Minimum version 5.3.0) 
If you need to remove the prompt on cart.php to login then add this to your 
vsadmin/includes.php file... 
$noclientloginprompt=TRUE; 

Remove the "remember me" box from checkout (Minimum version 5.3.0) 
If you want to remove the Remember Me feature from the checkout page then 
add this to vsadmin/includes.php... 
$noremember=TRUE; 

Remove mailing list checkbox (Minimum version 5.3.1) 
Set this in vsadmin/includes.php 
$nomailinglist=TRUE; 
to remove the mailing list checkbox. 

Stop email confirmation for mailing list (Minimum version 5.4.0) 
Setting this in vsadmin/includes.php 
$noconfirmationemail=TRUE; 
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will stop the email a customer receives to verify their mailing list sign-up. By 
default the customer will receive an email to verify their address and intention. 

Show thumbnail image in the shopping cart (Minimum version 5.4.0) 
If you want to show a thumbnail image in the cart of the product a customer 
has purchased, add this to vsadmin/includes.php 
$useimageincart=TRUE; 

Link the thumbnail image in the shopping cart (Minimum version 5.4.0) 
If you want to link the thumbnail image in the cart to its product detail page, 
add this to vsadmin/includes.php 
$linkcartproducts=TRUE; 

Show the SKU on the product and detail pages (Minimum version 5.4.0) 
If you want to show the SKU in the products and product detail pages then 
add this to vsadmin/includes.php... 
$showproductsku="ISBN"; 
...you will need to add the SKU to the product admin page. 

Show the manufacturers on the search page (Minimum version 5.4.0) 
To show a drop down and allow customers to refine the search by 
manufacturer, use this setting... 
$searchbymanufacturer="Manufacturer"; 
...you will need to define the manufacturers in the manufacturer admin page 
and select them from the product admin page. 
 

Multi-purchase columns (Minimum version 5.5.0) 
 
If you are using the multi purchase feature, you can specify the number of 
columns for the quantity boxes with the following setting 
 
$multipurchasecolumns=3; 
 

Show the manufacturer on the products page (Minimum version 5.5.0) 
 
To show the manufacturer field on the products page, add 
 
$manufacturerfield="Manufacturer"; 
 

Customer login link (Minimum version 5.5.0) 
 
To provide a link to the customer account in the login minibox, add the 
following 
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$customeraccounturl="clientlogin.php"; 
 

Changing default buttons to images (Minimum version 5.5.0) 
 
If you would like to use your own images instead of the browser generated 
buttons for Continue Shopping, Update Totals, Delete, Printable Version, 
Configure Options and Buy the add the following to vsadmin/includes.php 
 
$imgcontinueshopping="images/imgcontshop.gif"; 
$imgupdatetotals="images/imgupdtots.gif"; 
$imgdelete="images/imgdelete.gif"; 
$imgprintversion="images/imgprintable.gif"; 
$imgconfigoptions="images/imgconfopts.gif"; 
$imgbuybutton="images/buy.gif"; 
 
You will need to upload your own images to the main images folder on your 
store. 
 

Giant image properties (Minimum version 5.5.0) 
 
If you are using the giant image linked from the product detail page then to 
have it appear in a pop-up window, use the following 
 
$giantimageinpopup=TRUE; 
 
To set the height and width of the pop-up window, use 
 
$giantimagepopupwidth=450; 
$giantimagepopupheight=600; 
 
If you prefer not to have a pop-up window and have the image open on a 
separate page then set 
 
$giantimageinpopup=FALSE; 
 

Enable customer reviews and ratings (Minimum version 5.5.0) 
 
If you would like your customers to rate and review your products, add this 
line to vsadmin/includes.php 
 
$enablecustomerratings=TRUE; 
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Restrict customer reviews to logged in customers only (Minimum 
version 5.5.0) 
 
If you only want logged in customers to be able to add a rating and / or review 
then set 
 
$onlyclientratings=TRUE; 
 

Customer review display options (Minimum version 5.5.0) 
 
You can set the maximum number of reviews and ratings you want to appear 
on the product detail page with the following addition 
 
$numcustomerratings=6; 
 
To set the number of reviews per page on the all reviews page(s) 
 
$allreviewspagesize=30; 
 

Limit the number of reviews submitted per day (Minimum version 5.5.0) 
 
If you want to limit the number of reviews submitted in a 24 hour period then 
set the following 
 
$dailyratinglimit=10; 
 

Default product and category image folder (Minimum version 5.5.0) 
 
The default folder for images is /prodimages/ but this can be changed for the 
location of the product images with this addition 
 
$defaultprodimages = “newimagefolder/”; 
 
... and this one for category images 
 
$defaultcatimages = “newcatimagefolder/”; 
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General F.A.Q. 
How do I add links to individual products and categories?
I need to change hosts - any recommendations?  
Where can I get the updaters?
Can I upgrade from my Standard Version to the Ecommerce Plus?
Can I resell your templates?
How do I edit the default text on my store?
I add a product to my cart but it shows as empty, why's that?
What is the function of the "Authorize" button in my orders admin page?
Why don't all my categories show up after I've added them through the online 
admin?
Why can’t I see the product images on my store? I just get a red “x”.
How can I download my complete product inventory?
How do I remove the dot after all my category names?
How can I match the fonts used on the graphics for my template?
 

How do I add links to individual products and categories? 
Once you have your products and categories added through the online admin 
section, browse your store and copy the URL of the product/category page 
from your address bar and paste it into the link box you have in your HTML 
editor. This should look something like this /proddetail.asp?prod=ref001 or 
/categories.asp?cat=1 
 

I need to change hosts - any recommendations? 
We don't do hosting ourselves but you can find a number of recommendations 
here on our hosting page http://www.ecommercetemplates.com/hosting.asp. 
 

Where can I get the updaters? 
The updates are available from 
http://www.ecommercetemplates.com/updaters.asp. Free for the first 6 
months and $29.95 for a further 6 months, please email us if you have a 
change of address. 
 

Can I upgrade from my Standard Version to the Ecommerce Plus? 
The price is $60 for the upgrade available from 
http://www.ecommercetemplates.com/upgrades.asp. 
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Can I resell your shopping cart software? 
For the time being, the only avenue is through our affiliates program or 
reseller program, which will give you a 20% return on each purchase made 
through your affiliate link. 
 

How do I edit the text on my store? 
All the default language generated by the store can be edited in the file 
/vsadmin/inc/languagefile.asp/php - the most recent additions are always 
added to the top for people who have already made changes and are 
updating their store version. 
 

I add a product to my cart but it shows as empty, why's that? 
There are 2 known reasons for this happening: 
 
Your cart page is in a frameset -> Remove the page from frames.  
You don't have cookies enabled in your browser -> In Internet Explorer go to 
Tools > Internet Options > Privacy  
If that doesn't solve your problem, please post on our support forum. 
 

What is the function of the "Authorize" button in my orders admin page? 
You'll see this button if someone has gone through checkout but hasn't made 
it back to your store, this may be because they're just playing around with the 
cart, have decided at the last moment not to purchase or there was a glitch on 
the Processor's site. Only hit the authorize button after you've checked with 
your Payment Provider and are sure the payment has been made correctly. 
You can set the amount of time that unauthorized orders appear on your store 
in the admin section. 
 

Why don't all my categories show up after I've added them through the 
online admin? 
This is probably because you haven't added any products to the categories - 
once you associate a product with a category, they should show up. 
 

Why can’t I see the product images on my store? I just get a red “x”. 
 
The default folder for the product images is called prodimages and the 
graphics should be uploaded there and the path set in your product admin 
page. If you see a red “x” in place of the graphic, make sure the file name is 
spelled correctly, that it is lowercase with no spaces in the name and has the 
correct .jpg or .gif extension. 
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How can I download my complete product inventory? 
 
You will need to be using the Stock Management program. This can be 
switched on in your main admin setting page. Then go into the main products 
admin page and click on the “Dump Inventory” button. This will download your 
inventory to a .csv file, which can be opened in Excel. From Version 5.0.0 you 
can download the product inventory without having Stock Management 
selected. 
 

How do I remove the dot after all my category names? 
There is a setting your vsadmin/inc/languagefile.asp/.asp file. 
For the ASP version find xxDot="." and change it to xxDot="" 
For the PHP version find $xxDot="."; and change it to $xxDot=""; 
Remember to upload your language file to the server for the change to take 
place. 
 

How can I match the fonts used on the graphics in my template? 
All the font information is included in the file instructions.txt that accompanies 
the download. The fonts are just used as a suggestion so if you don’t have a 
particular font installed you can use a different one or perform a search on 
Google to see if it is available. 
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ASP Plus version for Windows servers 
I'm not receiving email confirmation of orders - what's up?
Why do my orders disappear in the orders admin page?
How do I make my database secure and non-downloadable?
Why does the log-in page reappear every time when trying to access the 
admin section?
I've forgotten / lost my admin password - how can I retrieve it?
 

I'm not receiving email confirmation of orders - what's up? 
From version 3.6.6 and upwards the system for choosing the email object (the 
component your ASP Ecommerce Plus template uses to send email) has 
become a lot more powerful. 
Most people won't require the information here and emails will be sent 
automatically. However if you are having problems, this is what you need to 
do. 
 
Firstly, log in to your admin section and go to the Admin Main page. 
The email address you set in the "Email address:" section is very important. It 
has to be an address on the same domain as your website as this is a 
security feature for most hosts to avoid SPAM. For instance if your website is 
www.yourwebsite.com then an email address on that domain would be say 
info@yourwebsite.com. 
 
You should see a section "Email Object". In the drop down list you will see a 
list of the available email objects that are installed on your server. If you don't 
see any available email objects in the list, then you need to ask your host if 
they can install an email object for sending email from an ASP page like for 
instance 
CDONTS 
CDO 
ASP Email (PERSITS) 
ASP Mail (ServerObjects) 
JMail (Dimac) 
Some of these are free, so there shouldn't really be a problem. From version 
4.0.1  
SMTPMail (SoftArtisans) 
is also supported. 
 
Ok, so now you can choose an email object in your admin main page. The 
best one to try first is CDONTS, as it doesn't require any further configuration. 
Set the email object to CDONTS and then press submit at the bottom of the 
admin main page, and try an "email friend" to yourself. If you receive the email 
you are all set. 
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If you still can't get email to work, please ask your host if they have a test 
script for sending email from an ASP page. Once you have tried the test script 
using one of the email objects that we support (listed above), send us an 
email with your FTP login details and URL of the test script and we will have a 
look at why emails are not working from your Ecommerce Plus template. 
 
One other important note. You need a properly configured mailserver to send 
emails from an ASP page. For this reason, don't worry about emails if you are 
testing on your local machine. It will come together when you publish to your 
host.. 

Why do my orders disappear in the orders admin page? 
If a payment is not authorized then it will be automatically deleted after the 
time you specify in your admin main page. 
 

How do I make my database secure and non-downloadable? 
 

 
 
 

 
SECURITY TIP 
The best place for your database is outside the 
web root. Most hosts provide a special folder 
for this with the database permissions already 
set. Using a folder outside the web root will 
make it difficult for anyone to download your 
database and gain access to your username 
and password. Otherwise you must set the 
permissions on your database folder so that 
your database cannot be downloaded. More 
information is available here. 

 
 

 

 
 
 

 
SECURITY TIP 
Rename your database from vsproducts.mdb to 
a name of your choice, (keeping the .mdb 
extension of course). 
Examples would be (though don't use ours) 
yourstore591.mdb or database2221.mdb 
This will make it harder for anyone to find your 
database if your database folder permissions 
are set incorrectly. 

 
 

  

Why does the log-in page reappear every time when trying to access the 
admin section? 
The usual reason is that your store is hosted on a Unix / Linux server and the 
host is using something like chilisoft.asp which doesn't support an Access 
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database. We do have Plus versions available for Unix / Linux servers so 
please contact us if this is the case. 
 

I've forgotten / lost my admin password - how can I retrieve it? 
If you've forgotten the password to your admin section, then the easiest thing 
to do is to download your database and have a quick look in the admin table 
in Access.
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PHP Plus version for Unix / Linux servers 
 
I'm not receiving email confirmation of orders - what's up?
Why do my orders disappear in the orders admin page?
Why can't I run the createdb.php file?
I've forgotten / lost my admin password - how can I retrieve it?  
 

I'm not receiving email confirmation of orders - what's up? 
Make sure that the email address in the admin main page is a valid email 
address on the server. Sometimes emails cannot be sent to an address 
outside of the domain if the "From" address is not on the domain and valid. 
 
- Hosts that support non-standard email headers 
 
You can set the parameter $customheaders in your vsadmin/includes.php file 
for hosts that require non-standard email headers. Instances of %from% will 
be replaced by the "From:" address and instances of "%to%" (not normally 
needed) will be replaced by the "To:" address. For example . . . 
$customheaders = "MIME-Version: 1.0\nFrom: %from%\nContent-type: 
text/plain; charset=iso-8859-1\n"; 
 
or for HTML emails 
 
$customheaders = "MIME-Version: 1.0\nFrom: %from%\nContent-type: 
text/html; charset=iso-8859-1\n"; 
 

Why do my orders disappear in the orders admin page? 
If a payment is not authorized then it will be automatically deleted after the 
time you specify in your admin main page. 
 

Why can't I run the createdb.php file? 
This usually happens when either the database connection hasn't been set 
correctly in vsadmin/db_open_conn.php or if that has been done then check 
with your host that your server is running a minimum of PHP4.1. 
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I've forgotten / lost my admin password - how can I retrieve it? 
If you have phpMyAdmin or something like that installed you can check in the 
admin table. If you don't have that, or don't know how to use it, try creating a 
new file called t.php and add the following to it 
 
<HTML> 
<BODY> 
<?php 
include "vsadmin/db_conn_open.php"; 
$sSQL = "SELECT adminUser,adminPassword FROM admin WHERE adminID=1"; 
$result = mysql_query($sSQL) or print(mysql_error()); 
$rs = mysql_fetch_assoc($result); 
print "The username is : " . $rs["adminUser" ] . "<BR>"; 
print "The password is : " . $rs["adminPassword" ]; 
mysql_free_result($result); 
?> 
</BODY> 
</HTML> 
 
Then, upload this to your web, and put it in the root directory of the store, then 
open in your browser. The most important thing to do is to remember to delete 
the file from your web after using it, as otherwise anyone can get your 
password.
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Dreamweaver F.A.Q. 
 
Why do my images not show up when I preview my page locally?
Why can I see the site correctly on my PC but on a friend's there are no 
images?
How do I define my site?
 

Why do my images not show up when I preview my page locally? 
It could be that you have your image paths set to "Relative to Root" - this 
probably wouldn't be a problem on your server, but locally it'll more than likely 
stop the images from showing and the paths not working. A path which is 
relative to the root would look like this /images/mygif.gif - if it's relative to the 
document it would be in the form of ../images/mygif.gif - you can choose the 
form you want by selecting from the drop down in the window that appears 
when you add an image. 
 

Why can I see the site correctly on my PC but on a friend's there are no 
images? 
This is probably because the path to your image files is pointing to your hard 
drive rather than the images on your server, the most likely cause is that the 
site hasn't been defined...(see below) 
 

How do I define my site? 
Open Dreamweaver, and go to Site>New Site. Give your site a name and 
then browse to where you extracted the template to. If you want to upload 
your files via Dreamweaver then you'll need to add the FTP information that 
was given to you by your host.

 
234  © Ecommerce Templates 



 
 
Frontpage F.A.Q. 
 
Why can't I add pages in Navigation View?
Why are parts of the pages missing, like the navigation and news sections?
How do I change the wording of "home" on the nav bar?
Why is all the formatting missing when I upload my site?
How do I make a back-up of my site?
How do I stop Frontpage overwriting my database and database connection 
files?  
 

Why can't I add pages in Navigation View? 
First of all remember that the PHP version doesn't use Frontpage navigation 
and that some templates rely solely on include files rather than a Frontpage 
theme. For the ASP version, for some reason you can't add child pages below 
a .asp page but you can get round this Frontpage quirk by renaming the page 
with a .html termination, dragging in the new page to Navigation View and 
then name the parent page with the .asp extension again. 
 
 

Why are parts of the pages missing, like the navigation and news 
sections? 
This is probably because you have the PHP version and unfortunately PHP 
and Frontpage don't mix too well, but we have found a way around this. 
The first thing is to get the page open in Frontpage :- 
In Frontpage go to Tools>Options>Configure Editors  
Choose "Add"  
Put PHP for file type  
Put the same information as you have for htm, html etc. - this is usually 
Editor Name: FrontPage 
Command: frontpg.exe  
Save 
 
Now you can get the pages open you'll see that the include files are "missing" 
- this is because they are PHP includes not Frontpage includes but you can 
work on them directly from the files in the includes folder - to view your 
changes locally you can download this utility 
http://www.totalpconline.com/phprocketaddin/?page=orders.html or work live 
on the server and on saving your page you can check it in your browser. 
 
There's more information in the first chapter as well as in our PHP help 
section. 
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How do I change the wording of "home" on the nav bar? 
In Frontpage go to Tools > Web Settings > Navigation and change the 
wording there. 
 

Why is all the formatting missing when I upload my site? 
This usually happens when for some reason the theme gets detached from 
the site. Connect live to your site through Frontpage and go to Theme in the 
top menu and go through the themes until you find the one that matches the 
name of your template. If that doesn’t work, try Tools > Recalculate Hyperlinks 
 

How do I make a back-up of my site? 
Open your site live on the server by going to File>New>Web from the top 
Frontpage menu and typing in the URL of your site, and then giving your 
name and password. Your site will now open up on the server so you can 
publish back to your hard drive by hitting the publish icon and choosing a 
back-up location on your hard drive 
 

How do I stop Frontpage overwriting my database and database 
connection files? 
The simplest method is to take them out of your Frontpage web on your 
computer and save them somewhere else on your hard drive. Alternatively 
you can right click on the file and Select Properties > Workgroup and select 
"Exclude this file when publishing the rest of the web".
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GoLive F.A.Q. 
 
Why do I get a little green bug icon in my site file list?
 

Why do I get a little green bug icon in my site file list? 
This means there is an error on the page - usually an incorrect path - if it's 
showing on all pages it's probably located in one of the components. You may 
find that some files in the vsadmin folder show a green bug and due to the 
include structure, these can be safely ignored. 
 
Final checklist 
 
Once you have your store ready and think it's time to unleash it to the world, it 
may be a good idea to go through our checklist to make sure everything is as 
it should be. 
 
General Issues 
 

• Make sure that each page of your site has unique TITLE and META 
DESCRIPTION tags. 

• Check your site on a different computer, preferably in Internet Explorer 
and Firefox. Pay particular attention to any broken links, screen 
resolution problems or slow loading pages. 

• Ask a friend or colleague to browse your store and make a purchase.  
• Make sure that you have carried out demo transactions for your 

payment provider and that emails are received as well as that orders 
show correctly in the order admin page of the control panel.  

• Be sure that all your graphics are optimized and contain ALT 
information.  

• Include a site map, linked from all your pages with text links to the most 
important pages on the store. 

• Include your main keywords in a natural way on your home page blurb. 
• Make sure you have changed the default password and user name for 

the control panel.  
• Ask for a site critique.  

  
ASP Version 
 

• Make sure your database is not downloadable. You can test this 
yourself by typing in the address eg 
www.yourstore.com/fpdb/vsproducts.mdb. If you receive an option to 
download the .mdb file then it may mean that people can access your 
database. Please check with your host if you have any doubts at all. 

 
© Ecommerce Templates Page 237 of  255 



 

Most hosts will provide you with a directory below the root of your web 
with the correct permissions already set.  

 
PHP Version 
 

• Be sure that each of the cart related pages at the very top in HTML 
view and before the opening HTML tag there is a little bit of code that 
goes like this . . .  

<?php 
session_cache_limiter('none'); 
session_start(); ?><html> 
 
This needs to be on each of the cart related PHP pages like 
cart.php, search.php, products.php, categories.php and so on. 

 
• Don't have spaces in your file names so use a pattern like my-

page.php rather than my page.php - remember they are also case 
sensitive. 
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Chapter 9 
Search Engine Optimization 
 
 
 
Introduction
Creating dynamic title and meta tags
Creating static URLs
ALT information 
Optimizing your store for the search engines  
Search engine information
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Introduction 
We believe we have most angles covered when it comes to offering search 
engine friendly shopping cart software. Ecommerce templates offers the 
ability to use static pages which are easy to spider by visiting search engines 
as well as unique titles and meta tags for category, product and product detail 
pages and ALT information for all the product images. We have also outlined 
some general information on optimizing your pages for search engines as well 
as an overview of the main players. 
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Dynamic title and meta description tags 
 
From version 4.1.1 it is possible to dynamically generate the title and meta 
description tags for your categories, product and product detail pages. Not 
only are they dynamically generated but you can also add you own unique 
information such as company name to the title tag. The set up details are 
outlined below: 
 

ASP Version  
 
The pages you are going to want to change are... 
categories.asp 
products.asp 
proddetail.asp 
 
Open each of these in turn and go to HTML view. About halfway down the 
page you should see a bunch of "include" files, something like this... 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
Then, at the very top of the file before the first <html> tag add that 
db_conn_open line along with the metainfo.asp include line like this... 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/inc/metainfo.asp"--> 
<html> 
 



 

Now repeat this with each of the 3 files categories.asp, products.asp and 
proddetail.asp 
 
Now, on your categories.asp AND the products.asp pages you can change 
the page title tag to something like this... 
 
<title>Bob's widget store: <% 
if topsection<>"" then response.write topsection & ", " 
response.write sectionname%></title> 
 
Also on the categories page, if you use a category description you might want 
to set the meta description tag to this... 
 
<META NAME="Description" 
CONTENT="<%=Replace(sectiondescription,"""","&quot;")%>"> 
 
The information available to the proddetail.asp page is slightly different. On 
that page you can change your page title to... 
 
<title>Bob's widget store: <%= productname & ", " & sectionname & ", " & 
productid %></title> 
 
You might not want to include the product ID, in which case you can use... 
 
<title>Bob's widget store: <%= productname & ", " & sectionname %></title> 
 
For the meta description on the proddetail.asp page you can use... 
 
<META NAME="Description" 
CONTENT="<%=Replace(productdescription,"""","&quot;")%>"> 

 
Multiple language set up 
If you are using the multiple language set up then you will need these include 
lines before the <html> tag: 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
<!--#include file="vsadmin/inc/metainfo.asp"--> 
...making sure they are not duplicated later in the code.  
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PHP Version  
 
The pages you are going to want to change are... 
 
categories.php 
products.php 
proddetail.php 
 
Open each of these in turn and go to HTML view. About halfway down the 
page you should see a bunch of "include" files, something like this... 
 
<?php include "vsadmin/db_conn_open.php"?> 
<?php include "vsadmin/includes.php"?> 
<?php include "vsadmin/inc/languagefile.php"?> 
<?php include "vsadmin/inc/incfunctions.php"?> 
<?php include "vsadmin/inc/incproducts.php"?> 
 
You will want to delete the first one, the db_conn_open.php line.  
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en, at the very top of the file before the first <html> tag you should already 
ve a couple of lines of code. Now add the db_conn_open line along with the 
tainfo.php include line like this... 

php 
ssion_cache_limiter('none'); 
ssion_start(); 
lude "vsadmin/db_conn_open.php"; 
lude "vsadmin/inc/metainfo.php";?><html> 

w repeat this with each of the 3 files categories.php, products.php and 
oddetail.php 

w, on your categories.php AND the products.php pages you can change 
 page title tag to something like this... 

tle>Bob's widget store: <?php 
topsection != "") print $topsection . ", "; 

int $sectionname?></title> 
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Also on the categories page, if you use a category description you might want 
to set the meta description tag to this... 
 
<META NAME="Description" CONTENT="<?php print 
str_replace('"','&quot;',$sectiondescription)?>"> 
 
The information available to the proddetail.php page is slightly different. On 
that page you can change your page title to... 
 
<title>Bob's widget store: <?php 
print $productname . ", " . $sectionname . ", " . $productid; 
?></title> 
 
You might not want to include the product ID, in which case you can use... 
 
<title>Bob's widget store: <?php 
print $productname . ", " . $sectionname; 
?></title> 
 
For the meta description on the proddetail.php page you can use... 
 
<META NAME="Description" CONTENT="<?php print 
str_replace('"','&quot;',$productdescription)?>">  
 
Multiple language set up 
If you are using the multiple language set up then you will need these include 
lines before the <html> tag: 
<?php include "vsadmin/db_conn_open.php" ?> 
<?php include "vsadmin/includes.php" ?> 
<?php include "vsadmin/inc/languagefile.php" ?> 
<?php include "vsadmin/inc/incfunctions.php" ?> 
<?php include "vsadmin/inc/metainfo.php" ?> 
...making sure they are not duplicated later in the code.  
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Converting dynamic to static URLs 
 
The default URL for a products page would be something like 
www.yoursite.com/products.asp?id=2 but it is possible to change this to 
something even more search engine friendly like 
www.yoursite.com/productname.asp. You can also do the same for the 
category pages and the product detail, the information is outlined below. 
 

ASP version 
 
Make a copy of products.asp and call it say bobswidgets.asp 
Now, open this page in notepad or your web editor and go to HTML view. 
Now, you should see a set of include files like this: 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
 
Now just add the variable to specify the category before the incproducts 
include like this for ASP 
 
<!--#include file="vsadmin/db_conn_open.asp"--> 
<!--#include file="vsadmin/includes.asp"--> 
<!--#include file="vsadmin/inc/languagefile.asp"--> 
<!--#include file="vsadmin/inc/incfunctions.asp"--> 
<% 
explicitid=2 
%> 
<!--#include file="vsadmin/inc/incproducts.asp"--> 
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u can now do the same for categories.asp and proddetail.asp by adding the 
plicitid before: 
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<!--#include file="vsadmin/inc/inccategories.asp"--> 
 
and 
 
<!--#include file="vsadmin/inc/incproddetail.asp"--> 
 
As the explicit id for a product detail page is a product reference, you have to 
enclose this in quotes like this: 
explicitid="yourprodref" 
 
You can get the variable you need by browsing your site and checking the 
particular page URL. For example if your URL for a widget looks like this: 
 
www.yoursite.com/products.asp?id=14 
 
...then you would want to set 
 
<% 
explicitid=14 
%> 
 
If you don't want to change all your pages to static URLs then the URL can be 
in the form of http://www.yoursite.com/products.asp?cat=14 due to the fact 
that Google may not give as much weight to links which contain this generic 
"id" parameter. 
 
In version 4.8.4 we added the possibility to define the static URL in the 
categories admin page after following the instructions above. This is an 
optional feature and if you want to use it just place the name of the static page 
you have created. 
 

 
 

This now means that your menu system won't pick up on the dynamic URLs 
as the store is browsed. It also works with the DHTML menu and avoids 
duplicate URLs / content on the store. 
 
In version 4.9.6 we added linked product detail static pages where there is 
now an option in the product admin page "Has static page" which if checked 
will cause the product detail page link to take the form. . . 
the_product_name.asp 
. . . where the page name will be made of the product name, in lower case 
with spaces replaced by underscores and non alphanumeric characters 
removed. It will be your responsibility to create the static detail page of that 
name using the method above. 
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In version 5.1 we added the ability to change the underscore to the character 
of you choice so if you prefer the layout of the-product-name.asp then you will 
need to add this to includes.asp 
urlfillerchar="-" 
 

PHP version 
Make a copy of products.php and call it say bobswidgets.php 
Now, open this page in notepad or your web editor and go to HTML view. 
Now, you should see a set of include files like this: 
 
<?php include "vsadmin/db_conn_open.php"?> 
<?php include "vsadmin/includes.php"?> 
<?php include "vsadmin/inc/languagefile.php"?> 
<?php include "vsadmin/inc/incfunctions.php"?> 
<?php include "vsadmin/inc/incproducts.php"?> 
 
Now just add the variable to specify the category before the incproducts 
include like this for PHP 
 
<?php include "vsadmin/db_conn_open.php"?> 
<?php include "vsadmin/includes.php"?> 
<?php include "vsadmin/inc/languagefile.php"?> 
<?php include "vsadmin/inc/incfunctions.php"?> 
<?php 
$explicitid=2; 
?> 
<?php include "vsadmin/inc/incproducts.php"?> 
 
  
 
 
 
 
 
  
 
 
 
You can now do the same for categories.php and proddetail.php by adding 
the explicitid before: 
 
<?php include "vsadmin/inc/inccategories.php"?> 
 
and 
 
<?php include "vsadmin/inc/incproddetail.php"?> 
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As the explicit id for a product detail page is a product reference, you have to 
enclose this in quotes like this: 
$explicitid="yourprodref"; 
 
You can get the variable you need by browsing your site and checking the 
particular page URL. For example if your URL for a widget looks like this: 
 
www.yoursite.com/products.php?id=14 
 
...then you would want to set 
 
<?php 
$explicitid=14; 
?> 
 
If you don't want to change all your pages to static URLs then the URL can be 
in the form of http://www.yoursite.com/products.php?cat=14 due to the fact 
that Google may not give as much weight to links which contain this generic 
"id" parameter. 
 
In version 4.8.4 we added the possibility to define the static URL in the 
categories admin page after following the instructions above. This is an 
optional feature and if you want to use it just place the name of the static page 
you have created. 
 

 
 

This now means that your menu system won't pick up on the dynamic URLs 
as the store is browsed. It also works with the DHTML menu and avoids 
duplicate URLs / content on the store. 
 
In version 4.9.6 we added linked product detail static pages where there is 
now an option in the product admin page "Has static page" which if checked 
will cause the product detail page link to take the form. . . 
the_product_name.php 
. . . where the page name will be made of the product name, in lower case 
with spaces replaced by underscores and non alphanumeric characters 
removed. It will be your responsibility to create the static detail page of that 
name using the method above. 
 
In version 5.1 we added the ability to change the underscore to the character 
of you choice so if you prefer the layout of the-product-name.php then you will 
need to add this to includes.php 
$urlfillerchar='-'; 
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ALT Information 
By default all the product pictures and product detail pictures will have the 
ALT information dynamically generated by the value you have added for the 
product name. So if your product name is "Blue Widget" then when your 
mouse passes over the picture the name "Blue Widget" will appear. 
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Optimizing your store 
Once you've got your store set up the next step is getting people to find it. 
Preparing your site for search engines and directories is worth the time and 
effort and pretty simple to do with the templates. We've prepared a very brief 
introduction and guide below that is worth following. 
 

Title tag 
If you look at your HTML code, you'll find something like this near the top of 
your page <TITLE>Untitled document</TITLE>. It's crucial to have a good 
title, around 10 words that clearly explain what the page / site is about and 
including words and phrases you think people will search on, so if you're 
selling widgets for example you might have something like this 
 
<TITLE>Online sales of professional manual and mechanical widgets. My 
Company</TITLE> 
 
It's a good idea to use different titles for different section/pages of your site, so 
on a help page you might have: 
 
<TITLE>How to install mechanical widgets</TITLE> 
 

Meta tags 
Far less important than the <TITLE> tag but still useful for some search 
engines. The description tag is particularly handy for controlling how your link 
will appear. Here you want to use 12 to 15 words that describe the content of 
your page, preferably using the same collection of words and phrases that 
can be found in your main body of text. This again could and should change 
from page to page depending on content. For example: 
 
<META NAME="description" content="Quality widgets and fidgets for sale. 
Buy online at low prices at My Store"> 
 
The other main meta tag is the keywords. It seems their usefulness has all but 
disappeared but they won't harm your site so it's best to include a few. 
Choose words and phrases that people will search on, are relevant to your 
site and appear in your main body of text. For example: 
 
<META NAME="keywords" content="widgets,mechanical widgets,manual 
widgets, widget sales"> 
 
So with this information the top of your code should look something like this: 
 
<html> 
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<head> 
<TITLE>Online sales of professional manual and mechanical widgets. My 
Company</TITLE> 
<META NAME="description" content="Quality widgets and fidgets for sale. 
Buy online at low prices at My Store"> 
<META NAME="keywords" content="widgets,mechanical widgets,manual 
widgets, widget sales"> 
 

Body text 
Many of the major search engines will pick up the text from your site and use 
it, amongst other factors, as a test of relevancy for the search. So having 
keyword rich text is extremely important for giving the search engine 
something to pick up on. You shouldn't go overboard here but certainly having 
your keywords near the top of the page is going to be an advantage. Don't try 
fooling the search engines by hiding text, or listing your keywords 50 times to 
improve ranking. 
 
Be careful of using manufacturer supplied product information as your page 
content should not be identical to others on the web selling the same product 
line. This can lead to duplicate content issues and lack of ranking. Be sure 
your content is unique! 
 

Alt information 
Each graphic on your site should have accompanying alt information - that's 
the text in a box you see when you pass your cursor over a graphic. Apart 
from aiding the disabled viewers, you can also help with your search engine 
optimization by using concise keyword rich descriptions. For example: 
 
<img border="0" src="images/manual_widget.gif" width="140" height="113" 
alt="Manual Widget"> 
 

Internal links 
Help a search engine index your site, and a person navigate, by having a 
clear navigation structure, text link alternatives to javascript and Flash, and a 
text based site map. 
 

Incoming links 
It appears that particularly for Google, the importance of quality links to your 
site will improve your ranking. You may want to spend some time asking to 
have links placed on related sites, preferably text and with your keyword(s) 
incorporated. You can start off by adding your store to our directory HhereH. 
Beware of "link farms" however. If you want to find out what a quality link 
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would be in the eyes of Google, download their toolbar HhereH and check the 
page rank - anything above 5 is good. 
 
Also consider how you are going to treat deleted products. Once you have 
deleted a product, the product detail page will be lost from your site but the 
URL still may be available in the search engines, causing people to find 
broken links and go elsewhere. One solution would be to set up Custom 404 
pages (your host can help with that), another would be to mark the product as 
out of stock rather than completely deleting it from your store. 

Other considerations 
A good domain name can help so you might want to look for something like 
manual-widgets.com or mechanicalwidgets.com. Use your keywords in your 
page names where possible and without going over the top eg. 
widgethelp.htm 
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Search engine information 
It's getting more and more difficult to keep up with how search engines work 
and interact, we've outlined below the information in a brief guide to what we 
believe to be correct and will be updating the details as and when we find 
things have changed.  

Google 
Google is undoubtedly the top dog of search engines and a decent listing here 
is without doubt, at the time of writing, one of the keys to the success of a site. 
Listings in Google are free, although you can pay for AdWords to get 
immediate traffic. Google will usually take up to a month to get your site listed, 
and it appears the best way to do so is through the Google bot (spider) 
picking up on your link from another site, spidering (indexing) your site content 
and adding it to their database. The Google database is updated at irregular 
intervals, commonly known as the "Google Dance" as this is when the major 
shake up of the database occurs. You can add your URL to Google but as it's 
important to get links in it's advisable to add your site to dmoz.org and even 
our own store listing. We recommend avoiding link farms and be wary of 
companies guaranteeing instant search engine success. 
 
Google appears to rate sites on a number of aspects, one of the important 
ones being the "quality" of in-bound links eg. a link from Microsoft.com being 
far more interesting than one from your neighbor (unless you live next to Bill 
Gates). Your importance in Google is measured as "page rank" - to find out 
the page rank of a site you'll need to download Google's tool bar. Here is a 
very general and unordered list of what Google is believed to look for on your 
page: 
 
Quality incoming links (preferably using your keywords in the text)  
Keywords in the title  
Keywords in the meta description  
Keywords in the main body of text  
Keywords in the ALT information  
Keywords in the URL  
Descriptive text links within the site  
Text in <H1> tags  
It's important not to overdo things, avoid trying to trick Google, study high 
ranking competitor sites without ripping them off and above all have patience. 
 

Google ad words 
 
You can get into Google immediately through their adword program, rather 
than trying to explain it here, you're best getting the information from the 
horse's mouth. The great thing about adwords is that they will get your site 
advertised on Google immediately, you can also pay for keywords that your 
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site is not showing up on, but keep a close eye on what they are costing you 
and read the information on optimizing your ads. 
 

Yahoo 
There's some debate now on the worth of submitting to yahoo. At the time of 
writing the cost of inclusion is $299 - this should get you into the yahoo 
directory, and in turn a link for Google to pick up on - all in all, probably worth 
it for an ecommerce site but not as important as it was in the past. 
 
To add your site to Yahoo, find the category that best suits your needs and 
click on the "Suggest a Site" link at the bottom of the page - make sure you 
read Yahoo's guidelines before submitting. 
 

Yahoo search marketing 
Yahoo is one of the major players in pay per click - like Google adwords it's a 
great way to target your audience and in the same vein it can work out 
expensive so it's important to do your research and check out the competition. 
With Yahoo you bid on the price of your keywords and a well targeted 
campaign can prove very successful - remember that a top three listing is 
beneficial. 
 

Other search engines and directories 
Here's a list of other places to submit your site, some are free and some are 
paid inclusions - it's also worth doing a search to find directories of sites that 
are industry related or regional, but again avoid using free for all link farms - 
you are likely to get more spam than trade, and may even be penalised by the 
major players. 
 
All the web (free + paid)  
Teoma / Ask Jeeves (paid)  
Open Directory (free)  
 
 
 
. 
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